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2D Tools

The tools on the 2D Tool palette are used to create 2D objects and to perform editing operations upon 
them. The palette also contains tools for manipulating the drawing within the viewing area.

The 2D Tool palette is opened using the Tools command on the Window menu. It is closed by clicking 
the Close box in the corner of the palette. It contains the following tools:

Tool Description

The Pan tool is used to move the view of the active 
drawing.

The Move Page tool is used to move the drawing 
around the drawing page. This tool is on the Pan 
tool's pop-out menu.

The Selection tool is used to select a 2D object in 
the drawing window.

The Zoom In tool magnifies the view of the drawing.

The Zoom Out tool reduces the view of the drawing.

The Text tool is used to place text anywhere on a 
drawing.

The Line tool is used to create constrained and 
unconstrained single lines.

The Double Line tool is used to create constrained 
and unconstrained double lines. This tool is on the 
Line tool's pop-out menu.

The Leader Line tool is used to create a 2-segment, 
leader line. This tool is on the Line tool's pop-out 
menu.

The Arc tool draws circular arcs of any degree, at 
any angle.

The Quarter Arc tool creates arcs that are one 
quarter of an ellipse, with an angle limited to 90°. 
This tool is on the Arc tool's pop-out menu.

The Rectangle tool is used to create a rectangle or a 
square.

The Rotated Rectangle tool is used to create a 
rectangle at any angle. This tool is on the Rectangle 
tool's pop-out menu.

The Rounded Rectangle tool is used to create 
rectangles with rounded corners. This tool is on the 
Rectangle tool's pop-out menu.

The Polyline tool is used to create a connected 
series of arcs, curves and lines that are treated as a 
single entity.

The Freehand     Line   tool produces a polygon along a 
path that is specified by dragging the mouse. This 
tool is on the Polyline tool's pop-out menu.



The Ellipse tool is used to draw circles and ellipses.

The 2D     Polygon   tool is used to create polygonal 
shapes.

The Double     Line     Polygon   tool is used to create 
double line polygons. This tool is on the Polygon 
tool's pop-out menu.

The Regular     Polygon   tool is used to create a closed 
polygon whose sides are equal in length. This tool is 
on the Polygon tool's pop-out menu.

The Insert Symbol tool is used to place symbols in 
the drawing in 2D or Plan projection.

The Symbol Paint tool is used to place multiple 
copies of the active symbol in the drawing by 
dragging the mouse. This tool is on the Insert 
Symbol tool's pop-out menu.

The 2D Locus tool is used to place a 2D reference 
point (represented by a diagonal cross) on the 
drawing. This tool is on the Insert Symbol tool's pop-
out menu.

The Trim tool is used to remove a portion of an 
object using another object as a cutting tool.

The Offset tool is used to create a new object whose 
outline is at a constant distance from the selected 
object. This tool is on the Trim tool's pop-out menu.

The Extend tool lengthens or "extends" one object to 
meet another object. This tool is on the Trim tool's 
pop-out menu.

The Reshape tool is used to edit polygons and 
polylines, including freehand lines. 

The Resize tool is used to scale an object. This tool 
is on the Reshape tool's pop-out menu.

The Shear tool skews all of the vertices of a 
rectangle, polygon or ellipse. This tool is on the 
Reshape tool's pop-out menu.

The Clip tool is used to cut objects. It can cut lines, 
arcs, rectangles, ellipses, polygons, and polylines. 
This tool is on the Reshape tool's pop-out menu.

The Fillet tool is used to places an arc (fillet) 
between two objects, making the arc tangent to each 
object at the fillet's end points.

The Chamfer tool is used to place a line between 
two linear objects, at a specified distance from the 
intersection of the lines or objects. This tool is on the 
Fillet tool's pop-out menu.

The Eyedropper tool is used to "pick up" attributes 
from one object and apply them to another.

The Mirror tool is used to make a mirror image of a 



selected object.

The Duplicate Along Path tool is used to replicate 
an object (or group of objects) at regular intervals 
along a path.    This tool is on the Mirror tool's pop-
out menu.

The Rotate 2D tool is used to rotate a selected 
object.

The Duplicate Symbol in Wall tool is used to 
replicate the active symbol (typically a door or 
window) at a specified interval in a wall.

The Fancy Door tool is used to create a door in a 
front elevation. The door can have raised panels, 
rectangular windows, and a semicircular top window.

The Number Stamp tool is used to place a marker 
with an identifying number on the drawing. The 
number automatically increments each time the tool 
is used. 

The Parking Space tool is used to create evenly-
spaced lines for parking lots. 

The Property Bounds tool is used to create a 
polygon based on bearing and distance values. The 
boundary line can be made of line segments or 
curves.

The Revision Cloud tool on the on the 2D Tool 
palette is used to create a revision cloud.

The Shutters tool is used to create window shutters 
in front elevation.

The Straight Stair tool is used to create stairs.

The Wall tool is used to create walls.

The Butt-Join Wall tool is used to join walls with 
corners butted together instead of mitered. 

The Y-Join Wall tool is used to join multiple walls 
that come together at odd angles and cannot be 
joined using the other wall-joining tools.

3D Tools

The tools on the 3D Tool palette are used to create 3D objects and to perform editing operations upon 
them. The palette also contains tools for manipulating the 3D drawing within the viewing area.

The 3D Tool palette is opened using the Tools command on the Window menu. It is closed by clicking 
the Close box in the corner of the palette. It contains the following tools:

Tool Description

The Align Plane tool allows 3D objects to be aligned to 
the working plane in both rotation and translation.

The Flyover tool is used to move the view of the 
drawing by dragging the mouse. It changes the angle 



of view, while constraining the viewer to an upright 
position.

The 3D Locus tool is used to place a 3D reference 
point (represented by a triad) on the drawing.

The 3D Mirror tool is used to make a mirror image of a 
selected object in 3D space. 

The Extruded Polygon tool is used to extrude objects 
in 3D without drawing them in 2D first.

The 3D Polygon tool is used to create 3D polygons 
without drawing them in 2D first.

The Extruded Rectangle tool creates 3D rectangles 
without drawing them in 2D first.

The 3D Reshape tool is used to edit extrudes, walls, 
roofs and 3D polygons.

The Rotate 3D tool is used to rotate a selected object 
in 3D space.

The Rotate View tool is used to change a model's 
angle of view.

The 3D Selection tool is used to select objects in 3D 
orthogonal views.

The Set Working Plane tool is used to set the working 
plane based on either a currently extant object's plane 
or three points in space specified by the user.

The Insert 3D Symbol tool is used to insert symbols in 
3D orthogonal projections.

The Translate View tool moves the 3D projection 
around the page.

The Walkthrough tool is used to visualize an 
architectural model.

The Zoom In tool magnifies the view of the drawing.

The Zoom Out tool reduces the view of the drawing.

Add Surface

Any object with a surface can be added to another object using the Add Surface command on the Tool 
menu. 

The result of an Add Surface operation is a single polygon that is a combination of two or more objects. 

Any combination of the following objects can be added together: 

· Rectangles

· Rounded rectangles

· Ellipses/circles

· Quarter arcs

· Full arcs

· All types of polygons (regular, freehand and polyline)



Any 2D filled object that is not locked, is not in a group or is not a symbol, can be added to another 
object. More than two objects can be added together simultaneously.

When surfaces are added, the object in front is added to the object in back. If the objects have fill 
patterns, the new object has the fill pattern of the rearmost object. 

If the objects being added are open, they are converted to closed polygons then added together.

For related information, see the following topics:
Combine into Surface 



Align Layer Views

The Align Layer Views command on the Organize menu changes the view and projection of all layers 
in a drawing to match the view and the projection of the active layer. 

To use this command, place the active layer in the desired view and projection. Then choose the Align 
Layer Views command. 

For related information, see the following topics:
Projection



Align to Grid 
Control -

The Align to Grid command on the Tool menu moves objects that were created with the reference grid 
disabled, or were moved off the grid, back into alignment with the grid. This tool can also be used to 
realign objects to the grid after the grid is changed. 

The upper left corner of each object is aligned to the grid. The grid is controlled with the Set Grid 
command on the Page menu.

To align objects to the reference grid, select the object you want to align to the grid and choose the Align 
to Grid command on the Tool menu.



Align Objects 
Control =

The Align Objects command on the Tool menu is used to align selected objects to each other. When 
the Align Objects command is chosen, the Align Objects dialog box opens. 

If only 2D objects are selected, alignment is restricted to the x and y axes. If 3D objects are selected, the 
z axis can also be used for alignment.

The dialog box is divided by row. The top buttons are used to select the alignment of the x axes, and the 
next row, the y axes. If the objects selected are 3D, the bottom row aligns the z axes. Any combination of 
alignments of the x, y, and z axes is possible. 

When aligning objects in 3D, the current view determines the direction of the alignments.

For related information, see the following topics:
Align Layer Views

Align to Grid 



Attributes 

The Attributes command on the Window menu is used to open the Attribute palette. The Attribute 
palette controls attributes such as pen color, pen pattern, marker style and line weight. 

For additional information, see the following topics:
Attribute Palette



Cam Construction 

The Cam Construction command on the Mechanical menu draws a flat plate cam using the 
parameters specified in the Cam Construction dialog box. 

Note:    This command is only available when the Mechanical Overlay is active. If the Mechanical 
menu is not listed on the menu bar, select the Mechanical Overlay using the Overlays command on the 
File menu.

The cam is specified by the radius of the prime, or base circle (P.C.R.), maximum follower displacement 
(Max), and radius of the follower (Size). The cam profile is described by constructing a follower 
displacement curve.

To construct the curve, click the mouse in the area of the diagram to be described. A black bar highlights 
the ordinate of the portion of the diagram selected. For the initial point, click anywhere in the diagram. 

Next, specify the type of follower motion for that portion of the diagram. The types of motions allowed 
are: 

· Uniform

· Harmonic

· Parabolic

· Cycloidal

· Trapezoidal

· Modified Sine

If a portion of the diagram is a dwell, the type of motion has no effect.

Click the New button and specify the angle and displacement for the selected portion of the diagram. 
The angle specified is the angle from 0° (0° being vertical). 

The displacement is measured from the prime circle radius. If the displacement for any portion of the 
diagram is the same as the previous section, a dwell is assumed.

A few seconds after the data is entered, if no further action is taken, the displacement curve for the 
selected area is drawn. The displacement curve also is drawn if the mouse is clicked anywhere in the 
diagram. Successive points of the displacement curve are similarly described until the diagram is 
complete.

After the diagram is complete, any point of the curve can be changed by clicking on the vertical line at 
the point and changing the angle or displacement. The remainder of the diagram is automatically 
changed to reflect the modification. 

Any point can be deleted by clicking on the vertical line at the point and clicking the Delete button. If the 
type of motion is to be changed, click anywhere in the portion of the diagram to be changed, and re-
specify the type of motion using the pop-up menu.

After the diagram is complete, the cam is drawn by clicking the OK button or pressing Enter.

A few important things to remember when using the Cam Construction command are:

· The displacement curve and prime, or base, circle radius represents the motion of the follower.

· Be sure to click in the area of the displacement diagram in which you want a new point to be 
positioned before clicking the New button.

· To change an existing point, click on the vertical line at the point and type in the new angle or 
displacement.

· To delete a point, click on the vertical line at the point and click the Delete button.



Classes

The Classes command on the Organize menu is used to create a "class."

The use of classes is a powerful way to organize the elements of your drawing. Classes are similar to 
layers in many ways, but they can work across layers, which often makes them more useful. 

For example, you can put objects, like lighting fixtures, into a class called "Fixtures," and the fixtures can 
be used on many layers in    the drawing. You can make the lighting fixtures in the drawing visible or 
invisible by changing the visibility of the Fixtures class.

Classes also allow intricate detail to be included with objects or symbols. The intricate details can be 
placed in a class. The class can be made invisible, reducing clutter on the drawing and significantly 
improving speed of screen redraws. The class can be made visible when details are required. You can 
create multiple detail classes to display increasing levels of detail.

Class information can be used with worksheets, and can be used as search criteria for the database. 
Class information can be returned into formulas, where the data can be calculated and manipulated.

All drawings have a minimum of two classes, Dimension and None, with None being the default class. 
These classes can be renamed, but they cannot be deleted. 

Additional classes can be created or deleted. If a class is deleted, the objects in the class are assigned 
the default class, None. If you import a symbol from another drawing, any classes that have been 
assigned to the symbol are imported too. 

A single drawing can contain up to 256 classes (including Dimension and None).

Objects are always drawn in the active class, with the exception of dimensions. All dimensions are 
placed in the Dimension class regardless of the active class.

For additional information, see the following topics:
Creating Classes

Assigning a Class

Worksheets



Creating Classes

Classes are created with the Classes command on the Organize menu which opens the Classes dialog 
box. 

This dialog box has the following options:

Normal
Selecting Normal makes the class fully visible. Objects in a normal class can remain invisible if the 
object is "owned" by another object that is in an invisible class.

Invisible
Selecting Invisible makes the class invisible. Objects that are "owned" by an invisible-class object are 
hidden, even if the owned object itself is in a class that is visible.

Rename
Allows you to rename an existing class. Renaming a class has no effect on objects in that class, or on 
their visibility.

New
Creates a new class in your drawing. Each class in a drawing must have a unique name that can be no 
longer than 20 characters.

Remove
Removes the selected class from the drawing. A dialog box warns that this permanently removes the 
class from the drawing. Any objects in the deleted class are put in the default class, None.

For related information, see the following topics:
Assigning a Class

Classes

Object Info Palette



Assigning a Class

All objects are drawn in the active class. The name of the active class is always displayed in the mode 
bar, in the header of the Class pop-up menu.

The active class is always visible, regardless of what the visibility setting for that class is. This allows you 
to display (or print) an invisible class by making it the active class. 

The active class is changed by choosing a different class in the Object Info Palette. You can also 
change classes by selecting it from the Class menu on the Data Display bar while no objects are 
selected. 

After an object is drawn, its class can be changed by selecting it and choosing a different class name in 
the Object Info palette or in the Class menu on the Data Display bar. 

For related information, see the following topics:
Creating Classes

Classes

Object Info Palette



Clear 

The Clear command on the Edit menu removes the selected object(s) from the drawing. 

The Clear command has the same effect as pressing the Delete key while an object is selected.

Unlike the Cut command, Clear does not place the deleted objects on the Clipboard. They can only be 
retrieved with the Undo command. 

For related information, see the following topics:
Cut

Undo



Clip Surface 

Clipping a surface takes any number of objects and creates a new polygon by removing overlapping 
areas of the two surfaces. Clipping is done with the Clip Surface command on the Tool menu.

When two objects are clipped, the object in front remains on the drawing, and the area beneath it is 
removed. Depending on the objects used, the clipped object may be converted into a different object 
type. For instance, if a hole is cut in a rectangle, the rectangle is converted to a polyline figure.

Any combination of the following objects can be clipped: 

· Rectangles

· Rounded rectangles

· Ellipses/circles

· Quarter arcs

· Full arcs

· All types of polygons (regular, freehand, and polylines).

Other things to remember about clipping:

· Any object that can be filled and that isn't in a group can be clipped.

· You cannot clip with a symbol. 

· If open objects are clipped, they are converted to closed polygons first.

To clip objects, arrange the objects in the proper order (if necessary, use the Send command to place 
the objects in the proper order). The Clip Surface command takes the topmost object and uses it to clip 
the selected objects below it. Once arranged, select all objects and choose Clip Surface on the Tool 
menu.

For related information, see the following topics:
Clip

Intersect Surface



Close command
Control W

The Close command on the File menu closes the active document. 

The Close command has the same effect as clicking in the close box in the drawing window. 

If there are any unsaved changes in the document, you will be prompted to save them before closing the 
document.

For related information, see the following topics:
Open



Combine into Surface 

The Combine into Surface command on the Tool menu, creates a new object that is the combination of 
objects from which it is created. Any combination of objects can be used as long as they form a closed 
curve (their perimeter must be unbroken). 

This tool produces a brand new object as a result. The original objects are not changed in any way.

To combine surfaces:

1. Select both objects.

2. Choose Combine into Surface on the Tool menu. 

The Paint Bucket cursor appears. 

3. Place the Paint Bucket cursor inside the area you want to combine and click. 

4. A polygon is created with the current fill pattern.

Troubleshooting tip!    If you have objects that won't combine with this tool, the selected objects are 
probably not closed (a single pixel gap can prevent the new surface from being formed). Use the Object 
Info Palette to check the polygons and polylines in your selection. Click the Close Object button on 
each. If the command still fails, zoom-in and carefully examine the objects for a gap.

For related information, see the following topics:
Add Surface



Constraints

The Constraint palette opens when the Constraints command is chosen from the Window menu. 

The Constraint Palette displays 2D constraints with 2D tools, and 3D constraints with 3D tools. 

Like all palettes, the Constraint palette can be moved around the screen by dragging its title bar. The 
palette can be closed by clicking its close box. 



Convert to Lines

Most objects, both 2D and 3D, can be converted into individual lines with the Convert to Lines 
command on the Tool menu. For example, if you convert a rectangle to lines, it becomes four separate 
lines.

When converting circles, the accuracy of the conversion depends on the "conversion resolution," which 
is set with the Preferences command. The conversion resolution specifies the number of line segments 
per 360° of arc. 

The sides of rounded rectangles are converted to lines and the corners become one quarter of the 
conversion resolution. 

Arcs with fill patterns are converted with radius lines. 

Polygons have one line per segment (i.e., one line less then the total number of vertices).

To convert an object to lines, select the object and choose Convert to Lines on the Tool menu. The 
object converts to individual lines. If you want to keep the original object intact, and convert a copy of the 
object, use the Convert Copy To Lines command.

If the selected object is a 3D object, a dialog box opens with two options: 

· Convert Object To Lines produces a 2D object made of individual lines, displaying all lines in the 
original 3D object. The view of the object is taken from the current projection. The 3D object 
appears in wireframe with all lines visible. 

· Hidden Line Rendering produces a hidden line rendering, taken from the current projection. A 
hidden line rendering removes all objects obscured by the top-most objects. The resulting objects 
are 2D, in a 3D view, made of lines with no surface. Therefore, the objects can have no color or 
shading.

For related information, see the following topics:
Convert Copy To Lines

Convert to Polygons

Convert to Mesh



Convert Copy To Lines

Convert Copy to Lines works like the Convert to Lines command except that it creates a copy of the 
selected object. The original object is unchanged.

Note:     The Convert Copy to Lines command is located on the alternate Tool menu. This menu is 
activated by, pressing the Control key while selecting the Tool menu from the menu bar.

When the Convert Copy to Lines command is chosen, a copy of the selected object, converted to lines, 
is placed on top of the original. If the selected objects are 3D, copies of the hidden line rendering are left 
selected on top of the original.

For additional information, see the following topics:
Convert to Lines



Convert to Mesh

The Convert to Mesh command on the 3D menu is used to convert a 3D polygon or extrude to a mesh 
object.

When a 3D object is converted to a mesh, each individual vertex of the mesh object can be edited. 
Multiple vertices can be selected and edited together. 

A 3D object that has been converted to mesh can be converted to a wireframe again. To convert the 
mesh object back to wireframe, select all of its vertices and group the selection.

After converting to mesh, the object can be edited with the Object Info Palette. In addition, the vertices 
can be edited with the 2D tools. Any vertex, or multiple selection of vertices, can be moved with the 
Move command on the Tool menu, or dragged to a new location with the mouse. 

The individual polygons that make up the mesh can be edited. Because the polygons are grouped 
objects, the group must be entered with the Edit Group command before it can be edited. 

For related information, see the following topics:
Convert to Lines

Convert to Polygons



Convert to Polygons

Any object that has a surface can be converted into a polygon with the Convert to Polygon command 
on the Tool menu. 

When converting circles, the accuracy of the conversion depends on the "conversion resolution," which 
is set with the Preferences command. The conversion resolution specifies the number of line segments 
per 360° of arc. 

The corners of rounded rectangles are one quarter of the conversion resolution. 

Arcs with fill patterns are converted with radius lines. 

To convert an object to a polygon, select the object and choose Convert to Polygons on the Tool 
menu. The object converts to 2d polygons. If you want to keep the original object intact, and convert a 
copy of the object, use the Convert Copy To Polygons command.

If the object being converted is 3D, the Convert to Polygons command opens a dialog box with the 
following options:

· Convert To Polygons converts the 3D object to 2D polygons. Each polygon can be individually 
selected and edited, deleted, or moved. However, in this mode polygons may not be stacked 
correctly--polygons that were beneath others in the 3D object may be on top after conversion. 
The Send command on the Tool menu can be used to reorder them.

· Render to Remove Hidden Surfaces renders the object into individual lines and 2D polygons. 
The polygons are sorted so that objects in the foreground obscure objects in the background. The 
result is a hidden surface rendering of the original 3D object. After conversion, the individual lines 
or polygons that make up the rendering can be selected, individually edited, deleted or moved. 
2D polygons can have color or fill. This option takes somewhat longer than a Convert to 
Polygons.

For related information, see the following topics:
Convert Copy To Polygons

Convert to 3D Polygons

Convert to Mesh

Convert to Lines



Convert Copy To Polygons

Convert Copy to Polygons works like the Convert to Polygons command except that it creates a copy 
of the selected object, and converts the copy to polygons. The original object is unchanged.

Note:     The Convert Copy to Polygons command is located on the alternate Tool menu. This menu is 
activated by, pressing the Control key while selecting the Tool menu from the menu bar.

When this command is chosen, a copy of the selected object converted to polygons is placed on top of 
the original. If the object is 3D, a dialog box offers the option of converting a copy or rendering a copy of 
the 3D polygon.

For additional information, see the following topics:
Convert to Polygons



Convert to 3D Polygons

Any selected 2D line or surface object, including polylines, polygons, ellipses or rectangles, can be 
converted into a 3D polygon with the Convert to 3D Polygons command on the 3D menu. After 
conversion, the new 3D polygon can be rotated and manipulated with the 3D tools and commands.

A 3D polygon has a z dimension but no thickness. Thus, the object has a location in 3D space and 
projects appropriately in a 3D projection. 

Surface items are shown in wireframe after being converted into 3D. They show a surface only when 
rendered.

Multiple selections can be converted to 3D polygons.

Groups of 2D objects cannot be converted to 3D polygons. Grouped items must be ungrouped, or the 
group must be entered with the Edit Group command, before conversion. 

For related information, see the following topics:
Convert to Polygons

Convert to Mesh

Convert to Lines



Copy
Control-C

The Copy command on the Edit menu copies selected objects or text to the Clipboard. The original 
objects remain on the drawing. 

If the Show/Snap/Modify option is set with the Layer Options command, you can select multiple 
objects on different layers and copy them to the Clipboard. When pasted, all objects are placed on the 
active layer.

If objects are on the Clipboard, be careful not to inadvertently switch applications. MiniCad is a high 
resolution program. The resolution is maintained with objects copied to the Clipboard as long as MiniCad 
remains the active application. If the application is switched, the contents of the Clipboard may be 
converted to 72 dpi.

MiniCad objects pasted into other applications from the Clipboard will lose detail. You can use the 
Export command to bring high resolution objects into other applications without any loss of detail.

For related information, see the following topics:
Cut

Paste

Duplicate

Duplicate Array

Duplicate Along Path 



Create Layer Link

Layers created with MiniCad are independent entities; that is, they can have their own z and Dz, scale, 
projection, and render status. As such, they can be thought of as "slices" of a single drawing--separate, 
independent pieces of a drawing. 

The layers can be linked together and viewed as a group with the Create Layer Link command on the 
3D menu. The layer link is created on the active layer.

Because layering is spatial in nature, you must assemble the pieces of the drawing by manipulating the z 
and Dz of the individual layers (a process that can be done automatically when you create the layers). 

If you want to rotate these pieces together in precise alignment, they must be linked. For example, if you 
create a building's walls on one layer and a proposed roof on another, you have to link the layers in order 
to rotate the assembled model.

A linked layer maintains more than registration with the layers to which it is linked. Any changes made to 
the original layers are updated on the linked layer with every screen redraw. The dynamic link between 
layers occurs only in one direction--from the linked layer to the layer to which it is linked. This way, you 
can add detail to a linked model without any unwanted changes to the original. 

To create a layer link, make the layer that displays the multiple layers active. In many cases it is 
desirable to create separate "model" layers to display layer links.

When the proper layer is active, choose the Create Layer Link command on the 3D menu. A dialog box 
opens with all layers except the active layer displayed in a scrolling list. Select the layers to which you 
want to link. You can Shift-Drag or Shift-Click to make multiple selections.

The dialog box has the following options:

Link
Creates the model from the layers selected. Double-clicking the selected layers in the scrolling list has 
the same effect as clicking the Link button.

Project 2D Objects
When selected, 2D objects on the layer, such as dimensions, are projected on the linked layer.

Cancel
Returns you to the drawing without any changes.

Additional layers can be added to the layer link by choosing the Create Layer Link command and 
selecting the additional layer or layers. The new layers are added to the link according to the layer's z 
and Dz settings.

For related information, see the following topics:
General Information about Layers

Layers

Layer Options



Deleting Layer Links

Layers can be deleted from a layer link. When created, layers in the layer link are locked, keeping them 
in registration. If a layer link is selected, it displays gray handles showing it is locked. To delete a layer 
from a layer link, select the layer and choose the Unlock command on the Edit menu. The handles 
display in black. Select the layer to be deleted and press the Delete key. The original layer is unaffected.



Advanced Layer Link Techniques

Layer Links and Elevations
Layer links can be used to create elevations. A useful technique is to create a layer link and switch the 
model layer to the front view, or right side, whichever is appropriate. 

Select the entire drawing and choose the Unlock command. With the entire model still selected, choose 
the Convert to Lines command on the Tool menu. When the dialog box opens, click on the Render 
button to produce a hidden line rendering. The resulting object is a 2D representation of the model. 
While the object is no longer dynamically linked to the drawing layers, it is quite small and fast. It is easy 
to edit and add text.

Layer Links and Printing
Layer links can be used to create layers specifically for printing. For example, multiple layers of a 
floorplan can be arranged with the layers next to each other instead of stacked into a model. Layers can 
be printed displaying all layers in the drawing on a single sheet. This can be useful when used with 
classes, as different elements of the drawing can be displayed as appropriate. 

Layer Links and Multiple Views
Links can be made to the same layer multiple times to give a multiple view effect. Any combination of 
views of the original can be linked, and the changes made to the original are updated in the multi-views 
every time the screen is redrawn.

For additional information, see the following topics:
Create Layer Link

Layers

Layer Options



Create Symbol

The Create Symbol command on the Organize menu is used to create a symbol.

Symbols are an efficient way of displaying repeating items because only one copy of the item is stored in 
the drawing's Symbol library. No matter how many times the symbol is displayed in the drawing, only the 
single object in the library is stored in the drawing. Any edits to a symbol in the library affect all instances 
of the symbol placed in the drawing. 

Symbols are stored in the active file, but, through the Resource Palette, they can be imported from 
external libraries or from other drawings. 

Symbols can have a 2D component, a 3D component, or both. If the symbol has both, it is known as a 
"hybrid" symbol. A hybrid symbol appears correctly in any projection. That is, when in 2D/Plan projection, 
the 2D component is displayed. When in 3D orthogonal projection, the 3D component is displayed. 

If the symbol is only one type, it always displays as drawn. 

For additional information, see the following topics:
Creating Symbols

Creating Hybrid Symbols



Creating Symbols

To create a symbol, first create the objects, text, or group that are to become the symbol. 

Then, select the objects and choose the Create Symbol command on the Organize menu. The Create 
Symbol dialog box opens. 

Enter the symbol's name in the Name field. 

Select one of the following options to define the symbol's "insertion point." The "insertion point" is the 
point within the symbol that, when the symbol is placed, will register exactly with whatever point you 
select in the drawing:

· Plan Projection Center. This option places the insertion point at the center of the symbol (as 
determined by its bounding box). When creating a 3D symbol in Top/Plan projection, the plan 
projection center is the center of the object on the ground plane. If the projection is isometric, this 
button changes to 3D Object Center. 

· Next Mouse Click. This option places the insertion point at the next mouse click. The snap 
constraints and data display bar can be used to set the insertion point. 

If the symbol created is 3D, its z dimension is also determined at creation. However, the z dimension for 
a 3D symbol can be changed after it is placed (with the 3D Reshape tool) without changing the z values 
of all symbols in the drawing.

When finished, click OK. 

The symbol is removed from the drawing and placed in the library. 

A symbol is placed in a drawing by first selecting it in the Resource Palette, then inserting it with the 
Insert 2D Symbol or Insert 3D Symbol.

For additional information, see the following topics:
Creating Hybrid Symbols

Symbols and Walls

Create Symbol



Creating Hybrid Symbols

Converting a 3D symbol into a hybrid symbol is easy. First, create the symbol as you normally would 
(see Creating Symbols). 

Once the symbol is created, double-click its name in the Resource palette and, if the symbol is 3D, click 
the 3D Edit button. 

When the Edit window opens, rotate the symbol to the orientation of the intended 2D view (usually top 
view). Draw the 2D component over the existing 3D symbol, using the existing symbol for reference. 
When finished, click the Exit Symbol button. 

The symbol is now a hybrid. The 2D components display in Top/Plan, and the 3D components display in 
all 3D projections. The 2D components can be edited now by clicking on the 2D Edit button. 

The process of converting a 2D symbol to a hybrid is the same.

For additional information, see the following topics:
Symbols and Walls

Create Symbol



Custom Selection

The Custom Selection command creates a macro that searches across the drawing for every instance 
of the criteria you select. Objects that meet the criteria are selected. 

The macro is created by making selections from a dialog box. The macro is named    and placed in a 
floating palette. Double-clicking the macro name in the palette, automatically selects everything in the 
drawing that meets the search criteria.

To create a custom selection macro choose the Custom Selection command on the Organize menu. 

In the Search Criteria dialog box, set the search criteria then click OK. See The Custom Selection 
Search Criteria dialog box for description of its options.

A dialog box opens for the command's name. Enter a unique name for the macro command. When you 
click OK, the command is put in the active command palette. If no command palettes are open on the 
drawing, one is created.

Macro commands and command palettes can also be created and edited with the Resource Palette.

For related information, see the following topics:
Custom Tools/Attributes

Custom Visibility

Resource Palette



The Custom Selection Search Criteria dialog box

The Search Criteria dialog box is used to define the criteria used for a custom selection. 

When an option presents a list of choices:

· Multiple selections can be made using the Shift-Drag or Shift-Click mouse technique.

· Multiple selections can be unselected by clicking the Remove button.

The Search Criteria dialog box has the following options:

Preset
Sets the default settings for the search criteria. 

Edit
Edits the search criteria in the edit window.

Select
When clicked, the objects that meet the criteria are selected. Any items on the drawing already selected 
remain selected.

Deselect
When clicked, the objects that meet the criteria are deselected.

Select only
When clicked, only the objects that meet the criteria are selected.

Visible
When clicked, the search is limited to visible objects.

Selected
When clicked, the search is limited to selected objects.

All
When clicked, all objects in the drawing are subject to the search.

Layer 
A search criteria can be limited to a particular layer or layers. To set the layer search criteria, click the 
Layer button. When clicked, a list of all layers in the drawing is displayed. 

Class
The Class option is used to include instances of a particular class or classes. When clicked, a list of 
classes in the drawing is displayed. Select classes that are to be included in the custom selection.

Type
A search can be conducted for any of the object types used in MiniCad. To search for a object type, click 
on the Type button. When clicked, a list of MiniCad's object types is displayed. Select any of the types to 
be included in the search. 

Name
You can search the drawing to select named objects. To include a named object in a search criteria, click 
the Name button. When clicked, a list of named objects is displayed. Select any of the names to be 
included in the search. .

Symbol
The custom command can select symbols placed on the drawing. To include a symbol in the search 
criteria, click on the Symbol button. When clicked, a list of symbols in the drawing is displayed. Select 
any of the symbols to be included in the search. Symbols can be located in folders nested within other 
folders. You can find them by looking at the path list at the top of the scrolling list of symbols. 



Record/field
The custom selection command can search the drawing for instances of a specific record or fields within 
the record. In addition, certain operations can be performed on the record or field to further refine the 
search. 

When you click the Rec/Fld button the Record Field dialog box is opened. Select the records and/or 
fields for which a search is to be conducted and double-click. After making all selections, click the Done 
button. 

You can click the Delete button in the Record Field dialog to remove a specific record or field from the 
list. This will not remove the record or field from the drawing. 

For more information about this option, see The Record Field dialog box.

Fill Pattern
The search can be limited to instances of a specific fill pattern. Click the FilPat button. Select the fill 
patterns for which a search is to be conducted and double-click. Edited fill patterns retain the ID number 
of the original fill pattern so the search criteria remains the same no matter how many times you edit the 
pattern. After making all selections, click the Done button. 

You can click the Delete button to remove a selected fill pattern from the list. 

Line Weight
The search to can be limited to instances of specific line weights or thickness. Click the LineWgt button. 
Select the line weights for which a search is to be conducted and double-click. It is possible to have 
more line weights on your drawing than the five selections available on the attribute palette. If there are 
more than five different line weights on the drawing, click on the Set Thickness line in the selection box. 
Type the desired line weight to be searched directly into the dialog box. After making all selections, click 
the Done button. 

You can click the Delete button to remove a selected line weight from the list.

Line Style
The search can include instances of a specific dash style. Click the LineStyl button. The selection list 
displays all available dash styles. Select the dash styles for which a search is to be conducted and 
double-click. After making the selections, click the Done button. 

You can click the Delete button to remove a selected dash style from the list. 

Arrow Shape
The search can include instances of specific arrowheads and line markers. Click the Arw Shape button. 
There are seven available "slots" for different arrowhead shapes. Select the particular slot for which a 
search is to be conducted and double-click. After making the selections, click the Done button. 

You can click the Delete button to remove a selected arrowhead or line marker from the list. 

Arrow Size
The search can include instances of specific arrowheads sizes. Click the Arw Size button. A scrolling list 
of the markers on the drawing is displayed. Select the particular arrow size for which a search is to be 
conducted and double-click. After making the selections, click the Done button. 

You can click the Delete button to remove a selected arrowhead or line marker from the list.

Fill/Pen Foreground/Background
The search can include instances of a specific color. MiniCad isolates the foreground color from the 
background color and also separates the pen (lines and text) and fill (surfaces). To search by color, click 
one of the color buttons (FillFore, FillBack, PenFore, PenBack). The color palette appears. Select the 
colors to search for, and double-click. After making the selections, click the Done button. 

You can click the Delete button to remove a selected color from the list.



The Record Field dialog box

The Record Field dialog box has the following options

No operators
When selected, no operation is performed on the search criteria.

Less than (<)
When selected, the search is successful only if the search criteria is less than the value in the limit value 
field.

Greater than (>)
When selected, the search is successful only if the search criteria is greater than the value in the limit 
value field.

Equal (=)
When selected, the search is successful only if the search criteria is equal to the value in the limit value 
field.

Less than or equal (<=)
When selected, the search is successful only if the search criteria is less than or equal to the value in the 
limit value field.

Greater than or equal (=>)
When selected, the search is successful only if the search criteria is greater than or equal to the value in 
the limit value field.

Not equal (<>)
When selected, the search is successful only if the search criteria is not equal to the value in the limit 
value field.

Enter a Limit Value
When using the greater than and less than operators, enter the limit value here.

Record search only
When checked, the search is limited to records.



Custom Tools/Attributes

Different combinations of tools and attributes can be configured to form custom tools. These custom 
tools can be named and placed into palettes and accessed with a double-click on the name in the 
palette. Custom tools are created with the Custom Tools/Attributes command on the Organize menu. 

Custom tools are created by changing the default attributes in the drawing as required for the special 
tool. The desired tool, if any, is selected. Finally, when all attributes and tools are properly selected, the 
Custom Tool/Attribute command is chosen from the Organize menu.

When the command is chosen, the Custom Tools/Attributes dialog box opens. The specific selections 
made in this dialog box control the command's action when it is selected. Any or all attributes can be 
selected from the dialog box. The two buttons labeled All On and All Off can be used to select or 
deselect all attributes at once.

See The Custom Tools/Attributes dialog box for a description of its options.

When the OK button is clicked, a dialog box opens for the command's name. Enter a unique name for 
the macro command.

The command is put in the active command palette, if one is open. If no command palettes have been 
created before, one is created.

Macro commands and command palettes can also be created and edited with the Resource Palette.

For related information, see the following topics:
Custom Selection

Custom Visibility

Resource Palette



The Custom Tools/Attributes dialog box

The Custom Tools/Attributes dialog box is used to define the criteria used for a custom selection. It 
has the following options:

Pen
The pen color controls the color of lines, hatches, and text. You have individual control over foreground 
color, background color, and pattern. Text color is controlled by the pen color. Generally, the line and text 
color are controlled by the foreground color. All pen attributes can be selected by clicking the Pen 
checkbox.

Fill
The fill color determines the surface color and pattern of objects. You have individual control over 
foreground color, background color, and pattern. Generally, the line and text color is controlled by the 
background color. All fill attributes can be selected by clicking the Fill checkbox.

Line
The Line section of the dialog box controls whether a line's weight (thickness), style (dash patterns), 
markers (arrowheads), and marker size becomes part of the tool's attribute. All line attributes can be 
selected by clicking the Line checkbox.

Text
Select any combination of text attributes. All text attributes can be selected by clicking the Text 
checkbox.

Class
If selected, the current class is included as a tool attribute

Layer
If selected, the current layer is included as a tool attribute

Symbol
Select any symbol to be used in combination with the selected attributes.

Tool
If selected, the active tool can be used in combination with the selected attributes.

Constraint
If selected, the current snap constraint(s) is selected as an attribute.

Macro commands and command palettes can be created and edited with the Resource Palette.



Custom Visibility

The Custom Visibility command on the Organize menu is used to create commands that search 
across the drawing for every instance of specific criteria. Objects that match the criteria can be made 
visible or invisible by double-clicking the macro's name on the command palette. These commands, or 
macros, can control the visibility of any combination of objects on the drawing.

To create a custom visibility command, choose Custom Visibility from the Organize menu. All 
selections for the command are made from the Search Criteria dialog box. Set the search criteria by 
clicking the appropriate buttons. 

See The Custom Visibility Search Criteria dialog box for description of its options.

When done, click OK. A dialog box opens to enter the command's name. All commands must be given a 
unique name. The command is put in the active command palette if one is open. If no command palette 
exists in the drawing, one is created.

Macro commands and command palettes can also be created and edited with the Resource Palette.

For related information, see the following topics:
Custom Tools/Attributes

Custom Selection

Resource Palette



The Custom Visibility Search Criteria dialog box

The Search Criteria dialog box is used to define the criteria used for a custom selection. 

When an option presents a list of choices:

· Multiple selections can be made using the Shift-Drag or Shift-Click mouse technique.

· Multiple selections can be unselected by clicking the Remove button.

The Search Criteria dialog box has the following options:

Preset
Sets the default settings for the search criteria. 

Edit
Changes the settings for the search criteria.

Show
When selected, the objects that meet the criteria are made visible.

Hide
When selected, the objects that meet the criteria are made invisible.

Show only
When selected, only the objects that meet the criteria are made visible. All other objects are hidden.

Visible
When selected, the search is limited to visible objects that meet the search criteria.

Selected
When selected, the search is limited to selected objects that meet the criteria.

All
When selected, all objects in the drawing are subject to the search.

Layer
A search criteria can be limited to a particular layer or layers. To set the layer search criteria, click the 
Layer button. When clicked, a list of all layers in the drawing is displayed. 

Class
The search can include instances of a particular class or classes. This is done by clicking the Class 
button. When clicked, a list of classes in the drawing is displayed. Select any classes to be included in 
the search. 

Type
Any of the object types can be made invisible as a group. To search for an object type, click on the Type 
button. When clicked, a list of MiniCad's object types is displayed. Select any of the types to be included 
in the search. 

Name
You can search the drawing to select named objects. To include a named object in a search criteria, click 
the Name button. When clicked, a list of named objects is displayed. Select any of the names to be 
included in the search. 

Symbol
The custom command can control the visibility of symbols placed on the drawing. To include a symbol in 
the search criteria, click on the Symbol button. When clicked, a list of symbols in the drawing is 
displayed. Select any of these symbols to be included in the search. Symbols can be located in folders 
nested within other folders. You can find them by looking at the path list at the top of the scrolling list of 



symbols.

Record/Field
The custom selection command can search the drawing for instances of a specific record or fields within 
the record. In addition, certain operations can be performed on the record or field to further refine the 
search. To do this, click the Rec/Fld button

In the Record Field dialog box, select the records and/or fields for which a search is to be conducted 
and double-click. After making all selections, click the Done button.

You can click the Delete button in the Record Field dialog to remove a specific record or field from the 
list. This will not remove the record or field from the drawing. 

For more information about this option, see The Record Field dialog box.

Fill Pattern
The search can be limited to instances of a specific fill pattern. To do this, click the FilPat button. Select 
the fill patterns for which a search is to be conducted and double-click. Edited fill patterns retain the I.D. 
number of the original fill pattern, so the search criteria remains the same no matter how many times you 
edit the pattern. 

After making all selections, click the Done button.

You can click the Delete button to remove a selected fill pattern from the list. 

Line Weight
The search can be limited to instances of specific line weights or thickness. To do this, click the LineWgt 
button. Select the line weights for which a search is to be conducted and double-click. 

It is possible to have more line weights on your drawing than the five selections available on the attribute 
palette. If there are more than five different line weights on the drawing, click on the Set Thickness line 
in the selection box. Type the desired line weight to be searched directly into the dialog box. 

After making all selections, click the Done button. 

You can click the Delete button to remove a selected line weight from the list. 

Line Style
The search can include instances of a specific dash style. To do this, click the LineStyl button. The 
selection list displays all available dash styles. Select the dash styles for which a search is to be 
conducted and double-click. 

After making all selections, click the Done button.

You can click the Delete button to remove a selected dash style from the list.

Arrow Shape
The search can include instances of specific arrowheads and line markers. Click the Arw Shape button. 
There are seven available "slots" for different arrowhead shapes. Select the particular slot for which a 
search is to be conducted and double-click. 

After making the selections, click the Done button. 

You can click the Delete button to remove a selected arrowhead or line marker from the list. 

Arrow Size
The search can include instances of specific arrowheads sizes. Click the Arw Size button. A scrolling list 
of the markers on the drawing is displayed. Select the particular arrow size for which a search is to be 
conducted and double-click. 

After making the selections, click the Done button. 

You can click the Delete button to remove a selected arrowhead or line marker from the list.

Fill/Pen Foreground/Background



The search can include instances of a specific color. MiniCad isolates the foreground color from the 
background color and also separates the pen (lines and text) and fill (surfaces). To search by color, click 
one of the color buttons (FillFore, FillBack, PenFore, PenBack). The color palette appears. Select the 
colors to search for, and double-click. 

After making the selections, click the Done button. 

You can click the Delete button to remove a selected color from the list.



Cut
Control-X

The Cut command on the Edit menu removes the selected objects or text from the drawing and places it 
in the Clipboard. 

If the Show/Snap/Modify option is set with the Layer Options command, you can select multiple 
objects on different layers and cut them to the Clipboard. When pasted, the objects are placed on the 
active layer.

If objects are on the Clipboard, be careful not to inadvertently switch applications. MiniCad is a high 
resolution program. The resolution is maintained with objects copied to the Clipboard as long as MiniCad 
remains the active application. If the application is switched, the contents of the Clipboard may be 
converted to 72 dpi.

MiniCad objects pasted into other applications from the Clipboard will lose detail. You can use the 
Export command to bring high resolution objects into other applications without any loss of detail.

Note:     Do not confuse the Cut command with the Delete key or the Clear command. These two 
methods do not copy the deleted objects on the Clipboard.

For related information, see the following topics:
Paste

Copy

Clear 



Cut 2D Section

The Cut 2D Section command on the 3D menu produces a 2D object that is a "slice" of a 3D object. 
The section can be cut through a single layer or through a layer link of multiple layers. 

To cut a 2D section, choose the layer that is to be sectioned. Orient the drawing to the appropriate view 
for the section. 

Next, choose the Cut 2D Section command. Drag the cursor along the line where the section is to be 
cut and click the mouse on one side of the section line. 

The specified section is copied to a new layer, and the drawing is automatically changed to that layer. 
The new layer is given the default layer name, which you can change using the Layers command.

The original layer, and the objects contained on it, remain unchanged. There is no link between the 
original object and the new section. 

If the image is reversed after a section, use the 2D Mirror tool to correct the orientation.

For related information, see the following topics:
Cut 3D Section



Cut 3D Section

The Cut 3D Section tool on the 3D menu cuts a section through a 3D model. Sections can be cut 
through a linked layer model and through 3D symbols. 

When chosen, this command allows you to set the plane used to cut the section. After cutting the plane, 
you are asked to set the side of the model to be cut away. The sectioned model is drawn in a new, 
untitled layer. The sectioned model has no links to the original model nor to that model's original layers. 

As a 3D object, the new section can be rotated to any view, or viewed through any projection. For this 
reason, you must be aware of the implications of adding 2D information to your 3D section. Because 
dimension information or text annotations are 2D objects, these elements cannot be attached to the 
sectioned model if the model is rotated.

For related information, see the following topics:
Cut 2D Section



Document windows

All open documents are listed on the Window menu. The selected document is identified with a check 
mark next to its name in the menu. A document is made active by selecting its name from the menu.



Calculate Terrain Model

When the Calculate Terrain Model command is chosen with 3D loci or polygons    selected on the active 
layer, the Digital Terrain Model dialog box opens.

Note:    This command is only available when the Terrain Modeler Overlay is active. If the DTM menu is 
not listed on the menu bar, select the Terrain Modeler Overlay using the Overlay command on the File 
menu.

To learn more about the DTM, see General Information About the Digital Terrain Modeler and 
Importing Data into the Digital Terrain Modeler.

The Digital Terrain Model dialog box has the following fields and buttons:

Name
Unique name of the DTM. This is the name of the layer that contains the terrain data. If the layer name is 
changed, the DTM is deleted.

2D To
Name of the layer where the 2D portion of the terrain model is output. If the layer doesn't exist, it is 
created.

3D To
Name of the layer where the 3D portion of the terrain model is output. If the layer doesn't exist, it is 
created.

Current Data
The lowest and highest points in the current selection of loci or polygon vertices, and the difference 
between them (the range). If a DTM exists on the layer, the field returns the lowest and highest points in 
the DTM and their range.

Contour Interval field
Enter the desired contour interval. This value must be greater then one, but it doesn't need to be an 
integer. 

Major Multiple 
The Major Multiple value is the number of contour lines per index number. The major multiple must be 
an integer. 

Datum Elevation
Used for calculating the volume between the irregular surface of the DTM and the horizontal datum 
plane. The elevation can be any number.

Base Elevation field
The contour is based on the value in the Base Elevation field. This value is usually zero, but it can be 
any number.

Minimum Elevation field
The value in the Minimum Elevation field is the lowest point in the terrain model. By default the 
Minimum Elevation represents the lowest 3D loci or 3D polygon vertex on the layer. In a "cut and fill" 
DTM, the minimum elevation is typically less then the maximum cut (usually a negative number).

Maximum Elevation field
The value in the maximum elevation field is the highest point in the terrain model. By default the 
maximum elevation represents the highest 3D loci or 3D polygon vertex on the layer. In a "cut and fill" 
DTM, the maximum elevation is typically greater then the maximum fill depth.

2D Contours



When selected, 2D contours are created.

Surface 3D
When selected, 3D triangular polygons are created. This creates a 3D terrain model with a multifaceted 
surface. The model can be rendered as a solid. 3D polygons cannot be smoothed.

Contour Labels
When selected, contour labels are created at the index 2D contours. The index contours are placed at 
the major multiples, where the index contours meet the hull (i.e., the edge of the DTM).

Triangles (2D)
When selected, 2D triangular polygons are created.

3D Contours
When selected, 3D contours are created using 3D polygons. 3D polygons cannot be smoothed, but the 
3D polygons retain the elevations that they represent.

Hull
When selected, a closed 2D polygon is created representing the hull, or boundary of the DTM.

Smooth 2D Contours
When selected, the 2D contours are smoothed with Bezier splines at creation and extra vertices are 
created as required. The contour can be smoothed after it is created, but vertices are not added.

Group Objects
When selected, like objects are grouped upon creation. For example, all 2D contour lines or 3D triangles 
are grouped together. Contour labels are grouped with 2D contour lines.

Use Breaklines
When selected, 3D polygons are used as breaklines in the DTM. Breaklines force linear interpolation 
along each leg of each polygon.

Always Recalculate
When selected, the DTM automatically recalculates whenever the dialog box is changed. It is usually 
desirable to always recalculate. When selected, less RAM is required. However, because the DTM is 
recreated each time it is recalculated, you may wish to disable this option in a complex DTM.

For related information, see the following topics:
Display Area

New Cut & Fill Model

Display Cut & Fill-To Datum



Display Area

The area of a terrain model can be calculated with the Display Area command. When the Display Area 
command is chosen, the area of the terrain model is displayed in a dialog box.

Note:    This command is only available when the Terrain Modeler Overlay is active. If the DTM menu is 
not listed on the menu bar, select the Terrain Modeler Overlay using the Overlay command on the File 
menu.

The area is calculated by taking the projection of the model on a horizontal plane. The unit of measure is 
the same as the drawing's current unit of measure, cubed. The command does not calculate the sum of 
the areas of the sloped surfaces.

A layer with an existing terrain model must be active in order to calculate the display area of the model.

To learn more about the DTM, see General Information About the Digital Terrain Modeler and 
Importing Data into the Digital Terrain Modeler.

For related information, see the following topics:
Calculate Terrain Model

New Cut & Fill Model

Display Cut & Fill-To Datum



Display Cut & Fill-To Datum

The Display Cut and Fill to Datum command calculates and displays (in a dialog box) the total cut and 
total fill to get from the surface of the model to a datum plane. 

Note:    This command is only available when the Terrain Modeler Overlay is active. If the DTM menu is 
not listed on the menu bar, select the Terrain Modeler Overlay using the Overlay command on the File 
menu.

The elevation of the plane is indicated in the dialog box which appears when you choose to create or 
change a model. 

The plane may be above, below, or intersecting the model. If it is above, then there will only be fill; if it is 
below, then there will only be cut; if it intersects, then there will be both cut and fill. 

If the site is balanced, then the cut and fill volumes will be identical; this would indicate that soil cut from 
high parts would be exactly enough to fill low parts, creating a level surface at the datum elevation. 

Bulking and compaction factors are not used, and there is no way to take into account the stripping of 
topsoil (other than adjusting the original data upon which the model was based).

A layer with an existing terrain model must be active in order to calculate the volume of the cut and fill to 
datum. 

To calculate the cut and fill necessary to get from one model to another, you must first create a cut and 
fill model, then calculate its cut and fill volumes to get to a datum plane of elevation zero.

To learn more about the DTM, see General Information About the Digital Terrain Modeler and 
Importing Data into the Digital Terrain Modeler.

For related information, see the following topics:
Display Area

Calculate Terrain Model

New Cut & Fill Model



New Cut & Fill Model

The cut and fill between two terrain models can be calculated. There must be at least two existing terrain 
models in the drawing in order to calculate the cut and fill. 

Note:    This command is only available when the Terrain Modeler Overlay is active. If the DTM menu is 
not listed on the menu bar, select the Terrain Modeler Overlay using the Overlay command on the File 
menu.

The name given to the model will be the name of the active layer. This named can be changed. The 
names of the 2D and 3D output layers can also be edited.

This command is similar to the Calculate Terrain Model command. But instead of using 3D loci and/or 
3D polygons as its input, the New Cut & Fill command uses two existing models. 

One of the models must be totally enclosed by the other (they may have common boundaries as well). 
The enclosing model typically represents existing terrain, and the enclosed model typically represents 
proposed terrain. The calculations assume going from the enclosing model to the enclosed model.

The "enclosing" model is specified in the first pop-up menu in the Digital Terrain Model dialog box. The 
"enclosed" model is specified in the second. None of the data in the enclosed model may extend beyond 
the boundaries of the enclosing model.

The new model created by this command represents the difference in elevation between these two 
models. 

Where the new model's elevation is zero, the two chosen models are at the same elevation. 

Where the enclosed model is at a higher elevation, the elevation in the new model is positive. By 
calculating the cut and fill to a datum plane of zero elevation on the new model, the cut and fill volumes 
to get from the enclosing model to the enclosed model will be displayed.

The border of the new model will be the same as that of the enclosed model. A cookie cutter approach is 
used, meaning that vertical walls are assumed at the edge of the new model to represent the transition 
from the enclosing model to the enclosed model.

To learn more about the DTM, see General Information About the Digital Terrain Modeler and 
Importing Data into the Digital Terrain Modeler.

For related information, see the following topics:
Display Area

Calculate Terrain Model

Display Cut & Fill-To Datum



General Information About the Digital Terrain Modeler

The Digital Terrain Modeler (DTM) reads 3D loci and 3D polygons to create the terrain models. 3D loci 
are typically created by importing 3D point data provided by surveyors. 

3D polygons are typically created by digitizing an existing contour map, or importing a DXF file 
containing 3D polylines which represent contour lines. The module uses each vertex of each 3D 
polygon, along with their individual elevations, so 3D polygons are not assumed to be, and don't have to 
be, horizontal.

The module uses the Triangulated Irregular Network (TIN) method. The data may be scattered and in 
clumps; it need not be organized in any rectangular grid. The terrain modeler will use all the data points, 
without doing approximations. A network of triangles is created from the points. These triangles then 
form the terrain model. Interpolation is performed within the triangles to calculate the threading of 
contour lines.

Multiple terrain models can be used. For example, two terrain models can be created--one representing 
existing terrain, and another representing the proposed terrain. It is then possible to calculate the cut and 
fill volumes from the terrain to a datum plane. If two models exist, then the terrain modeler can create a 
new model which represents the cut and fill needed to get from one model to the other.

The model can represent terrain, hydrological measurements, temperature, financial data, and a wide 
range of other types of information.

Three layers are used per model. The original data resides in one layer, the 2D results are put into a 
second layer, and the 3D results are put into a third layer. If the name of the model is "existing", then the 
name of the 2D layer will be "existing_2D", and the name of the 3D layer will be "existing_3D". You may 
change the names which will be assigned to the output layers.

Once you have created a model, you can edit and delete the standard graphic objects which were 
created to represent it. You can also change and delete the model as a whole. This assumes that you do 
not change the names of the three layers associated with it. To perform an operation on a model, you 
must select one of the three layers associated with it.

Terrain model information is saved along with a drawing after each DTM-related command. If you save 
your drawing and open it again, the original internal DTM data remains.

For related information, see the following topics:
Importing Data into the Digital Terrain Modeler

Display Area

Calculate Terrain Model

New Cut & Fill Model

Display Cut & Fill-To Datum



Importing Data into the Digital Terrain Modeler

3D point data may be imported and converted into 3D loci. The data must be in a text (ASCII) file in the 
same folder as the MiniCad application. 

The text file must contain the data in tab-delimited y, x, z (northing, easting, elevation) format. There 
should be no other characters, such as headings, point numbers, or descriptions, in the file.

Tab-delimited files have a format such as: 
123 <Tab> 456 <Tab> 78 <CR>

This is an example of a y,x,z format, which represents northing, easting, and elevation (n,e,z). It is 
identical in appearance to an x,y,z (e,n,z) file. The only difference is that the first two columns are 
reversed. 

There is a Tab character after each of the first two numbers, and a carriage return at the end of the line. 

The most common formats are y,x,z; x,y,z; and #,n,e,z,d. The last format consists of five items per line: 
point number, northing, easting, elevation, and description. This kind of data can be entered with a 
macro found in the DTM Toolkit. This macro reads #,n,e,z,d files, stripping the first and last items from 
each line.

Configure the units and scale before importing data into the drawing. The units in the file should match 
the data in the file from which the data is imported. The Display as Fractions button on the Units dialog 
box should be deselected.

Scale must be set before importing data. Inspect the data to be imported and choose an approximate 
scale. Set the scale to one that will allow all of your data to fit in the drawing (consider mainly the 
horizontal coordinates). 

For instance, if your northing (y) values range from 1100 to 1300 feet, and your easting (x) values range 
from 2500 to 2800 feet, then the x and y ranges will be 300 feet and 200 feet, respectively. 

If you have set your units to feet, and you want the data to fit in one page, you may want to set the scale 
to 1"=50', which gives a paper scale of 1:600. In most cases you will want the scale to apply to all layers.

You may want to create a layer specifically for one model's data. Give it a name such as "existing", 
"proposal 1", etc. The data will be imported into the active layer as 3D loci.

Now you are ready to import the data. On the Resource Palette, select the appropriate macro from 
those listed in the DTM Toolkit, then click in the Run button. 

The macro will present a standard dialog box in which you should select the data file you want to import. 
The data file must be in the MiniCad application folder.

Once you have imported your data you will probably need to bring it into view. The easiest way is to 
choose the Normal Scale command on the Page menu. If asked whether to center on off-screen 
objects, click Yes.

When the data is imported, choose the Calculate Terrain Model command

Terrain data also can be imported as DXF files. The contour lines are represented as polylines in DXF, 
and are converted into polygons in MiniCad. 

If the polylines are only 2D, the elevations represented by the contour lines are not imported. 

If a 3D terrain model is desired, the 2D polylines must be converted to 3D polygons and moved to the 
proper z value for the respective elevations.

For related information, see the following topics:
General Information About the Digital Terrain Modeler

Display Area

Calculate Terrain Model



New Cut & Fill Model

Display Cut & Fill-To Datum



Drawing Size

The Drawing Size command on the Page menu controls the number of pages used for printing. 

The size of the paper is controlled by the settings made with the Print Setup command. 

Since different printers have different printable areas on a page, switching printers will affect the print 
area. Be aware that MiniCad doesn't determine the print area--this is done by the printer. 

The drawing area used by MiniCad, and the portion of the drawing area that is printed, are different. 

A gray border in the drawing represents the overall size of the printable area of the drawing. The actual 
number of pages needed to print the drawing at this size is shown within the border. If only a portion of a 
page is to be used for tiling, only that portion is shown.

The Drawing Size dialog has the following options:

Edit Window
The print area can be enlarged by dragging the small rectangle in the upper left corner of the edit 
window to select the number of pieces of paper desired. 

Size
The Size pop-up menu is used to select standard paper sizes, including technical sheet sizes used by 
plotters. A custom page size can be specified using the Height and Width fields. 

MiniCad automatically tiles the drawing across the required number of printer pages to match the paper 
size you specify.

Width and Height
The actual print area for the selected printer (times the number of pages selected) is shown in the height 
and width fields. 

Custom page sizes can he entered directly in the fields. Some printers allow for enlargement or 
reduction of the print area. These settings, made with the Print Setup command, will affect the 
dimension shown in the Height and Width fields.

Inch/millimeter 
Choose a unit of measure by clicking one of the buttons.

Show Page Breaks 
Select this checkbox to show the page breaks.



Duplicate
Control-D

The Duplicate command on the Edit menu makes an exact copy of a selected object.

When an object is duplicated, the copy can be offset from the original. The offset is controlled with the 
Preferences command on the File menu. 

If the duplicated object is moved immediately after it is created, subsequent duplicates will be placed at 
the same offset. If Offset Duplications is deselected, the copy is placed on top of the original.

Note:    unlike the Copy command, the Duplicate command does not place a copy of the object on the 
Clipboard.

For related information, see the following topics:
Copy

Duplicate Array

Duplicate Along Path



Duplicate Array
Control-Shift-D

With the Duplicate Array command, it is possible to make multiple copies of the object, resize the 
duplicate, and rotate or move the duplicate. 

Note:     The Duplicate Array command is located on the alternate Edit menu. This menu is activated 
by, pressing the Control key while selecting the Edit menu from the menu bar.

Selecting the Duplicate Array command opens the Duplicate Array dialog box.

The possible array types are: Linear, Circular, and Rectangular. 

Objects can be resized as they are duplicated by selecting the Resize Duplicates button. The object's x 
and y dimensions are multiplied by the specified factor. Values greater than one enlarge the duplicate. 
Values less than one reduce the duplicate.

Duplicated objects can be rotated from the original by selecting the Rotate Duplicates option and 
entering the degree of rotation in the Angle field.

For additional information, see the following topics:
Creating Linear Arrays

Creating Rectangular Arrays

Circular Arrays

For related information, see the following topics:
Copy

Duplicate Along Path

Sweep



Creating Linear Arrays

To create a linear array with the Duplicate Array command, select the Linear Array button in the 
Duplicate Array dialog box. Then, type the number of copies in the Copies field, and enter the x and y 
distance from the center of the original to the center of the copy.

When setting the offset for the direction of the duplication, a positive x value makes the offset move to 
the right. A negative x value moves the duplicate to the left. 

A positive y moves the duplicate upward. A negative y moves the duplicate downward. 

Clicking the Next Mouse button lets you set the offset with the mouse.



Creating Rectangular Arrays

To create a Rectangular array with the Duplicate Array command, select the Rectangular Array button 
in the Duplicate Array dialog box. In this mode, duplicates are placed in rows and columns. 

The Copies field changes to Row and Columns. Type in the desired values. The x offset determines the 
distance from center-to-center of individual columns.

When setting the offset for the direction of the duplication, a positive x value makes the offset move to 
the right. A negative x value moves the duplicate to the left. A positive y moves the duplicate upward. A 
negative y moves the duplicate downward.

Clicking the Next Mouse button lets you set the offset with the mouse.



Circular Arrays

To create a Circular array with the Duplicate Array command, select the Circular Array button in the 
Duplicate Array dialog box. Enter the copies and angle values. 

In the Center field, enter the radius for the arc angle with the x and y fields. The Next Mouse option 
allows the radius for the arc angle to be set with a mouse click.



Edit Attributes

Object attributes, such as fill pattern, line thickness, dash style, arrow head and the color palette can be 
edited with the Edit Attributes command on the Edit menu. 

To edit an attribute, select it from the Edit Attributes' submenu.

For additional information, see the following topics:
Editing Patterns

Editing Line Thickness

Editing Dash Styles

Editing Arrow Heads/Line Markers

Editing the Color Palette



Editing Patterns

Thirty six of the patterns on the Attribute Palette can be edited. These patterns are shown on the 
bottom half of the pattern menu. 

These patterns are edited using the Edit Attributes command's Pattern option. When Patterns is 
chosen from the Edit Attributes submenu, the editable patterns are displayed on the pop-up menu. 

To edit a pattern, select a pattern from the pop-up menu. The full pattern is displayed in the right-hand 
window. A close-up bitmap version of the pattern is displayed in an editing window on the left.

In the editing window you can change the pattern by clicking individual bits off or on. Your changes are 
reflected in the full size window.

Changes to a pattern are global, which means that every instance of that pattern number on your 
drawing is changed. 

Pattern edits are limited to the active drawing. The custom pattern will not be transferred to a new 
drawing if you copy and paste an object with that pattern applied, and there is no way to move a custom 
pattern from one drawing to another. However, if a custom pattern is used repeatedly, you may want to 
edit the pattern and save a blank version of the file with the Save as Stationery command. The new 
pattern will be available to all new documents.



Editing Line Thickness

The Attribute Palette has five default line thicknesses. All five of these default line weights can be 
modified. 

To edit a line weight, choose the Edit Attributes command from the Edit menu, then select the Line 
Thickness option. The Preferred Line Thickness dialog box opens. The values in the edit fields can be 
displayed in points, mils or millimeters. The current line thickness is displayed in the selected unit of 
measure. 

Changes are made by entering new values in the New fields.

When lines are edited, the changes are not global. Lines already in the drawing remain unchanged. To 
change a line to the new weight, select the object and choose the desired line weight from the Attribute 
palette. 

Custom line weights are saved as preferences. They are available in all new drawings. It is not possible 
to return to the default line weights unless the preferences file is replaced. 



Editing Dash Styles

The Dash Styles command on the Edit Attributes menu is used to add a new dash style to the drawing, 
or to change one that is already there.

MiniCad comes with eight standard dash patterns. These standard dash patterns can be edited, and up 
to eight additional dash patterns can be added, for a maximum of 16 patterns.

To create a new dash style or edit an existing one, choose the Edit Attributes command from the Edit 
menu, then select the Dash Styles option. 

To edit an existing dash style, select one from the pop-up menu on the dialog box. To make a new dash 
style, click on the Add button.

The dialog box has three sliders to make the pattern. The first one on the left controls the dash. The 
second one controls the space between the dashes. The slider control on the far right creates two new 
sliders to make additional dashes and spaces.

If you create a custom dash style and apply it to an object, and copy that object into another file, the new 
style becomes available in that file. If you copy a custom dash pattern into a file that already contains the 
maximum sixteen dash patterns, the dash pattern reverts to solid.

The Edit Dash dialog box has the following options:

Dash Style # 
All of the existing dash styles in the active file are displayed in this menu. Choose the dash style to be 
edited from this menu. This menu also is useful for creating new dash styles that are similar to existing 
ones. To create a new style, choose the dash style closest to the new style and click the Add button. 

Inches / mm buttons
Changes the display for reference purposes as the custom dash style is created. It has no real bearing 
on the dash style.

Scale with line thickness checkbox
When selected, the gap between lines is scaled to maintain the gap's proportion as the line is made 
thicker.

Revert 
Discards any changes made to the current dash.

Add 
Adds a new dash style for editing.

Cancel 
Closes the dialog box and returns to the drawing window without any changes.

OK
Accepts the changes and add the new and edited dash styles to the Attribute palette.



Editing Arrow Heads/Line Markers

MiniCad has seven available line markers. Any of the seven default markers can be edited. 

To edit a line marker, choose the Edit Attributes command from the Edit menu, then select the Arrow 
Heads option. 

Each marker occupies a "slot," which is selected from the Arrow # pop-up menu. The marker type to be 
edited is selected with the Style pop-up menu. When clicked, the pop-up menu displays the seven slots 
and the current marker in each.

Arrowhead changes made with the Edit Attributes command are "global." That is, the changes affect all 
MiniCad drawings. These changes are stored in the preferences file.

The Set Arrow Head Size dialog box contains the following options:

Style
The marker to be edited is selected with the Style pop-up menu. When clicked, the pop-up menu 
displays the seven default markers.

Angle
Arrow heads and markers can be any angle up to 90°. The angle of the marker is displayed in the Angle 
field. Any changes in the edit window are reflected in this field. The field accepts direct entry of the arrow 
head angle. In addition, the marker in the edit window reflects any changes to the value in the Angle 
field. Each one of the seven slots can have a different angle on its marker.

Length 
The length of the marker is displayed in the Length field. Any changes in the edit window are reflected in 
this field. The field accepts direct entry of the arrow head angle. Each of the seven slots can have a 
different length marker. The current units for the file is used for the marker length.

Arrow # 
MiniCad has seven "slots" for line markers. Each slot can be edited independently. The slot to be edited 
is selected with the Marker # pop-up menu. When clicked, the menu displays the seven slots, and the 
current marker in each. 



Editing the Color Palette

MiniCad uses a color palette containing 256 different colors. While the palette is limited to 256 separate 
colors, the colors within the palette can be completely customized.

To edit the color palette, choose the Edit Attributes command from the Edit menu, then select the 
Color Palette option. 

The Edit Color Palette dialog contains the drawing's palette. Each box on the palette represents one of 
the 256 available "slots" that can be edited. Boxes can be edited individually, or a range of boxes can be 
edited as a group.

The Edit Color Palette dialog box has the following options:

Pick Color
Opens a dialog box in which the drawing's palette is displayed. The range of colors in this palette 
depends on a number of factors including the computer hardware being used. 

To change a color in the palette, click the color in the palette. The selected color is shown. Changes to 
the color can be made by entering new RGB values in the fields.

Click on the Add to Custom Colors button to add the edited color to the color palette.

Import
Color palettes can be imported from any MiniCad 6 file. When the Import button is clicked, a dialog box 
opens. Select the file containing the color palette to be imported, then click OK. The color palette of the 
selected file replaces the color palette in the active file.

Lighten
When clicked, the selected color, or range of colors is lightened. When a color is lightened, the 
brightness level of the color is adjusted upward about 10 percent.

Darken
When clicked, the selected color, or range of colors is darkened. When a color is darkened, the 
brightness level of the color is adjusted downward about 10 percent.

RGB Blend
Blends the selected range of colors using the RGB color table.

HSV Blend
Blends the selected range of colors using the HSV color table.

Undo
Returns the color palette to the state it was in when the Edit Color Palette dialog box was open (not the 
color palette's default state).



Edit Group
Control-[ 

The Edit Group command on the Organize menu provides a way to edit a grouped object without 
ungrouping it. This is useful if you need to preserve the nested character of a group as well as edit within 
the group.

Note:    This command will automatically appear as Edit Symbol if a symbol is selected. Remember, 
when you edit a symbol, the changes are applied to all instances of that symbol in the drawing.

The Edit Group command is required to make changes to hybrid objects, such as roofs, floors, and 
walls. Although these objects are created without using the group command, they are special grouped 
objects, and need to be entered before they can be edited. 

Important!    Although it is possible to ungroup a hybrid object, you can never regroup it into a hybrid 
object again. For this reason, hybrid objects should always be edited with the Edit Group command. 

When editing a hybrid object, you must display the component you want to edit before you select the 
Edit Group command. Once Edit Group has been selected, you cannot change between 2D and 3D 
projections.

Each time the Edit Group command is chosen, you are taken another level deeper into the group. It is 
possible to hide the rest of the drawing while editing by choosing the Preferences command and 
deselecting the Show Other Objects While in Groups checkbox. This is useful because it reduces 
screen clutter. Conversely, showing the entire drawing helps align objects in the group with the rest of 
the drawing.

When all edits have been made, you can return to the main drawing window by selecting the Exit Group 
command on the Organize menu, or by clicking the Exit Group button in the mode bar. Each level of the 
group you have entered requires a separate Exit Group command. 

If the object has many levels of grouping, the Top Level command on the Organize menu returns to the 
main drawing level in one step.



Engineering Properties

The Engineering Properties command on the Mechanical menu calculates and displays in a data 
window the area, perimeter, centroid, and moments of inertia about both the centroid and any user 
specified point, and the radii of gyration of any selected 2D object.

Note:    This command is only available when the Mechanical Overlay is active. If the Mechanical  
menu is not listed on the menu bar, select Mechanical Overlays using the Overlays command on the 
File menu.

Only one object at a time can be selected for its properties information. However, an object and a locus 
point can be selected together.



Exit Group

 The Exit Group command reverses the action of the Edit Group command. in order to return you to the 
main drawing, this command must be chosen as many times as the Edit Group command was chosen.

When in Edit Group mode, this operation can also be performed using the Exit Group button on the 
mode bar . If you have entered a group that is many levels deep, you may want to use the Top Level 
command on the Organize menu to quickly return to the main drawing.



Export

MiniCad supports a range of export formats that allow objects and data created in MiniCad to be 
manipulated in other programs. 

Exporting in a different format does not change the original file. It creates a new file in the format 
specified.

A dialog box allows you to name the exported file and save it to the disk and folder of your choice. The 
following formats are supported:

Export Pict

Export EPSF

Export DXF

Export Text Format

Export Worksheet

Export Database



Export Pict

Exports a MiniCad file as a PICT document. A loss of resolution may occur during a PICT export. 

Files exported as PICT carry object-oriented attributes such as thin lines, fill patterns, and object colors.



Export EPSF

Files exported in EPSF format can be read by many other graphic and page layout programs. MiniCad 
exports EPSF files at high resolution with full accuracy. 

All drawing elements, except color bitmaps, appear in the EPSF file as you see them on screen, 
including 3D objects and grayed layers. Color bitmap objects are not supported and do not appear in the 
EPSF file. 

MiniCad EPSF files are exported in Illustrator '88 format. They can be edited in any program that 
supports that format, including Illustrator 5.0 by Adobe. 



Export DXF

Files exported in DXF can be read by other CAD programs and printed at a service bureau. DXF is the 
de facto standard in the DOS CAD marketplace. 

Files saved in DXF can be opened in AutoCAD. DXF exports can be used to transfer a MiniCad 3D 
model into a rendering program, such as Specular's Infini-D or into a modeling program, such as FormZ 
by autodessys.

The DXF translator in MiniCad writes to DXF 12 format. 

MiniCad reads all 2D and 3D entities in the DXF export file. All visible objects in visible layers are 
exported. Export of 2D or 3D information depends on the projection chosen at export. That is, if a layer is 
in 2D/Plan projection, the DXF export is in 2D. If the layer is in a 3D projection, it is exported in 3D.

To export a file in DXF format, choose Export from the File menu and DXF on the submenu. Name the 
exported file and choose a location to place the file in.

The Export DXF dialog box contains the following options:

Export as DXF Layers
This menu contains four choices for converting different MiniCad structures into AutoCAD layers. 

The default converts MiniCad layers into AutoCAD layers. This is the most straightforward conversion 
process. 

You also can use MiniCad classes, which can actually mimic the AutoCAD layer structure more 
accurately. The pen foreground and background also can be used to generate the AutoCAD layers.

Export 2D Objects Only/Export 2d & 3d Objects 
Choose one of these options. All AutoCAD drawings contain 3D information. However, MiniCad can 
create objects that are only 2D. 

If a drawing contains objects drawn exclusively with the 2D drawing tools, you can choose to export as 
2D only. The resulting file is significantly smaller. 

Select 2D & 3D to export the complete file geometry.

Decompose 3D Symbols into 3D Polys 
Some programs that import DXF block information do not handle MiniCad symbols correctly. Selecting 
this checkbox converts all 3D symbols into grouped 3D polygons. The object looks like the symbol, but 
imports correctly. The object does not convert into a DXF block.



Export Text Format

MiniCad files can be exported as text. All objects and attributes are exported with the file. 

MiniCad text files can be imported into any open MiniCad file. This can be used to repair a damaged file. 
It also can be used to import files from older versions of MiniCad.

Text exports also can be used to create start-up files. The use of start-up files is an obsolete way to 
change the defaults on a new file when it is opened. This method has been replaced by stationery files in 
newer versions of MiniCad. Start-up files are retained in MiniCad to maintain compatibility with older 
versions of the program.



Export Worksheet

The MiniCad worksheets can be exported in comma delimited, tab delimited, merge, DIF, or SYLK 
formats. 

The files exported in any of these formats can be read by other programs such as Microsoft's Excel or 
Claris' FileMaker. Files saved in tab delimited format can be opened as a table in Microsoft Word.

All or part of a worksheet can be exported. Note that the different export formats support different 
aspects of the original worksheet. Generally, exporting the values in a file rather than the formulas has 
more predictable results. It is a good idea to experiment with the different formats and check the results 
in the target program. 

To export the contents of a worksheet, you must open the worksheet first. If you want to export just part 
of a worksheet, select the rows you wish to export. If multiple worksheets are open, make the worksheet 
to be exported the active worksheet. 

Next, choose Worksheet from the submenu of the Export command. The Export Worksheet dialog box 
opens. 

This dialog box has the following additional options:

All rows/Selected Rows Only 
Select one of these choices. If only part of the worksheet is exported, you must select the rows before 
the Export command is chosen.

Format
Select one of the formats from the drop-down list.

Comma
Each cell in the exported worksheet is separated with a comma. The file is exported by rows.

Tab
Each cell in the exported worksheet is separated with a tab character. The file is exported by 
rows. Exporting worksheets as tab delimited files usually gives the best results.

Merge
Used mainly in text-processing programs to produce mail merge documents. It is quite useful for 
placing different information in the same location in multiple documents.

DIF
Used for placing worksheet information in database programs. 

SYLK
Used to export worksheet formulas, not just the results. However, since the syntax used to build 
the formulas in a spreadsheet differs from program to program, check the resulting file to be sure 
it contains the proper values when the formulas are calculated. 



Export Database

Database records and fields can be exported. To export a database record or field, choose Export from 
the File menu and Database on the submenu. The exported file can be read by other programs such as 
Microsoft's Excel, or Claris' FileMaker.

When you select the Database command, a dialog box opens. Select a record from the scrolling list. 
Next, select the fields you want to export. Upon clicking OK, you are asked to name the exported 
database and choose a location to store it. 

Choose the desired format from the Format menu: 

Comma
When a database worksheet is exported, each subrow cell in the worksheet is separated with a comma. 
The file is exported by subrows.

Tab
When a database worksheet is exported, each subrow cell in the worksheet is separated with a tab stop. 
The file is exported by subrows. 

Merge
Used mainly in text processing programs to produce mail merge documents. It is quite useful for placing 
different information in the same location in multiple documents.

DIF
Used for placing database worksheet information in standard database programs. 

SYLK
Used for placing database worksheet information in standard spreadsheet programs.



Extrude
Control-E

Extrude is the process that gives a z dimension to a 2D object, turning a 2D object into a 3D object. 
Objects are extruded with the Extrude command on the 3D menu.

Note:     The default z for an extruded object is the active layer's Dz. If you want to set a different z than 
this, use the Extrude... command. 

If an object with a fill is extruded, it extrudes as a wireframe solid. (The fill is not displayed until the object 
is rendered.)

When extruding, the z axis is always the extruded axis, and that axis is determined by the current view. 
For example, if you extrude in Top/Plan view, the z is the "height" of an object. But, if you extrude from 
the Front view, the z is the "depth" of the object. 

The following objects can be extruded:

· Rectangles (including rounded rectangles)

· ovals/circles

· arcs and quarter arcs

· polygons

· freehand lines

· polylines.

Groups cannot be extruded. However, multiple selections can. When extruded, multiple selections 
become a group of 3D objects. They can be ungrouped with the Ungroup command and edited 
separately. 

In addition, groups can be entered with the Edit Group command and edited without ungrouping. The 
only way text can be extruded is by first converting it to polylines with the Truetype to Polyline 
command.

A line is extruded as a flat plane. All other objects are extruded as wireframe solids.

To extrude an object, select it and choose the Extrude command. 

To reshape an extrusion, select it and open the Object Info Palette. Enter the new values for the Dx, Dy 
and Dz and click OK. 

You also can reshape an extruded object with the 3D Reshape tool on the 3D Tool palette.

For related information, see the following topics:
Multiple Extrude

Extruded Polygon

Extruded Rectangle

Sweep



Extrude...

The Extrude... command is identical to the Extrude command except that instead of using the layer Dz 
for the extrusion it opens a dialog box where the extrusion is set. 

Note:     The Extrude... command is located on the alternate 3D menu. This menu is activated by, 
pressing the Control key while selecting the 3D menu from the menu bar.



Fit to Objects

The Fit to Objects command has two forms. It will perform differently depending on whether an object is 
selected or not.

· If no objects are selected on the drawing, the window zooms-out to show all objects on the 
drawing, even if they are outside the print boundary. This differs from the Fit to Window 
command which zooms-out to show only those objects that fall within the print boundary. The 
print boundary is defined by the gray border shown on screen; all objects inside the boundary are 
printed. 

· If an object is selected on the drawing, the window zooms-in to show just the selected object.

For related information, see the following topics:
Zoom Out

Zoom In

Fit to Window

Normal Scale



Fit to Window
Control-4

The Fit to Window command places the entire drawing, even multiple pages, within the drawing window 
of the screen. The drawing is displayed with the center of the page(s) at the center of the screen. The 
Normal Scale command or the Zoom In tool can then be used to view a detail within the drawing.

You can move quickly from one section of a large drawing to another by selecting Fit to Window, 
selecting an object in another part of the drawing, and choosing Normal Scale.

For related information, see the following topics:
Zoom Out

Fit to Objects

Normal Scale



Floor

The Floor command on the AEC menu, greatly simplifies the creation of floors and decks. For example, 
if the specifications for the floors in a floorplan call for the use of 2 x 10's with a subfloor of 3/4'' plywood, 
the thickness of the floor is then set to 10 3/4" and all subsequent floors have a thickness of 10 3/4" (until 
the value in the Thickness field is changed). This reduces the number of calculations you must perform 
as you draw. 

Note:    This tool is only available when the AEC Overlay is active. If the AEC menu is not listed on the 
menu bar, select AEC Overlays using the Overlays command on the File menu.

The Floor command produces a hybrid 2D/3D object from a 2D original. A floor can be of any shape or 
thickness, but it must be flat. A floor must always be created parallel to the ground plane.

The Floor command also simplifies the creation of stairwells, lightwells, and balconies.

For additional information, see the following topics:
Making Floors

Editing Floors

Calculating Floor Area and Perimeter



Making Floors

To create a floor, draw the primitive from which the floor is created, using any combination of the 2D 
surface tools (e.g., Rectangle, Ellipse, or Polygon). Use the Add Surface command to combine different 
objects into a single object. 

Holes for a chimney, lightwell, or stairwell can be cut in the primitive using the Clipping tool. Holes also 
can be made by drawing an object the size of the desired hole and positioning it on the primitive. Select 
both objects and choose the Clip Surface command.

When the primitive is finished, select it and choose the Floor command on the AEC menu. The Create 
Floor dialog box opens. There are two fields in the dialog box, one for the floor's z    height and the other 
for its thickness. 

Bottom Z 
The Bottom Z dimension of a floor is the distance from the bottom of the floor to the bottom of the layer. 
If the floor is in its own layer, enter 0 in the Bottom Z field. 

Generally, a floor should be placed in its own layer. If a floor is in the same layer as the walls that 
surround it, door and window symbols must be adjusted for the floor's thickness. And, since floors vary in 
depth, symbols cannot be placed at a uniform z height. 

Thickness 
The Thickness field is used to specify the total dimension (joists, subflooring, and flooring) for the floor.

For related information, see the following topics
Editing Floors

Calculating Floor Area and Perimeter



Editing Floors

A floor is a group of objects. Thus, the Edit Group command must be used to edit a floor. After the floor 
has been entered, the original 2D primitive is displayed in the edit window.

The Add Surface command can be used to combine new 2D components to the primitive. Holes for a 
chimney, lightwell, or stairwell can be cut in the primitive using the Clip tool. 

When finished with the edits, click on the Exit Group button in the mode bar or choose the Exit Group 
command in the Organize menu. The floor reappears with all of the changes.

For related information, see the following topics:
Floor

Making Floors

Calculating Floor Area and Perimeter



Calculating Floor Area and Perimeter

The area and perimeter can easily be calculated for the floor. One method is to select the floor, and 
choose the Edit Group command. The area and perimeter of the primitive will be displayed in the 
Object Info Palette.

Another method of determining area and perimeter is to create a worksheet. The area can be calculated 
using the AREA function on the SLAB object type.

For related information, see the following topics:
Floor

Making Floors

Editing Floors



Font

The Font command on the Text menu displays a list of all fonts installed in the system. The currently 
selected font is identified with a checkmark next to its name.

A single text block can have multiple fonts. To set the default font, deselect the Text tool and choose a 
font from the Fonts submenu. 

To change the font of a string of characters within a text block, select the characters with the Text tool, 
then choose a font with the Font command.

Text is drawn in the current pen color. To make text in a different color than the current color, change the 
pen foreground color in the Attribute Palette. 

A block of text also has a fill color. To insert the block of text onto an object that has a fill, change the text 
block background to match the object's background color.

The text within a text block can be many different colors, but the background must be a single color.

For related information, see the following topics:
Size

Style

Text

Editing Text



Size

The Size command on the Text menu, opens a submenu of available point sizes for the fonts installed in 
the system. A single text block can have multiple font sizes. 

Outline fonts, like Type 1 PostScript or TrueType, are available in all point sizes. Bitmapped fonts come 
in a limited number of supported sizes. Only the supported sizes will display correctly. The supported 
sizes are displayed in the submenu in outline form. 

The Set Size command opens a dialog box that allows you to enter a font size that is not on the 
submenu.

To set the default font size, deselect the Text tool and select a size with the Size command. 

To change the font size of a string of characters within a text block, select the characters with the Text 
tool, then choose a size with the Size command.

To change the font size of an entire text block, select the block and select a size with the Size command.

For related information, see the following topics:
Font

Style

Text

Editing Text



Style

A text block can have multiple font styles (e.g., italic, bold), which can be selected using the Style 
command on the Text menu.

To set the default font style, deselect the Text tool and choose a font from the Style submenu. 

To change the font style of a string of characters within a text block, select the characters with the Text 
tool, then choose a style with the Style command.

For related information, see the following topics:
Size

Font

Text

Editing Text



Grid Creator

The Grid Creator command is part of the Cross Stitch toolkit. It is designed to work with the Symbol 
Paint tool and the Cross Stitch stationery supplied with the Cross Stitch toolkit. This toolkit simplifies 
the creation of cross stitch patterns.

The Grid Creator command creates a tenth-of-an-inch spaced grid with the number of squares 
specified. The grid is made of lines. 

Note:     This is not the grid used to align objects in a standard drawing. That grid is created and 
controlled with the Set Grid command.

The snap grid must be active, with the current snap set to one-tenth of an inch, for the symbols to fill the 
grid correctly. The Symbol Paint tool, which is used to apply a pattern to the cross stitch grid, 
automatically scales symbols to the current snap grid size.



Group
Control-G

Sometimes it is convenient to treat two or more objects as a single object. The Group command on the 
Organize menu takes multiple selected objects and turns them into a group. 

As a group, the multiple objects act as a single object with a single set of selection handles. Any 
combination of objects, symbols and text can be grouped. 

Selected groups can be combined into another group. Although a group has a single set of selection 
handles, objects within the group retain their original snap points. 

Groups are returned to single objects with the Ungroup command on the Organize menu. Multiple 
Ungroup commands are needed to completely ungroup nested groups.

Objects within groups can be edited without ungrouping using the Edit Group command.

A group is created by selecting all objects to be grouped. Objects may be selected using a marquee, 
Control-Marquee, clicking, or Shift-Clicking. After the objects are selected, choose the Group 
command to group them.



Guides

Guides are objects used to align different components of a drawing. Guides work with the snap 
constraints found on the Constraint palette. They also can be used for visual alignment. 

There are five different Guides commands used to create, display, select, or remove guide lines from the 
drawing:

For additional information, see the following topics:
Make Guides

Select Guides

Show guides

Hide Guides

Delete All Guides



Make Guides

The Make Guides command on the Guides command's submenu, creates a guide object from any 
selected object on the drawing. 

Any object on the drawing can be converted into a guide. By default, the guide object is the same color 
as the reference grid. 

The appearance of a guide or grid is determined by the monitor. On a color monitor, they are light blue, 
whereas on a black and white monitor, they appear as a dotted line.



Select Guides

The Select Guides command on the Guides command's submenu selects all guides on the drawing.

When selected, the guide's color can be changed by changing the pen color on the Attribute palette.



Show guides

The Show Guides command on the Guides command's submenu displays all guide objects on the 
drawing.



Hide Guides

The Hide Guides command on the Guides command's submenu suppresses all guide objects on the 
drawing. This can help reduce screen clutter.



Delete All Guides

 The Delete All Guides command on the Guides command's submenu deletes all guide objects on the 
drawing.



Hatch

The Hatch command on the Tool menu applies a predefined line pattern to a surface. Hatch patterns 
are traditionally used to represent specific materials or to show the profile of a section. 

MiniCad includes numerous library files which contain predefined hatch patterns. Additional, custom 
hatch patterns can be created. Hatches are imported and edited with the Resource Palette, but applied 
to objects with the Hatch command.

Hatches are created as a pattern of lines. Because the hatch is comprised of lines, the lines are 
translated correctly when the file is exported in DXF format. This is an important advantage over 
standard fill patterns which cannot be translated in DXF. This is also an important consideration if the file 
will be printed at a service bureau that uses DXF format. 

Hatches can also be created in paper scale, to make them appear appropriate in a scaled drawing. This 
is another major difference with fill patterns, which are always in world scale.

To apply a hatch pattern, select a filled object on the drawing. Choose the Hatch command. 

In the Select Hatch dialog box, select a hatch pattern from the scrolling list. Click Apply. The dialog box 
closes and the cursor changes to a paint can. 

Place the cursor within the object to be hatched and click. The hatch draws within the filled object. If 
multiple objects are selected, the hatch is applied to the specific object in which the cursor is placed.

Hatch patterns are created as separate objects from the objects to which they are applied. Because the 
hatch and the object are separate, you may want to use the Group command to combine them. That 
way the hatch and the object can be moved as a unit. 

If the object and the hatch are grouped, resizing the group can distort the hatch. To correct this distortion, 
ungroup the object, delete the hatch and reapply it. 

For additional information, see the following topics:
The Select Hatch Dialog Box



The Select Hatch Dialog Box

The Select Hatch dialog box is used to select and edit a hatch style. It has the following options:

Hatches
All hatches contained in the active file are listed in the Hatches scrolling list. The selected hatch is 
displayed in the window. Hatches to be applied to objects on the drawing are selected from this list. 
Hatches are also selected from this list before they are edited, removed, or duplicated.

Remove 
Removes the selected hatch from the active file. A dialog box asks you to confirm the deletion.

Duplicate 
Duplicates the selected hatch. Duplicating a hatch is useful for making a new hatch similar to an existing 
one. 

Cancel 
Closes the dialog box without making any changes.

Edit 
Opens the selected hatch in the Edit Hatch dialog box. The hatch is displayed in the window on the 
dialog box. Existing hatches can be renamed by selecting the hatch, clicking the Edit button, and typing 
a new name in the Name field.

For more information about the Edit Hatch dialog box, see the Hatches topic under the Resource 
Palette.

New 
Opens the Edit Hatch dialog box so that a new hatch pattern can be created. For more information 
about the Edit Hatch dialog box, see the Hatches topic under the Resource Palette.

Apply 
When clicked, the selected hatch in the scrolling list becomes the active hatch. When the Apply button is 
clicked (or the Enter key is pressed), the dialog box closes and the cursor changes to a paint bucket. 

When the cursor is placed inside the selected object, and the mouse is clicked, the active hatch is 
applied.



Hex Socket Screw

The Hex Socket Screw command on the Mechanical command's submenu is used to draw the top or 
side view of a socket cap screw. 

Note:    This tool is only available when the Mechanical Overlay is active. If the AEC menu is not listed 
on the menu bar, select Mechanical Overlays using the Overlays command on the File menu.

The parameters are specified in the Create Hex Socket Screw dialog box. It contains the following 
options:

Head styles
Head styles include cap head, button head, and flat head. 

Nom size
Nominal sizes, which are read from data files supplied with the external, are selected from the Nom Size 
pop-up menu. 

The data files can be edited in any word processor, allowing custom sizes to be added by the user. The 
data files for drawing the screws are located in a folder named "External Data," which is in the Externals 
folder.

Screw 
The length of the screw is entered in the Screw Length field. 

Detail 
The threads can be drawn in detail, either Unified National Fine (UNF) or Coarse (UNC), or as dotted 
lines (No Detail).

In addition there are buttons to select the top or side view of the screw, and buttons to determine 
whether English or metric measurement is used.

For related information, see the following topics:
Machine Screw



Import

Files can be imported into MiniCad in a number of ways. Before importing a file, determine its file type to 
identify which import method to use. 

If MiniCad does not support the format for the file to be imported, you may be able to do a "Save As" 
within the original program and save it into a format MiniCad can read. 

The following import formats are supported:

Import PICT

Import PICT as picture

Import EPSF

Import DXF

Import Text Format

Import worksheet



Import PICT

Used to import PICT files into MiniCad.



Import PICT as picture

PICT as Picture imports with full resolution. A PICT as Picture import is a single graphic object. The 
only editing possible to an imported PICT as picture is resizing. No other editing of the object is 
possible. Greyscale and color images (including 24 bit) retain their quality when they are imported as 
PICT as Picture.



Import EPSF

MiniCad imports Encapsulated PostScript Format. EPSF is a high resolution format. To import a file, 
select the file from the directory dialog box which opens when you choose this command.



Import DXF

The Data Exchange Format (DXF) is the de facto standard in the DOS desktop CAD market. MiniCad 
reads AutoCAD release 12. 

Both 2D and 3D entities can be imported through DXF. If 3D entities are detected in the file to be 
imported, two options are given. One will import 3D objects as 2D, the other imports as 3D.

When importing a DXF file, always start with a blank, unformatted document. If you do not start with a 
blank unformatted document, the translation may fail (you can set attributes and preferences after the file 
is successfully imported). 

Set the drawing scale to 1:1 prior to import. Units settings need to be made prior to the import process; 
i.e., if the file that the DXF information originated from was done in meters, the units settings need to be 
set to meters. If the translator detects a difference in units, a dialog box opens to notify you. 

Minor text repositioning can be required after a DXF import because of the inherent differences in the 
way DOS files handle text.



Import Text Format

MiniCad documents that have been exported in text format can be imported into any open document. 
MiniPascal macro files also can be imported as text.

Text format is not to be confused with text created with a word processing program. Text created in a 
word processing program can be copied to the Clipboard, and from there, pasted into a MiniCad text 
block.



Import worksheet

MiniCad can import worksheet information that is saved as comma delimited, tab delimited, DIF, or SYLK 
format. A worksheet must be open, and active, to import the data into the active MiniCad document. 



Intersect Surface

The Intersect Surface command on the Tool menu creates a new object from the overlap (i.e., 
intersection) of two selected objects. 

Any combination of the following objects can be intersected: 
· Rectangles
· Rounded rectangles
· Ellipses/circles
· Quarter arcs
· Full arcs
· All types of polygons (regular, freehand, and polylines). 

Any object that can be filled and that isn't in a group can be intersected.

When two surfaces are intersected, the object in front is intersected with the object in back. If the objects 
have fill patterns, the new object has the fill pattern of the rearmost object. 

If the objects are open, they are converted to closed polygons before they are intersected. 

To intersect objects, arrange them in the desired order. Remember that MiniCad creates a new polygon 
from the overlapping parts of the objects, and that each object intersects the one below it. If necessary, 
use the Send command to place the objects in the proper order. Select all objects then choose Intersect 
Surface.

For related information, see the following topics:
Clip Surface 

Clip

Combine into Surface 

Add Surface



Join
Control-J

The Join command on the Tool menu takes two segments of a nonparallel line and joins them together. 
Both single and double lines can be joined. 

Walls also can be joined, as can combinations of walls and double lines. The Join command extends the 
lines as required to form the join.

To join two segments of a single line, select both segments and choose the Join command.

The result of the join operation depends on the segments selected: 

· If two segments of a line join to form a 'T', one segment of the longer line is trimmed away. 

· If the lines overlap, the Join command trims the excess. 

Double lines are joined with some different considerations:

· In order to form a 'T' intersection of two double lines, the two sets of double lines cannot intersect. 

· In order to form a cross intersection, the two sets of lines must intersect. 

· In order to form a corner with a double line, the outer lines must not intersect, otherwise a "T" is 
formed. 

For related information, see the following topics:
Join and Fillet

Join and Trim

Wall

Butt-Join Wall

Y-Join Wall



Join and Fillet
Control-Shift-J

The Join and Fillet command is used to join selected double lines with a filleted intersection.

Note:     The Join and Fillet command is located on the alternate Tool menu. This menu is activated by, 
pressing the Control key while selecting the Tool menu from the menu bar. You must also have a 
double line selected when you select the Tool menu, otherwise the Join and Fillet command will not 
appear.

If a fillet radius has not already been defined, the Fillet Radius dialog box opens. Enter the radius in the 
Fillet Radius field and click OK. 

For related information, see the following topics:
Join

Join and Trim



Join and Trim
Control-Shift-J

The Join and Trim command is used to join and trim selected single lines.

Note:     The Join and Trim command is located on the alternate Tool menu. This menu is activated by, 
pressing the Control key while selecting the Tool menu from the menu bar. You must also have a single 
line selected when you select the Tool menu, otherwise the Join and Trim command will not appear.

For related information, see the following topics:
Join

Join and Fillet



Layers

Layers are controlled with the Layers command on the Organize menu or with the Layer pop-up menu 
on the Data Display bar.

A description of MiniCad's layers, and their uses can be found under General Information about 
Layers.

When the Layers command is selected, the Layers dialog box is selected. This dialog box is used to 
create new layers and edit existing ones.

It contains the following options:

Note:    the Layers Setup control keys can be used to select many of these options. See the Layers 
Setup Control Keys for a list of these keys.

Name 
Displays the name of the selected layer in the scrolling list. A layer can be renamed by selecting the 
desired layer and typing a new name in the field. Each layer must have a unique name.

New 
Adds new layers to the drawing. You are asked to name the new layer; Layer-n is entered as a default. 
Each layer in a drawing must have a unique name.

Remove 
Removes the selected layer from the drawing. All objects on the layer are removed from the drawing. 
You are warned before the command takes effect because this action cannot be undone.

Top 
Sends the selected layer to the top of the scrolling list. This affects display and print order of layers in 
2D/Plan. Scrolling order has no effect on the z dimension of the layers.

Up 
Moves the selected layer one layer up the scrolling order. This affects display and print order of layers in 
2D/Plan. 

Down 
Moves the selected layer one layer down the scrolling order. This affects display and print order of layers 
in 2D/Plan. 

Bottom 
Sends the selected layer to the bottom of the scrolling order. This affects display and print order of layers 
in 2D/Plan. 

Active layer 
Makes the selected layer the active layer and displays it. The active layer is always visible, regardless of 
its visibility setting.

Normal 
Makes the selected layer visible. A solid diamond is displayed in the scrolling list. Visible layers are 
printed and can be edited from other layers, if desired. 

Grayed 
Displays 2D layers as a grayed outline when viewed from other layers. A hollow diamond is displayed in 
the scrolling list. Text and fills are invisible in grayed layers. A grayed layer prints as displayed. 3D layers 
do not display if they are grayed.

Invisible 
Makes the selected layer invisible when viewed from other layers.



Transfer mode
This pop-up menu controls visual attributes that apply to objects drawn on that layer. These settings are 
most useful on black and white monitors. Transfer modes are unpredictable when used on color 
monitors. Moreover, except for paint and overlay, these settings are not supported on PostScript printers 
or on plotters. 

For details about this menu, see The Transfer Mode Pop-up Menu.

Scale
The Scale option is used to assign a scale to the layer. While a drawing can include objects drawn in 
different scales, each layer can have only one scale. Therefore, in one drawing (but all in different 
layers), a title block can be in 1:1, a site plan in 1:50, a floor plan in 1/4" and details in 1/2".

When you select the Scale option, the Drawing Scale dialog box appears. It offers architectural, 
engineering and enlargement scales. 

The value in the Paper Scale field will change to reflect changes in the scale. You can type a value 
directly into the field, if desired. 

If you want to set a default scale for all layers in the drawing, select the All Layers checkbox. Care must 
be taken when using this option, as it overrides any settings made in layers setup.

If you want text to be scaled with the drawing, select the Scale Text option.

Colors
The Colors option allows you to select a color, for both pen and fill, that applies to the entire layer. Use 
of layer color is a convenient way to differentiate elements on a complex drawing. 

Any settings made with the Colors option are visible only if the Use Layer Colors checkbox is selected 
in the Preferences dialog box. Layer color supersedes any object color attributes. The object attributes 
remain, but display only when the Use Layer Colors checkbox is deselected.

Z
The Layer z setting is the distance to the ground plane from the selected layer. This distance is important 
when using the Layer Link command to view multiple layers together.

DZ
The DZ setting is the default height for 3D objects created in the selected layer. For example, if an object 
is extruded in a layer with a 8' z, the object's z value is 8'.

For related information, see the following topics:
Layer Options

Create Layer Link



The Transfer Mode Pop-up Menu

Paint
Makes objects solid and obscures objects in layers below.

Overlay
Makes objects transparent so they do not obscure objects in layers below.

Invert
Creates a photo negative image on areas where objects overlap each other on different layers.

Erase
Gives objects a transparent effect, but with all foreground patterns displayed as white and all background 
patterns displayed as "None" (transparent).

Not Paint
Displays the objects as solids and inverts the colors on areas where objects overlap on different layers.

Not Overlay
Gives objects a transparent effect and inverts layer colors

Not Invert
Gives objects a transparent effect and makes overlapping black pixels from other layers turn white and 
the white pixels transparent.

Not Erase
Gives objects a transparent effect and makes overlapping white pixels from other layers turn black and 
the black pixels transparent.



Layers Setup Control Keys

The Layer Setup dialog box has a unique set of keyboard commands that can be used to select options 
for the active layer in the Layers Setup dialog box. The Layers Setup dialog box must be open when 
these commands are issued.

Layers Control Keys

Control-A Activate layer

Control-B Send layer to bottom level

Control-D Send layer down one 
level

Control-G Gray out layer

Control-I Make layer invisible

Control-K Color

Control-M Normal visibility

Control-N Create new layer

Control-R Remove layer

Control-S Set scale

Control-T Send layer to top level

Control-U Send layer up one level

General Information about Layers

Layers and Classes are two different ways MiniCad gives you to organize the elements in your drawing.

In standard 2D CAD, layers are similar to a stack of transparent mylar, where one element is 
superimposed over another. Layers in 2D CAD have a stacking order, which determines the order in 
which the layers are displayed and printed.

In MiniCad, layers can have different scales, projections, rendering, and visibility. Any layer in the 
drawing can be grayed, invisible, or visible. 

Because MiniCad is a 3D program, layers have a z dimension in addition to the traditional x and y 
dimensions. The z dimension is measured from the ground plane, and can be either a positive or 
negative number. This way layers can occupy the same place in space, stacked one atop the other, or 
be arranged in any order desired. 

When working in 3D, layers can be dynamically linked to each other. Layers must be linked before they 
can be viewed or rotated together. Any number of layers can be linked and edits to one layer are 
reflected in the linked layer with each screen redraw. 

A single layer can be linked repeatedly, giving multiple views of the same layer. Layers are linked with 
the Create Layer Link command on the 3D menu. 

For related information, see the following topics:
Layers

Layer Options

Create Layer Link



Layer Options

The Layer Options command on the Organize menu controls how layers interact with each other, and 
how they are seen. The following choices can be made from the Layer Options submenu.

Active Only
When selected, only the active layer is displayed. All other layers are hidden. If the file is printed, only the 
active layer is printed. (MiniCad always prints what is displayed on the screen.)

Gray Others
When selected, all visible 2D layers are grayed, and the active layer is displayed normally. Only the 
active layer can be edited. 3D layers cannot be grayed.

Show Others
All layers are displayed normally, but only the active layer can be edited.

Show /Snap Others
All layers are displayed normally, but only the active layer can be edited. The active layer snaps to 
objects on other layers if they are in the same scale and projection. You cannot snap between 3D layers.

Show /Snap/Modify Others
All layers are displayed normally and all visible layers can be edited if they are in the same scale and 
projection. The active layer snaps to objects on other layers. You cannot snap between 3D layers.

All selection handles in the active layer are black. Selection handles on other layers are hollow and 
locked objects have grayed handles.

You can snap between layers only if the layers are in the same scale and projection.

For related information, see the following topics:
Create Layer Link

Layers

Layer Options



Link Text to Record

A text block can be linked to a record that is attached to a symbol. The text appears with the symbol 
when the symbol is placed. The text can be edited in the Data pane of the Object Info Palette or with 
the Record Format command.

The Link Text to Record command on the Organize menu can be used to identify individual symbols. 
Even though all symbols are identical, linked text allows a unique number to be attached to a symbol on 
the drawing. A database can be then configured to list of the symbols with their unique numbers.

To link text to a symbol, select 1) a symbol placed on the drawing and, 2) a text block. Choose Link Text 
To Records. 

From the Choose Field dialog box, select a format to open and a record to attach to the symbol. All 
instances of the symbol placed thereafter will have the text block attached. 

The text block's position relative to the symbol can be edited with the Edit 2D button on the Symbol 
dialog box.

To edit the text in the symbol, select the symbol. Open the Object Info palette, make the Data pane 
active and select the record to be edited. The text can be edited directly in the edit field.



Lock

MiniCad allows you to protect objects from accidental movement, deletion, or editing with the Lock 
command on the Edit menu.

Any object that is selected when the Lock command is chosen becomes locked. 

A locked object has grayed selection handles. A locked object cannot be edited, moved, or deleted. 

If a worksheet placed as a graphic on a drawing is locked, it is updated if the underlying worksheet is 
updated. However, it cannot be moved, deleted, or edited in any other way.

The Unlock command on the Edit menu can be used to unlock a selected object. 



Machine Screw

The Machine Screw command draws the top or side view of a socket cap screw. This command is 
located on the Mechanical command's submenu on the Toolkit menu. 

Note:    This tool is only available when the Mechanical Overlay is active. If the Mechanical menu is not 
listed on the menu bar, select Mechanical Overlays using the Overlays command on the File menu.

The parameters used to create the screw are specified in the Create Socket Cap Screw dialog box. It 
contains the following options:

Head Styles
Head styles include cap head, button head, and flat head. 

Nom Size
Nominal sizes, which are read from data files supplied with the external, are selected from the Nom Size 
pop-up menu. 

The data files can be edited in any word processor, allowing custom sizes to be added by the user. The 
data files for drawing the screws are located in a folder named "Data," which in turn was placed in the 
External folder when MiniCad was installed.

Screw Length
The length of the screw is entered in the Screw Length field. 

Detail Buttons
The threads can be drawn in detail, either Unified National Fine (UNF) or Coarse (UNC), or as dotted 
lines (No Detail).

For related information, see the following topics:
Hex Socket Screw



Move
Control-M

The Move command allows for precise movement of an object. This can be quite useful whenever 
precision is required to move an object or group. 

You can use either Cartesian or polar coordinates to move your object. Cartesian moves an object in its 
x and y axis; polar moves it in terms of distance and angle.

To use this command, select an object, group, or multiple selection and then choose the Move command 
from the Tool menu. Enter the value in the appropriate field for the distance you want the object moved 
and click OK.

For related information, see the following topics:
Nudge

Move 3D

Move Working Plane



Move 3D
Control-Shift-M

The Move 3D command on the Tool menu allows for precise movement of an object in the x, y, and z 
axes. This can be useful whenever precision is required to move an object or group through 3D space. 

If the working plane has been changed, the i, j and k axes control the movement of the object.

To use this command, select an object, group, or multiple selection and select the choose the Move 3D 
command. 

Enter the value in the appropriate field for the distance you want the object moved and click OK.

For related information, see the following topics:
Move

Move Working Plane



Move Working Plane

The Move Working Plane command on the 3D menu is the most accurate way to move a working 
plane. 

When this command is chosen, the Move Working Plane dialog box opens. This dialog box allows the 
choice between the x, y, z or the i, j, k axes, and has fields for specifying the movement.

The working plane is a user definable plane used while working in 3D. Multiple working planes can be 
configured in a MiniCad drawing. Working planes are created with the Working Plane palette. 

For related information, see the following topics:
Working Plane Palette

Move 3D



Multiple Extrude

The Multiple Extrude command allows multiple objects to be extruded in a linear, stepladder fashion. 
The Multiple Extrude command allows pyramids, spheres and similar objects to be created.

When objects are extruded, the first object created is located at the bottom of the stacking order. This 
object is extruded to the second object, which is extruded to the third object, and so forth. This continues 
until the last object is extruded. 

The distance between objects is constant throughout the extrude. The x and y dimensions can change 
for each object in the stack, which allows the extrude to flare in any direction. A locus can be used to 
bring the extruded object to a point. 

Note:     The default z for an extruded object is the active layer's Dz. If you want to set a different z than 
this, use the Multiple Extrude... command. 

The result of a Multiple Extrude is a grouped, 3D object. The height of the object can be changed by 
selecting it and entering a new Dz for the object in the Object Info Palette.

If you choose the Edit Group command on the Organize menu with a selected multiple extrude object, 
the original 2D objects are displayed in the edit window. Edits to the original objects modify the extrusion. 

If the multiple extrusion is converted to a mesh, the individual vertices of the object can be edited.

For related information, see the following topics:
Extrude

Extruded Polygon

Extruded Rectangle



Multiple Extrude...
Shift-Control-E

The Multiple Extrude...    command allows multiple objects to be extruded in a linear, stepladder fashion 
to a height specified in a dialog box. 

Note:     The Multiple Extrude command is located on the alternate 3D menu. This menu is activated by, 
pressing the Shift and Control keys while selecting the 3D menu from the menu bar.

The Multiple Extrude... command works identically to the standard Multiple Extrude command, except 
that the height of the object is determined at creation using a dialog box instead of using the current 
layer's Dz setting. 

When the Multiple Extrude... command is chosen, the Create Extrude dialog box opens. The Dx and 
Dy values for the selected objects are displayed. 

Enter the desired Dz in the Extrusion field and click OK.

For related information, see the following topics:
Extrude

Extruded Polygon

Extruded Rectangle



New
Control-N

The New command on the File menu creates a new MiniCad document. When you choose the New 
command, a new, untitled document opens. 

The first new document is titled "Untitled n." 

Up to eight MiniCad documents can be opened simultaneously. Each new document opens on top of the 
previous document.

The file opens with the standard defaults. A specific set of defaults, such as scale or units, can be 
created to preconfigure a new file.

This is done by saving the desired settings with the Save as Stationery command. The file must be 
saved with the name "Default.sta" and placed in the same folder as the MiniCad application. 

All new documents will have the stationery's defaults.

For related information, see the following topics:
Open



Normal Scale
Control-3

To view or edit a drawing at its print size, choose Normal Scale on the Page menu.

For example, in 1:1 scale, one square inch of screen area displays a one-inch square of the drawing and 
prints that one-inch square. 

In 1:48 scale, one-inch of screen area displays a forty-eight inch square and prints a one inch square 
representing a forty-eight inch square.

If an object is selected when the Normal Scale command is chosen, it is placed in the center of the 
drawing window.

Since the actual size of the paper can be larger than the screen, it may necessary to pan the screen 
display to view the entire drawing. This can be done with the Pan tool, the scroll bars, or by auto 
scrolling. 

The Fit to Window command also is useful when used in conjunction with the Normal Scale command.

For related information, see the following topics:
Zoom Out

Zoom In

Fit to Window

Fit to Objects



Nudge

The Nudge command on the Tools menu allows the arrow keys to be used to move an object in one-
pixel increments. 

Normally the arrow keys move the view of the drawing window one-half screen each time the key is 
pressed. However, when an object is selected and the Nudge command is chosen, the arrow keys will 
move the object. Each time an arrow key is pressed, the object moves one pixel in the direction of the 
arrow. 

The command remains active until the object is deselected.

There are 72 pixels to an inch. A pixel is an absolute distance and is affected by zoom. For example, if 
the drawing is zoomed out to display the entire page, moving the object by a single pixel moves the 
object a greater distance than when the drawing is zoomed in to show just the selected object.

For related information, see the following topics:
Move



Object Info

The Object Info Palette opens when the Object Info command is chosen from the Window menu. 

The Object Info palette changes as different objects are selected on the drawing. The palette may have 
to be resized to see all available buttons and fields. The palette is closed by clicking the close box. Like 
all palettes, the Object Info palette can be moved around the screen.



Open
Control-O

The Open command on the File menu is used to open an existing MiniCad document. 

The Open command presents a dialog box that lists all the available files on the current disk. If you click 
the folder name above the scrolling list, the directory pop-up menu shows the path from the current 
folder to the hard disk. 

Up to eight MiniCad documents can be open simultaneously.

For related information, see the following topics:
New



Overlays

MiniCad's tools and commands are organized into industry specific combinations (e.g., architectural, 
mechanical). These different combinations of menus and tool palettes are called Overlays. 

Overlays are selected from the Overlay submenu on the File menu. The default overlay is the MiniCad 
Standard Overlay. To change an overlay, choose the desired overlay from the Overlay submenu.



Paste
Control-V

The Paste command on the Edit menu places a copy of the Clipboard's contents onto the active layer of 
the current drawing. 

Normally a pasted object is centered on the drawing window. Use the Paste in Place command to keep 
the pasted objects aligned or in registration. 

The Clipboard's contents remain unchanged after a paste, so you can use this command repeatedly to 
make multiple copies of an item. 

You also can use the Duplicate or Duplicate Array command to make multiple copies of an object.

For related information, see the following topics:
Paste as Picture

Paste in Place

Copy

Cut



Paste as Picture

The Paste as Picture command on the Edit menu places a copy of the Clipboard's contents onto the 
active layer of the current drawing as a picture. 

As a picture, the pasted objects cannot be edited. They will draw much faster, and they retain 24 bit color 
information and PostScript comments when pasted as a picture.

The Clipboard's contents remain unchanged after a paste, so you can use this command repeatedly to 
make multiple copies of an item.

For related information, see the following topics:
Paste

Paste in Place



Paste in Place
Control-Shift-V

The Paste in Place command places a copy of the Clipboard's contents on the active layer of the 
current drawing, at the same x, y and z coordinates as the original object.

The Clipboard's contents remain unchanged after a paste, so you can use this command repeatedly to 
make multiple copies of an item.

For related information, see the following topics:
Paste

Paste as Picture

Copy

Cut



Perspective

The Perspective submenu on the 3D menu controls the amount of distortion used to give the impression 
of perspective in a 3D drawing. The settings you select are retained for the remainder of the current work 
session.

A 3D drawing is put in perspective with the Projection command on the 3D menu. In addition, some 
tools, such as the Walkthrough tool, automatically put the drawing in perspective.

The three perspective options on the submenu are used to change the perspective view:

· Narrow Perspective

· Normal Perspective

· Wide Perspective

The Set Perspective command opens the Set Perspective dialog box for the direct entry of the desired 
perspective value. This command allows full control over the degree of perspective than is allowed with 
the default choices. The higher the number entered in the Perspective field, the narrower the degree of 
perspective. 



Preferences

MiniCad maintains a preferences file in which certain default settings are set (e.g., conversion resolution, 
dimension standards, rotation detail, snap radius).

Changes to these defaults are made through the Preferences dialog box, which is opened with the 
Preferences command on the File menu. 

Changes made to this file are saved when you click OK. These settings become the defaults until you 
use this command to change them again.

The following items are controlled with checkboxes on the Preferences dialog box:

Click-Click Drawing
Click-Drag is the conventional method of drawing, wherein you click with the mouse, drag it with the 
button depressed, and release the button to finish the action. 

If this option is deselected, MiniCad is in Click-Click mode. In this mode, you click the mouse and drag it 
without holding the mouse button down (i.e., you simply move it). An action is finished by clicking the 
mouse again. 

Click-Click mode is useful if you enter data frequently in the Data Display bar. It is also helpful when 
pens and digitizing tablets are used. 

Note:  Some tools use a unique combination of clicks and drags, and are not affected by the Click-Click 
Drawing option. These include the Polygon and Wall tools and some Arc and Dimension tool modes. 

Offset Duplications 
When this item is selected, any duplicated object is offset from the original. The offset places the 
duplicate slightly above and to the right of the original. 

If the duplicate is moved immediately after it is duplicated, subsequent duplications are placed at that 
offset. If Offset Duplications is deselected, the duplicate is placed on top of the original.

Screen Cursor
When selected, the cursor displays solid lines that extend in the x and y axis to the edge of the screen.

Screen Hints
Screen Hints are the interactive text that accompanies the SmartCursor. When selected, search 
snapping is enabled; when deactivated, search snapping is off. 

Screen Hints can be toggled on and off with the Y key. 

For more information about this option, see Using Screen Hints and Floating Datum.

Floating Datum
A datum is a temporary variable placed into memory. A datum is set by holding the cursor on a snap 
point for a few moments. 

When the cursor snaps to a snap point, the location of the cursor is placed into memory as datum. The 
user can type an offset to the datum to which the cursor snaps. Thus, the user can draw or place objects 
at exact distances from any snap point.

There can only be one datum point in the memory at a time. If Floating Datum is deselected in the 
Preferences dialog box, the origin is set to be the datum and remains constant until either the origin is 
changed using the Set Origin command, or the Floating Datum is turned on again.

For more information about this option, see Using Screen Hints and Floating Datum

Snap to Loci
When selected, the snap grid works with loci placed with the 2D Locus or 3D Locus tool.



Rulers
This preference regulates the display of the rulers. When selected, on-screen rulers are displayed in the 
MiniCad drawing window.

Scroll Bars
This preference regulates the display of the scroll bars. When selected, standard scroll bars are 
displayed in the MiniCad drawing window. If deselected, scroll bars are suppressed. The arrow keys or 
the Pan tool must be used to move the view of the drawing window.

No Fill Behind Text
A text block can have a fill pattern. By default, a text block is given the currently selected fill pattern when 
the text block is created. 

When the No Fill checkbox is selected, the text block is created without a fill pattern. When a fill pattern 
is wanted, it can be assigned to the text block using the Attribute Palette.

Zoom Line Thickness
This preference keeps line thickness in proportion when the drawing is zoomed. When selected, this 
preference forces lines to show in proportion to the zoom level. When deselected, lines display exactly 
as they are going to be printed.

Black & White Only
When selected, the drawing displays in black and white. This setting supersedes the current monitor 
setting in the display control panel. Using a black and white display speeds up screen redraws.

Use Layer Colors
When selected, this preference displays objects in their layer color instead of their object color (layer 
color is specified by the Color option in the Layers command). When Use Layer Colors is enabled, the 
individual object colors are not displayed. However, the object's color is maintained internally, and will 
display properly once this preference is disabled.

Log Time In Program
MiniCad maintains a log of your work in the program. The log file keeps track of when you open MiniCad, 
when you open and close individual files, and when you quit MiniCad. This log file is maintained as a text 
file in the same folder as the MiniCad application. The log file can be opened with any word processor.

Selecting the Log Time in Program preference creates the log file if one has not been created yet. If a 
file has been created, new data is appended the existing log.

An example of the log file contents is shown below:

4/19/97 12:37 PM Started MiniCad.

4/19/97 12:38 PM Closed "Untitled 1" without saving.

4/19/97 12:38 PM Opened "Jones Addition".

4/19/97 4:29 PM Closed "Jones Addition".

4/19/97 4:36 PM Quit MiniCad.

Adjust Flipped Text
When selected, this option prevents mirrored text from being flipped. Instead of flipping, text is rotated, 
which prevents it from being mirrored. If deselected, mirrored text displays backwards.

Show Other Objects While In Groups
When selected, the entire drawing is visible while editing groups with the Group command. When 
deselected, the editing window hides everything but the group being edited. This reduces screen clutter.

Show 3D Axis Labels
When selected, this option displays the x and y axes of the ground plane, or the i and j axes of the 



working plane, in a 3D projection.

Black Background
When selected, the background becomes black. When deselected, the background is white.

Eight Selection Handles
When selected, a selected object is defined by eight selection handles. The handles are located at the 
corners and mid points of the object's bounding box. When deselected, a selected object is defined with 
four handles in the corners of its bounding box.

Constrain Angle
The value in the Constrain Angle field allows an additional angle constraint to be set. This constraint is 
in addition to the 0°, 30°, 45°, 60°, and 90° default constraints available in the Constraint Palette. 

Snap Radius
The Snap Radius is the distance the cursor has to be from an object before snapping occurs. The value 
is specified in screen pixels (typically 72 per inch.)

Conversion Resolution
The Conversion Resolution determines the number of line segments placed into curved surfaces when 
converting to polygons or lines. It is also used in other sequences, such as rotations.

The option contains four choices: Low, Medium, High, and Very High. The higher the value, the 
rounder the curve.

3D Conversion Resolution
The 3D Conversion Resolution determines the number of segments to be created when an object is 
converted to 3D. 

The option contains four choices: Low, Medium, High, and Very High. The higher the value, the 
rounder the curve. The higher the setting, the rounder the curve. However, the higher the setting, the 
larger the file and the more RAM needed to render it.

Dimensions 
The Dimension pop-up menu allows selection of dimension standards. Choosing Custom from the 
menu allows custom dimension standards to be created or edited. For more information about custom 
dimension standards see the MiniCad User Manual.

3D Rotation
The 3D Rotation buttons are a series of five radio buttons that control the degree of detail maintained in 
a 3D model as it is rotated. This setting is always within the range allowed by the hardware being used. 
That is, the faster the computer, the more control these buttons allow.

Save Reminder
MiniCad can automatically remind you to save the active file at a specified interval. If the Save 
Reminder preference is selected, the file automatically saves at the time interval specified in the 
Minutes field. 

If a file has not been previously saved, a dialog box opens to allow the file to be named. Subsequent 
saves are saved to the specified file without opening the dialog box. 

When the file is being auto-saved, the mode bar reports the operation's progress. During the brief time 
that the file is being saved, you cannot make changes to the file.



Using Screen Hints and Floating Datum

Each time the cursor snaps to a point, that point is placed in memory. This allows snapping to the 
intersections of the horizontal and vertical vectors that extend from the snap points. 

For example, position the mouse at an object's snap point. After snapping to the point, move the mouse 
away from the object. A dashed line appears. Position the mouse at another object's snap point. The 
dashed line extends to the snap point and the word "Intersect" appears when the cursor is snapped to 
the intersection. The cursor also displays a snap dot.

The first snap point that the cursor touched is now indicated by a small square. The second point has a 
small circle. Each time the cursor touches a new snap point, it is displayed with a small circle.

When the cursor crosses a horizontal or vertical vector of any of these snap points, the points are 
displayed as squares.

For additional information, see the following topics:
Screen Hints with Snap to Surface

Angle Vectors

Screen Hints with Snapping Combinations



Screen Hints with Snap to Surface

When the Snap to Surface constraint is selected, screen hints displays the word "Surface" to the right of 
the cursor when the cursor is within the snap distance of the surface of an object.



Angle Vectors

To get the vector of an angle (thus allowing snapping to an extension of angled lines or surfaces), move 
the cursor to the surface of the object. After a brief pause, a dotted line representing the vector from the 
object appears. Up to two objects can be stroked to get a dotted vector of their surface. 



Screen Hints with Snapping Combinations

Virtually any combination of constraints can have screen hints. It can, however, be necessary to move 
the cursor around slightly in order to get the particular snap data to appear when several combinations of 
snaps are in a small area.



Print
Control-P

The Print command, on the File menu, prints or plots a copy of the active document. The actual printed 
output is determined by the selected printer, the settings made with the Drawing Size command (one 
page is the default), the orientation determined with the Print Setup command, and the paper selected 
with the Print Setup command.

Worksheets have their own menus and have their own print command. If you want to print a worksheet, 
use the Print command on the worksheet's main menu. However, worksheets that have been placed on 
the drawing are considered graphic elements of the drawing and are printed with the standard Print 
command.

All objects, layers, and classes that are visible are printed. 



Print Setup

The Print Setup command on the File menu specifies the page size, orientation and resolution of the 
current document when it is printed. When the command is chosen, the Print Setup dialog box appears. 

The High Resolution check box sets the selected printer to its optimal resolution, as determined by the 
printer driver software installed on your system. 

Deselecting the check box reduces the resolution to screen resolution (72 dpi). Reduce resolution when 
printing to devices that do not support the system software's high resolution printing routines (certain fax 
modems, for example).

Select the paper size and page orientation desired. The selected paper size, reduction/enlargement, and 
orientation are reflected in the gray printer boundary that shows on the screen.

The actual number of pages it takes to print your document is determined by the Drawing Size 
command on the Page menu. The size of those pages is determined by the currently selected printer.

For related information, see the following topics:
Print



Projection

Projection is the process of mathematically transforming objects in the 3D model into lines on a 2D 
projector plane so that the viewer has the impression of viewing 3D objects.

MiniCad has seven standard projections, chosen from the Projection submenu on the 3D menu. The 
active projection is shown with a checkmark.

Top/Plan

Orthogonal

Perspective

Oblique Cavalier 30 & 45

Oblique Cabinet 30 & 45



Top/Plan

Top/Plan is used for normal 2D drafting. Plan is not really a projection in the traditional drafting sense. It 
is a special projection used in MiniCad to provide a way to link 2D with 3D. This provides the link that 
allows layers to print in perfect registration. Top/Plan also allows 2D views and 3D projections to be 
displayed and printed on the same page.



Orthogonal

Orthogonal is the traditional isometric projection used by architects and engineers. It is probably the 
most commonly used projection for 3D CAD. 

This projection displays the drawing as an undistorted projection in which the projectors are 
perpendicular to the projection plane and parallel to each other. An important property of the orthogonal 
projection is that objects on the projection plane are their exact size regardless of their distance from the 
plane. 



Perspective

Perspective projection adds distortion to the displayed objects so that some objects appear to be farther 
from the viewer than others. 

Perspective is very useful for determining what a modeled object is going to look like in its final form, 
because it is distorted on screen the same way it is distorted when seen in the real world. Objects in the 
distance appear smaller than objects close to the viewer, and parallel lines converge to a vanishing 
point. 

In perspective projection, the projectors converge to a point called the Center of Projection behind the 
projection plane. The distance between this point and the projection plane determines the amount of 
perspective, like the focal length of a lens.



Oblique Cavalier 30 & 45

In a Cavalier projection, a vector perpendicular to the projection plane has same length on the page as 
those parallel to the projection plane. Therefore, for rectangular objects, all dimensions on the page are 
actual. 

An advantage of a Cavalier projection is that measurements can be taken from the drawing after it is 
printed. Cavalier is an oblique projection, meaning that the projectors are parallel, as in orthogonal, but 
they are not perpendicular to the projection plane.

Be aware that the object being observed must be oriented so that its vectors are aligned with the 
projection plane. This insures that the dimensions are correct. This means that distances are accurate 
only if the oblique cavalier projection is used with the front, back, top, bottom, left, or right standard 
views.



Oblique Cabinet 30 & 45

Oblique Cabinet projection is very similar to Oblique Cavalier, but the object is foreshortened by 50% 
to achieve a more natural look. 

Distances are still easy to measure, but distances of those vectors perpendicular to the projection plane 
must be multiplied by 2 to get the actual dimension. Cabinet is an oblique projection, meaning that the 
projectors are parallel, as in orthogonal, but they are not perpendicular to the projection plane.

Like Oblique Cavalier, the object being observed must be oriented so that its vectors are aligned with 
the projection plane. This insures that the dimensions are correct. This means that distances are 
predictable only if the oblique cabinet projection is used with the front, back, top, bottom, left, or right 
standard views.



Purge Unused Objects

The Purge Unused Objects command on the Edit menu removes any combination of unused layers, 
classes, symbols, and record formats from the active drawing.

When chosen, only layers without any objects on them are removed. The command removes any 
symbol in the library that is not placed on the drawing, as well as any record format not attached to a 
symbol or object. This command cannot be reversed; a dialog box confirms the choice before the 
command is executed.

If the symbols are placed in folders in the symbol library, the symbols are removed but the folders 
remain. 

This command allows large, complicated stationery pads to be used without filling the finished file with 
unnecessary items. An "office standard" stationery pad can be used, with elaborate layer and class 
configurations. When the drawing is finished, all unused items can be easily removed.



Quit
Control-Q

The Quit command on the File menu closes MiniCad. If any unsaved documents are opened when you 
choose the Quit command, you are asked if you want to save them.

If there are several unsaved documents, you are asked about each document individually. 



Recover

The Recover command is used to repair a damaged drawing file. 

Note:     The Recover command is located on the alternate File menu. This menu is activated by, 
pressing the Control key while selecting the File menu from the menu bar.

When a file is opened with the Recover command, MiniCad attempts to make repairs to the file. Be 
aware that not all damaged files can be repaired. 

If the Recover command fails to recover a damaged file, Export the file in text format and Import the file 
back in text format.



Rendering

Rendering is the process by which MiniCad applies a solid surface to a 3D wireframe object. Rendered 
objects can have a color and/or fill applied to the surface. If desired, a light source be used to shade the 
rendered object. 

To render a drawing that contains 3D objects to show as a solid, choose one of the rendering commands 
from the Rendering submenu on the 3D menu. 

Wireframe

Quick

Solid

Shaded Solid

Shaded - No Lines

Final Shaded Solid

Final Hidden Line



Wireframe

The Wireframe command on the Rendering submenu produces a wireframe image of the 3D model. All 
of the object's lines are visible. This is the default for MiniCad models and it is the fastest way to view a 
3D model.



Quick

The Quick command on the Rendering submenu is the fastest solid rendering mode, but it does not 
always render objects accurately. Polygons may be rendered in the wrong order using this method.

Quick render is a shaded render mode. The first time a shaded render command is chosen, the Sun 
cursor appears. Position the cursor where the light source is to originate and click. The light source can 
be dragged to a new location after it has been placed. If a light source has already been placed, 
rendering is performed immediately.



Solid

The Solid command on the Rendering submenu renders any object with a fill pattern (which includes 
the default fill, white) as a solid. 

Any objects that lack a fill are shown in wireframe. 

Each object, or facet of an object, can have a different fill and/or color. Fill and color are chosen from the 
Attribute Palette. 

Objects rendered as a solid frequently look better if a color is used instead of white. A white fill is difficult 
to see on screen and when printed. Giving the different faces of a 3D object different shades of gray is 
particularly effective.



Shaded Solid

The Shaded Solid command on the Rendering submenu is used to render an object as a solid, with its 
surfaces shaded to simulate a directional light source. 

The first time a shaded render command is chosen, the Sun cursor appears. Position the cursor where 
the light source is to originate and click. The light source can be dragged to a new location after it has 
been placed. If a light source has already been placed, rendering begins immediately.



Shaded - No Lines

The Shaded - No Lines command on the Rendering submenu creates a rendered, shaded object with 
color and fill information, but without a wireframe. 

It effectively removes all lines from the drawing. The first time a shaded render command is chosen, the 
Sun cursor appears. Position the cursor where the light source is to originate and click. The light source 
can be dragged to a new location after it has been placed. If a light source has already been placed, 
rendering begins immediately.



Final Shaded Solid

The Final Shaded Solid command on the Rendering submenu produces a very accurate rendering, 
with surfaces shaded to simulate a directional light source. 

The price of the accuracy is speed. This mode is relatively slow. It is best for making final presentations.

The first time a shaded render command is chosen, the Sun cursor appears. Position the cursor where 
the light source is to originate and click. The light source can be dragged to a new location after it has 
been placed. If a light source has already been placed, rendering begins immediately.



Final Hidden Line

The Final Hidden Lines command produces is the most accurate rendering. It actually renders the 
object twice. A hidden line rendering does not have color or shading. It is best for plotting and making 
final presentations.



Resources

The Resource Palette opens when the Resources command is chosen from the Window menu. It is 
used to access a variety of drawing components, including:

· Symbols
· Worksheets
· Macro Commands
· Hatch Patterns
· Database Record Formats

The Resource palette changes as different types of resources are selected; the palette displays different 
buttons depending on the type and location of the selected resource. 

The palette is closed by clicking the close box. 

The palette can be stretched to display more resources if desired. Like all palettes, the Resource palette 
can be moved around the screen.



Revert to Saved

The Revert to Saved command removes all changes to the active document since the last time you 
saved. The last saved version of the document opens in place of the active document.

Revert is used only if recreating a document from the last save is easier than repairing any undesirable 
changes you made. Because of this, save the document before doing any work you may want to discard.

Because the Revert to Saved command cannot be reversed, you will be asked to confirm your request.



Roof

The Roof command on the AEC menu makes hybrid 2D/3D roofs from simple 2D objects. As a hybrid 
object, it displays as a 2D object in Top/Plan view, but displays as a 3D object in an Orthogonal view. 

Note:    This command is only available when the AEC Overlay is active. If the AEC menu is not listed 
on the menu bar, select AEC Overlays using the Overlays command on the File menu.

The Roof command creates complex roof structures in a few simple steps. You can either create the roof 
in the same layer as the wall structure, or in a layer of its own. If you create the roof in its own layer, you 
can use the Create Layer Link command to create a model of the walls and roof together.

For additional information, see the following topics:
Making Roofs



Making Roofs

Before the roof is drawn, a preliminary step should be taken. Locate the bearing point for the roof. This is 
the point where the roof sits on the walls underneath it. Draw a temporary reference line extending 
beyond the walls, past the eaves (if any.) This reference line will help locate the roof axis.

To create a standard gable roof, draw a 2D polygon or rectangle that represents half of the roof. Select 
the object and choose the Roof command.

The Create Roof dialog box opens. This dialog box has fields to set the parameters (e.g., slope, rise, 
thickness) for the roof. Make your selections in this dialog box, then click OK. 

See The Create Roof dialog box for description of the options in this dialog box.

Next, the axis for the roof must be defined. Drag a line using the reference line to guide you. A triangle 
forms at the axis line. The next click of the mouse defines the side of the axis on which the peak is 
located. Click the side where the ridge is located. Then select the reference line and delete it. Select the 
Mirror/Duplicate tool and drag a line down the ridge of the roof. 

When you release the mouse, the other half of the roof is formed. Refer also to the MiniCad User Manual 
for more information about creating roofs.

You can cut a hole through the roof for a chimney or dormer, before or after the roof is created. If you 
want to cut holes before creation, use the Clip tool or draw an object in the form of the hole and choose 
the Clip Surface  command on the Tools menu to make the hole.

If the roof is already created, use the Edit Group command on the Organize menu to "enter" the roof for 
editing. Then, use the Clip tool or draw an object and choose the Clip Surface  command to make the 
hole. 

After making all of the changes, click on the Exit Group button in the data display bar or choose the Exit 
Group command in the Organize menu.



The Create Roof dialog box

The Create Roof dialog box is opened when the Roof command on the AEC menu is selected. It has 
the following options:

Axis Z
The Axis z of the roof is the distance of the axis from the base of the layer. If the roof is in its own layer, 
this value is set to zero. 

If the roof is to be placed on top of some walls, select one of the walls and open the Object Info Palette. 
Note the z value for the wall and enter that in the Axis z field. Generally, it is better to put the roof in its 
own layer and use layer linking to view the layers as a model.

Angle
If you know the roof angle, select the Angle button and enter the value in the field.

Rise over Run
If you know the rise/run of the roof, select the Rise over Run button and enter the values.

Height at next click
This option allows you to set the peak of the roof with a mouse click, and lets you match an existing 
condition without a lot of calculations.

Thickness and Miter 
The Thickness and Miter options allow you to set those attributes for the roof. 

While using the Double Miter option, you can set a horizontal and vertical miter. If you enter the lumber 
thickness and one of the miter values, you can have the dialog box calculate the third value by pressing 
the Tab key. 

For example, if the roof sits on a 2 x 4 plate, enter 3 1/2" in the horizontal field and press the Tab key. 
The vertical field is calculated.



Rotate

The Rotate command on the Tool menu allows you to rotate a selected object by degrees, minutes, and 
seconds (as determined by the accuracy settings in Units command) or by a decimal number of 
degrees. 

Text is rotated only in degrees. 

Objects also can be rotated around a locus point.

The Rotate command's submenu contains the following commands:

Rotate...
The Rotate... command lets you rotate a 2D object by any degree.

Rotate 3D
The Rotate command lets you rotate a 3D object by any degree. When the Rotate 3D command is 
chosen, the Rotate Object in 3D dialog box opens. Select a rotation center, select the axis, and type the 
value for the degree of rotation into the field. Click OK.

See The Rotate Object in 3D dialog box for description of the options in this dialog box.

Rotate Right 90
The Rotate Right 90 command lets you rotate a 2D object 90° right, in one step.

Rotate Left 90
The Rotate Right 90 command lets you rotate a 2D object 90° left, in one step.

Flip Vertical
The Flip Vertical command lets you pivot the object across the horizontal axis (i.e., up/down)

Flip Horizontal
The Flip Horizontal command lets you pivot the object across the vertical axis (i.e., left/right).

For related information, see the following topics:
Rotate 2D

2D Mirror

Rotate to Zero

Rotate Working Plane

Rotate View

Walkthrough

Flyover



The Rotate Object in 3D dialog box

The Rotate Object in 3D dialog box is opened when the Rotate 3D command is chosen. It has the 
following options:

Rotation Center
The 3D object can be rotated about one of three options; the center of the working plane, the center of 
the object, or any point that is selected with a mouse click.

Rotation Axis
The object can be rotated along either the ground plane (x, y, z) or the working plane (i, j, k) axes. 

Rotation Angle Field
The Rotation Angle field is used to enter the desired rotation. The accuracy of the rotation is determined 
by the Units command.



Rotate 3D View

The Rotate 3D View command on the 3D menu allows manipulation of a 3D view. This dialog box 
permits either interactive or direct input of the x, y, and z coordinates in degrees, minutes and seconds. 

This means you can manually move the view in predefined steps, or you can enter a value directly in the 
rotation fields. The result of the rotation is shown in the thumbnail diagram displayed on the left side of 
the dialog box.

The 3D Rotation dialog box has the following fields:

Set By Value 
Allows you to see the results of the values entered into the fields below. After entering the desired 
rotations for the x, y, and z axes, clicking on the Set by Value button causes the thumbnail diagram in 
the dialog box to show the degrees of rotation.

Rotation on X, Y, or Z
Enter the desired degree of rotation in degrees, minutes and seconds.

Absolute
When checked, all rotations set in the dialog box are made from the top (absolute) view. If unchecked, 
rotations set in the dialog are from the current view.

Increment
Sets the number of degrees each click of the plus or minus buttons moves the viewpoint.

The X, Y, & Z Plus And Minus Buttons
Each click on these buttons moves the selected object by the number of degrees in the increment field.

OK
Accepts the entered rotation. When the screen redraws, the selected object is rotated.

Cancel
Returns you to the drawing without making any changes.

For related information, see the following topics:
Rotate View

Walkthrough

Flyover

Rotate



Rotate to Zero

The Rotate to Zero command on the 3D menu is used to align a 3D object with the world coordinate 
system. It can be used with any 3D object, including symbols, extrudes, multiple extrudes and sweeps. 

This command is useful for quickly reorienting an object to its upright position if you become disoriented 
while rotating it.

For related information, see the following topics:
Rotate

Rotate 3D



Rotate Working Plane

The Rotate Working Plane command allows rotation of the working plane with absolute precision. 

It is the most accurate way to rotate a working plane. The working plane can be rotated by degrees, 
minutes, and seconds (as determined by the accuracy settings in the Units command), or by a decimal 
number of degrees. 

A working plane must be active to rotate it.

When this command is chosen, the Rotate Working Plane dialog box opens. The dialog box allows the 
choice between the x, y, z or the i, j, k axes. Select the desired axis and enter the desired rotation in the 
Rotation Angle field.

For related information, see the following topics:
Rotate

Rotate 2D

Rotate 3D

Rotate View



Save
Control-S

The Save command on the File menu saves the open document to disk. 

The Save command updates the document by replacing the version on disk, with the version on the 
screen. 

If the file has been previously saved, it saves without any messages or dialog boxes.

If the document has never been saved before, the Save dialog box opens. Enter a name for the file and 
click OK. The file is saved in the active directory. New folders can be made by clicking the New button. 

For related information, see the following topics:
Save As

Save as Stationery



Save As

The Save As command saves a copy of the active document under a new name, in a different folder 
(i.e., directory), or on a different disk. You also can use the Save As command to save a new document. 

Use the Save As command when you want to make a copy of the active drawing. The original document 
is closed, without saving any changes from the last save. A new file is opened, and the active    document 
is copied into it.

For related information, see the following topics:
Save

Save as Stationery

Save View



Save as Stationery

Before drawing with MiniCad, most users configure the file's scale, set the grid, set wall thickness, set 
units, configure classes and create layers. These settings and more can be preconfigured so that new 
files are created with these settings as defaults. 

This is done by saving a preconfigured file as a "Stationery file." 

A Stationery file is created with the Save as Stationery command on the File menu. Any MiniCad 
drawing file can be saved as stationery. A Stationery file can be also include symbol libraries, macro 
commands, hatch patterns, record formats and class lists.

If a stationery file is saved with the name "Default.sta" and is stored in the same folder as the MiniCad 
application, it is used as the default file for all drawings subsequently created with the New command.

The stationery file has no effect on existing drawings. 



Save View

MiniCad allows you to save individual views of your drawing. This feature simplifies the presentation of 
your drawing. The saved view is given a name, and placed on a command palette. Saved views are 
actually macro command that are created by arranging the drawing as desired and selecting the Save 
View command.

In addition to saving the "view" of a drawing, the Save View command saves class and layer settings, 
which means you can show a certain "class" by simply clicking names on a list. This is far easier than 
using the Classes command to toggle the visibility of the classes.

When you choose the Save View command, the Save View dialog box prompts you to name the view 
and choose certain options. 

See The Save View Dialog Box for description of the options in this dialog box.

When you click OK, the command is put in the active command palette if one is open. If no command 
palette exists in the drawing, one is created.

Macro commands and command palettes can also be created and edited with the Resource Palette.



The Save View Dialog Box

The Save View dialog box is used to save a view to the command palette. It has the following options:

Save Current View
When selected, the view active at the time the command is chosen is saved. The file will switch to this 
view when the custom view macro is executed.

Save Active Layer
When selected, the active layer is saved with the custom view. The file will switch to the selected layer 
when the custom view macro is executed.

Save Layer Visibility
This option retains the current layer visibility information with the saved view. For example, you can have 
a drawing with three layers, one visible, one grayed and one invisible. 

When you execute the macro, the drawing changes to these visibility settings, no matter what the layer 
settings were before the macro command was invoked.

Save Class Visibility
This option retains the class visibility settings for the view you want to save. When you execute the 
macro, the drawing changes to the specified visibility settings, no matter what the class settings were 
before the macro command was invoked.



Scale

The Scale command on the Organize is used to set the scale of the active layer. 

Scaling is the ability to accurately display, or print, a large drawing in a manageable size (do not confuse 
scale with the Zoom In and Zoom Out tools, which only determine how the drawing is displayed). 

While a drawing can include objects drawn in different scales, each layer can have only one scale. 
Therefore, as long as the elements are in separate layers, you could have a title block in 1:1, a site plan 
in 1:50, a floor plan in 1/4" and details in 1/2".

All new layers automatically assume the    scale of the active layer, unless you specify otherwise. Layer 
scale can be changed at any time.

When you select the Scale command, the Drawing Scale dialog box appears. It offers architectural, 
engineering and enlargement scales. The value in the Paper Scale field will change to reflect changes in 
the scale. You can type a value directly into the field, if desired. 

The All Layers checkbox is used to set the default scale for all layers in a drawing. Care must be used 
when selecting this checkbox, as it overrides settings made with the Layers command.

If you want text to be scaled with the drawing, select the Scale Text option.

For related information, see the following topics:
Scale Objects

Resize



Scale Objects

The Scale Objects command allows you to rescale the x and y dimension of any selected object or 
group. 

Note:    At least one object must be selected in order to use this command.

When Scale Objects is chosen on the Tool menu, the Scale Objects dialog box opens. 

You can scale the x and y dimensions independently. Type the value for the scaling factor in the 
appropriate fields. 

The default scale is 1:1, so any factor entered less than one reduces the object's size. Any factor greater 
than one enlarges the object (e.g., a scaling factor of 2.5 makes the selected object two and a half times 
larger). 

Rescaling is done from the center of the object.

If the Scale Text check box is selected, selected text is scaled to match the entered scaling factor. 

If the Entire Drawing check box is selected, all visible objects in the drawing are scaled (grayed object 
are not rescaled).

For related information, see the following topics:
Scale

Resize



Select All
Control -A

The Select All command selects all visible objects on the active layer. 

Objects that are invisible are not selected. 

Objects can be selected in other layers if the Layer Options command is set to Show/Snap/Modify.

Visible objects on all normal layers are selected. (Setting a layer to Normal with the Layers command 
makes it visible.)

For related information, see the following topics:
2D Selection

3D Selection



Send

In MiniCad, every object is drawn in a sequential order with each object being drawn atop the other. This 
is known as the stacking order. An object maintains its position in the stacking order until it is changed. 

There are two ways to move an object through the stacking order. One way is to Cut the object to the 
Clipboard and paste it back into the drawing. The other way is to use one of the Send commands. The 
Send submenu on the Tool menu contains four different commands.

Objects are moved through the vertical stack by selecting the object and choosing one of the commands 
on the submenu. The choices are:

Send To Front
When chosen, the selected object is sent to the front (i.e., to the top of the stack). This can also be done 
with the Control-F key combination.

Send To Back
When chosen, the selected object is sent to the back (i.e., to the bottom of the stack). This can also be 
done with the Control-B key combination.

Send Forward
When chosen, the selected object is moved one level forward in the stacking order (i.e., one step up).

Send Backward
When chosen, the selected object is moved one level back in the order (i.e., one step down).



Set 3D View

The Set 3D View command on the 3D menu can be used to create a 3D perspective view by dragging a 
line on a 2D floorplan. The command also can be used while in a 3D projection.

This command lets you specify both the viewpoint and the exact point of interest in both height and 
location. For example, you could use it to inspect a cornice as viewed from the street, or get an idea of 
how a kitchen would look as viewed from the kitchen table.

To create a 3D view, choose the Set 3D View command. Position the cursor at the viewpoint and drag it 
in the direction to view. This line determines the actual view. The longer the line drawn, the more 
accurate the control over the view. 

When the mouse is released, a dialog box opens for other parameters of the view. 

The Viewer Height field sets the height of the viewpoint. 

The Look Toward Height field determines the height of the point being viewed. One of four perspective 
choices is made from the pop-up menu. When OK is clicked, the view is created.

Note:    If the height of the viewer and the viewpoint is the same, the perspective is quite normal. If 
however, the two points are different in height, the length of the line drawn with this command controls 
the distortion in the perspective. This is because the shorter the line, the greater the angle between the 
two points, and hence the exaggeration of the perspective. 

The Walkthrough tool can be used to change the view from within the 3D perspective. The perspective 
can be changed by selecting it with the Translate View tool.



Set Grid

The Set Grid command on the Page menu is used to configure the drawing's grid system.

MiniCad maintains an internal, user-definable grid system. The grid system has two components: 

· the invisible, Snap Grid, and 
· the visible, Reference Grid.

These grids can be changed at any time in a drawing by selecting the Set Grid command. This 
command opens the Set Grid dialog box. 

Note:    the Set Grid dialog box can also be opened by double-clicking Snap to Grid icon on the 
Constraint Palette.

The Set Grid dialog box has the following options:

Current Snap Grid
The value you set in the Current Snap Grid field sets the Snap Grid. This value specifies the smallest 
unit increment to which the cursor snaps. 

Different grid settings help constrain the mouse to the level of detail you desire. This helps maintain a 
level of precision consistent with the details with which you are working. 

Reference Grid
The Reference Grid is simply a visual aid and has no physical effect on the drawing. Setting the 
Reference Grid to a multiple of the Snap Grid allows you to snap at the Reference Grid's intersections. 

The display of the Reference Grid is affected by the current zoom. When the zoom levels make the grid 
unwieldy, the grid will be represented as points on the screen.

Show Grid Lines 
When selected, the Reference Grid will be visible. 

Print Grid Lines
When selected, the reference grid will print, and will export with the EPSF and PICT formats.



Set Origin

The origin point in MiniCad is the point on the drawing where the x and y axis meet. All x and y values 
are determined to be positive or negative in relation to this point. 

The origin point can be changed. The default origin is the center of the paper as determined in your page 
setup. If you change the paper size, the origin point changes to the new center point. 

Changing a drawing's origin does not change the physical drawing, but it does change the drawing's 
reference points (the x and y coordinates).

To set a custom origin point, select Set Origin. The cursor changes to a bull's-eye. Click on the drawing 
at the point you have selected as the new origin point.

Note:    The origin point can also be set by dragging the mouse from the upper left corner of the drawing 
window. Release the mouse when it is at the new origin point.



Shallow Symbol to Group

The Shallow Symbol to Group command converts a symbol made up of multiple symbols, into a single 
group of individual objects rather than decomposing each symbol as a separate group.

Note:     The Shallow Symbol to Group command is located on the alternate Organize menu. This 
menu is activated by, pressing the Control key while selecting the Organize menu from the menu bar.

For related information, see the following topics:
Symbol to Group



Shift Drawing

The Shift Drawing command moves the entire drawing, including all its layers and any invisible objects, 
in one motion.

Note:     The Shift Drawing  command is located on the alternate Page menu. This menu is activated by, 
pressing the Control key while selecting the Page menu from the menu bar.

To move the drawing:

1. Select the Shift Drawing command from the alternate Page menu.

2. Click the mouse on the drawing. 

3. Move the cursor to the where you want the drawing shifted, and click again.

For related information, see the following topics:
Move Page



Smoothing

The Smoothing command on the Edit menu is used to change all curves in a selected object to one of 
the following types:

· Corner Curve

· Bezier Curve

· Cubic Spline

· Arc Radius

Note:    This command automatically converts all vertices in the object to the selected curve type. If you 
want to change vertices individually, use the 2D Reshape tool.

To use the Smoothing command:

1. Select the object you want to smooth.

2. Select the Smoothing command from the Edit menu.

3. Select the type of curve to which you want all vertices converted. The No Smoothing option 
converts all curves to corner points.

For related information, see the following topics:
Polyline



Standard Views

The Standard Views command on the 3D menu is used to place your drawing in one of MiniCad's 
standard views. 

Standard views simplify the orientation and manipulation of your drawing. The currently selected view 
will have a check mark next to its name.

The standard views are divided into four basic categories: 

Views Description

Top/Plan The 2D view. Choosing this view switches to 
2D Plan projection. 

Top, Bottom

Front, Back

Right, Left

3D elevations.

Right Isometric

Left Isometric

Right Rear Isometric

Left Rear Isometric 

3D representations of your drawing.

  

Lower Right Isometric

Lower Left Isometric

Lower Right Rear Isometric

Lower Left Rear Isometric

  

3D representations of your drawing taken 
from below the ground plane. These views 
are useful in mechanical design. 

When looking at the object from below, the 
ground plane loses its grid.

Additional views of a drawing can be created with the Save View command. 

Additionally, any of the view manipulation tools on the 3D Tools palette can be used to place the drawing 
in any orientation.

For related information, see the following topics:
Set 3D View

Translate View

Rotate View

Flyover

Walkthrough



Structural Shapes

The Structural Shapes command on the AEC and Mechanical menus creates profiles various of 
various structural elements. 

Note:    This command is only available when the AEC Overlay or the Mechanical Overlay is active. If 
the AEC or Mechanical menu is not listed on the menu bar, select AEC Overlay or Mechanical 
Overlay using the Overlays command on the File menu.

When the command is chosen, the Create Structural Shape dialog box opens. The dialog box has two 
pop-up menus used to select the shape and nominal size of the structural shape.

The Structural Shape command uses an editable data file to produce the actual shape. These data files 
are located in the External Data folder in the Externals folder. 

The Externals folder is located in the same folder as the MiniCad application. Complete information on 
editing these data files is contained in your MiniCad Toolkit Manual.

Regardless of the units setting used with the active drawing, the Structural Shapes command uses 
industry standards commonly used in the US. This means all beam calculations are in feet and inches.



Sweep

The Sweep command allows you to create a 3D cylindrical object from a 2D object. A sweep has four 
basic elements: 

· a Centroid, 
· an Arc Angle, 
· a Segment Angle, and 
· the Pitch.

To learn more about these components, see .

A group cannot be swept, however, multiple selections can. 

Multiple selections are swept as grouped 3D objects. Afterwards, they can be ungrouped with the 
Ungroup command and edited separately. 

When a line is swept, MiniCad creates an outline of a surface. When objects with a surface are swept, a 
wireframe solid is created.

When the Edit Group command is chosen with a swept object, the edit window opens, displaying the 
original 2D object. Edits to the 2D original will affect the swept object. When the Exit Group button is 
clicked in the mode bar, the edited swept object is displayed.

Converting a swept object to a mesh object allows you to edit individual vertices.

For additional information, see the following topics:
Specifying Sweep Components

For related information, see the following topics:
Extrude

Multiple Extrude

Duplicate Array



Specifying Sweep Components

To execute a sweep, you must specify the following four basic elements: 

Centroid
To sweep an object, you must establish a center of rotation, or centroid. This is done by placing a locus 
on or near the object to be swept at the centroid. The object and the locus are selected before the 
Sweep command is chosen. The snap functions aids in placement of the locus

If a 2D object is swept without a locus establishing a centroid, the object is swept about itself.

Arc Angle
The arc angle is the degree of the sweep. The Sweep command creates an object that is swept a full 
360°. This can be changed by opening the Object Info Palette and entering a different arc angle.

Segment Angle
The segment angle is the number of segments making up a circle. By default, this is thirty-six, which 
means there is a segment for every ten degrees of arc. 

This number can be changed using the Object Info Palette after an object is swept. The default can be 
changed with the Preferences command on the File menu.

Pitch
The pitch of a sweep is the degree to which it spirals. This effect is like the coils on a spring. 

The pitch is represented in terms of plus or minus height per revolution. This means that if the pitch is 
one inch, the object rises one inch for every revolution. The default pitch is zero. The pitch can be 
changed    using the Object Info Palette after an object is swept.



Symbol Edit

The Symbol Edit command replaces selected symbols placed on the drawing with a different symbol in 
the symbol library.

Any number of selected symbols can be replaced simultaneously.

The symbol's rotation is maintained when a symbol is replaced. Because symbols are inserted with a 
specific insertion point; they will rotate consistently as long as their insertion points are consistent. 

For example, if symbols are inserted from the object center, they will replace one another appropriately 
at any angle. However, if some symbols are inserted from the center and others from the upper-left 
corner, the replacement symbols will be inserted inconsistently. 

The command also can be used to precisely move symbols from their current positions on the drawing.

The Symbol Edit command can replace a selected symbol placed in a wall with another. Because walls 
are a special type of object, different rules apply to them:

· Only one symbol at a time can be selected when the symbol is inserted in a wall. 

· Hybrid symbols, inserted in a wall, cannot be selected in a 3D view. The symbols must be 
selected in Top/Plan view. However, a selected symbol can be replaced while in a 3D view. This 
can be useful for experimenting with different doors and windows while in an elevation view.

To replace symbols placed on the drawing:

1. Select the symbols to be replaced (they do not have to be the same kind of symbol).

2. Next, choose the Symbol Edit command. 

3. The symbol's name and a thumbnail are displayed in the Symbol Edit dialog box. If multiple 
symbols are selected, the Original field in the dialog box says All Selected. 

4. Click the Replace Symbol button. (If this checkbox is not selected, the symbols won't be 
replaced.)

5. Click the Choose Symbol button, and select the symbol to replace the ones you've selected. 

6. If you want the new symbols inserted at positions other that of the selected symbols, enter new Y, 
Y and Z position values. Distances are measured from the symbol's insertion point.

7. If the new symbol is to be rotated differently from the original, enter the value in the Rotation 
field. 

8. If the selected symbol is in a wall, the new symbol can be rotated differently than the original by 
clicking on the dialog box. The Offset field shows the insertion point from the start of the wall. The 
Offset field determines the height (the Dz) of the selected symbol from the symbol's insertion 
point.

9. Click OK to replace the symbols.



Symbol to Group

If you edit a symbol directly, all instances of the symbol are changed. The Symbol to Group command 
can be used to convert a symbol to a group, so that you can edit it without making a global change to the 
symbol. 

Note:     If the symbol is inserted into a wall or other hybrid object, it must be dragged away from the 
object before it can be converted to a group. This is because "owned" symbols can't be edited.

After editing, the group can remain as a group, or you can create a new symbol from it. 

Note:     If a symbol is made up of multiple symbols (i.e. nested symbols), the Symbol to Group 
command converts each constituent symbol into a separate group. If you want to convert this type of 
symbol into a single group, use the Shallow Symbol to Group command.



Tablet

The Tablet command on the Page menu is used to activate a digitizing tablet within MiniCad. MiniCad is 
compatible with digitizing tablets that support the WinTab standard. 

To use a tablet, you will need to install the driver supplied by its manufacturer (the driver's installation 
instructions will be supplied with the tablet).

When the Tablet command is selected, the MiniCad searches for the tablet's driver. If one it found, 
MiniCad determines the size and resolution of the tablet, and displays the tablet on the screen as a large 
gray rectangle.( If no driver is found, an error message is issued.)

In tablet mode, information from the tablet is scaled directly to the drawing, so that high precision 
digitization can be performed. Tablets have a resolution of 1000 dots per inch or more. The tablet, when 
used as a mouse, is only a 72 dots per inch device.

To use the tablet:

1. Set the origin of the drawing to the lower left corner of the tablet. 

2. Set the scale of the drawing to the scale of the document being traced. It is best to tape art work 
to the tablet at this time.

3. Select Tablet from the menu. In some versions, you may have to do a screen redraw in order for 
the rectangle to appear.

4. Look at the page size of the drawing and the tablet rectangle on screen. Are they about the same 
relative size as a sheet of paper and the tablet you are using? If they are, proper communication 
has been set up. If not, go back to Step 2. 

Note:     Two or three attempts can be required to establish communication with the driver.

On the tablet:

· The first available button on the puck is used for mouse clicks. 

· The second button is used to toggle between functions.

· The third available button centers the screen on any point on the tablet.



Left

The text alignment commands, Left, Center and Right, on the Text menu, control the justification of text 
within a single text block. 

· The Left command makes all text in a selected text block left-justified. 

· The Center command centers all text in a selected text block. 

· The Right command all the text in a selected text block right-justified. 

Justification is set as a default for text by deselecting the text tool and choosing the desired alignment 
command. 

Justification of an existing text block can be changed by selecting the text block and choosing the 
desired alignment command. 

A text block can have only one alignment. To create the illusion of different text alignments, different text 
blocks, with different alignments, can be created.



Center

The text alignment commands, Left, Center and Right, on the Text menu, control the justification of text 
within a single text block. 

· The Left command makes all text in a selected text block left-justified. 

· The Center command centers all text in a selected text block. 

· The Right command all the text in a selected text block right-justified. 

Justification is set as a default for text by deselecting the text tool and choosing the desired alignment 
command. 

Justification of an existing text block can be changed by selecting the text block and choosing the 
desired alignment command. 

A text block can have only one alignment. To create the illusion of different text alignments, different text 
blocks, with different alignments, can be created.



Right

The text alignment commands, Left, Center and Right, on the Text menu, control the justification of text 
within a single text block. 

· The Left command makes all text in a selected text block left-justified. 

· The Center command centers all text in a selected text block. 

· The Right command all the text in a selected text block right-justified. 

Justification is set as a default for text by deselecting the text tool and choosing the desired alignment 
command. 

Justification of an existing text block can be changed by selecting the text block and choosing the 
desired alignment command. 

A text block can have only one alignment. To create the illusion of different text alignments, different text 
blocks, with different alignments, can be created.



Lower Case

The three text case commands, Lower Case, Upper Case and Title Caps, on the Text menu specify 
the case of text. 

· Lower Case displays selected text in all lower case letters.

· Upper Case displays selected text in all upper case letters.

· Title Caps makes the first letter of every selected word, uppercase.

Text can have its case changed no matter how it was created. 

For example, if a block of text had been created with the Caps Lock key down, it can be converted to 
lower case by selecting it and choosing the Lower Case command. 

The Lower Case tool affects an entire text block.



Upper Case

The three text case commands, Lower Case, Upper Case and Title Caps, on the Text menu specify 
the case of text. 

· Lower Case displays selected text in all lower case letters.

· Upper Case displays selected text in all upper case letters.

· Title Caps makes the first letter of every selected word, uppercase.

Text can have its case changed no matter how it was created. 

For example, if a block of text had been created with the Caps Lock key down, it can be converted to 
lower case by selecting it and choosing the Lower Case command. 

The Upper Case tool affects an entire text block.



Title Caps

The three text-case commands, Lower Case, Upper Case and Title Caps, on the Text menu specify 
the case of text. 

· Lower Case displays selected text in all lower case letters.

· Upper Case displays selected text in all upper case letters.

· Title Caps makes the first letter of every selected word, uppercase.

Text can have its case changed no matter how it was created. 

For example, if a block of text had been created with the Caps Lock key down, it can be converted to 
lower case by selecting it and choosing the Lower Case command. 

The Title Caps tool affects an entire text block.



Text Spacing

The spacing commands, in the Text menu, control how text lines are spaced within a text block. There 
can be only one line spacing setting in a text block.

· The Single Space command spaces lines with a minimal gap between lines. 

· The 1-1/2 Space command spaces text lines with a gap equal to half of the line's height. 

· The Double Space command spaces lines with a gap equal to that of the line's height.

· The Other command opens the Set Text Size dialog box, so that you can specify a custom line-
spacing value. You can enter the value in points, millimeters, or inches.

If text is selected, changes in the line spacing only affect the selection. Conversely, changes made 
without anything selected changes the default line spacing.



Tools

The Tools command on the Windows menu is used to open and close the tool palettes. 

MiniCad's standard palettes (i.e., 2D, 3D and Dimensioning) are listed on the Tools submenu.

If a palette is already open, a checkmark appears next to its name in the menu.

To toggle a palette off or on, click its name in the list.

For related information, see the following topics:
2D Tools

3D Tools

Standard Dimension Palette



Top Level

The Top Level command on the Organize menu returns you to the main drawing window from within an 
entered group. 

This command can be useful when you are working with an object that is many levels deep.

For related information, see the following topics:
Edit Group

Exit Group



Trace Bitmap

Bitmap images that are in PICT format can be converted to a polyline or a polygon with the Trace 
Bitmap command. 

When you select the Trace Bitmap, the Trace Bitmap dialog box opens. This dialog allows you to 
choose the degree of accuracy for the trace. You must set the thin line threshold and the collinearity 
sensitivity for the bitmapped object you want to convert.

Trace Bitmap can take from several seconds to several hours depending on the size of the bitmap and 
the settings you select. The progress bar can help you predict the total time needed to complete a given 
trace. 

Control-Period cancels the trace and returns you to the drawing.



Trim
Control-T

The Trim command on the Tool menu is used to cut lines with an object. 

Note:     This command works only with lines. It will not cut objects that have a surface. 

Multiple lines can be trimmed. 

Any object can be used as a trim object. The trim object cuts all lines that it intersects. When a line is 
trimmed, it is cut into segments by the trim object. The trimmed portion is not removed.

To trim a line, position the trim object at the point where you want the lines trimmed. Select the line(s) to 
be trimmed. (Do not select the objects that will trim the lines.) 

Choose the Trim command. 

Position the pointing-finger cursor on the trim object and click the mouse. The line is cut by the trim 
object. Selection handles appear at the points where the line(s) and the object had intersected.

For related information, see the following topics:
Clip

Clip Surface 

Intersect Surface



Truetype to Polyline

The TrueType to Polyline command on the Tool menu converts any TrueType font into a polyline. After 
conversion, the polyline is no longer a font and can be edited as any other polyline. 

TrueType fonts are defined by Bezier curves and arc points. MiniCad uses these font definitions to 
create the polyline. 

The Conversion Resolution setting in the Preferences dialog box has no effect on the font's 
conversion to a polyline. 

As a polyline, the text can be converted to 3D and positioned in 3D space. It also can be extruded to give 
it depth. 

Each letter of a text string is converted into a separate polyline object. If a polyline is extruded, the 
number of segments that make up the extrusion is determined by the 3D Conversion Resolution as set 
with the Preferences command. 

Be aware that setting the conversion resolution too high causes slow screen redraws without improving 
the quality of the font. Conversely, setting the conversion resolution too low changes the appearance of 
the font.



Undo
Control-Z

The Undo command on the Edit menu cancels the last change made to the drawing.

Undo works only on the last action taken. When another action is taken, even a mouse click in the 
window, you lose any chance to undo the preceding action.

You cannot undo an action that does not actually change a drawing (e.g., changing a dialog box setting, 
selecting a tool, resizing a window, changing zoom level).

For related information, see the following topics:
Revert to Saved



Ungroup

Groups can be broken into their component parts with the Ungroup command on the Organize menu. 

Unless a group is ungrouped, the individual objects in the group cannot be selected, moved, or edited.

Each time the command is chosen, a single level of the group is ungrouped. Because groups can be 
nested into many levels, multiple "ungroups" can be necessary to ungroup the entire nested group. 

Nested groups that have been ungrouped completely are usually difficult to "renest." If you ungroup a 
nested group completely, and draw a marquee around all ungrouped objects and regroup, a single group 
will be created.

If you want to edit a nested group, while preserving its nested structure, use the Edit Group command.



Units

The Units command on the Page menu controls the unit type (e.g., mm, decimal feet and inches) in your 
drawing. 

The unit setting is universal. Changing the unit setting changes the units in the entire drawing, including 
dimensions and worksheets. 

Note:     When files are imported through DXF, the Units command automatically configures the MiniCad 
environment for the combination of drawing size and units in the imported drawing. 

When you select the Units command, the Set Unit dialog box opened. This dialog contains the following 
options.

Unit Name
Use the Unit Name pop-up menu to select the unit of measure for the file. This is a universal setting for 
the file. It affects the display of all numbers in the drawing, data display bar, dimensions, and 
worksheets. 

Old Style Feet and Inches is the format used in some earlier versions of MiniCad. It is used only to 
ensure compatibility with older versions MiniCad. Old files that are in feet and inches should be updated 
to the new format. To update a file, choose Feet and Inches from the menu. 

Show Unit Mark
Selecting the Show Unit Mark checkbox puts the appropriate mark on dimensions. If Feet and Inches 
is selected, the selection is dimmed.

Display As Fractions
When selected, units less than one display as fractions. If deselected, they display as decimals. This 
option is dimmed if Old Style Feet and Inches is selected in the Unit Name pop-up menu.

Round Dimensions To
The Round Dimensions pop-up menu controls the display of numbers less than one. 

Rounding dimensions only affects how numbers are displayed. It does not affect the stored accuracy of 
the number. Changing the display accuracy will not cause rounding errors.

Decimal Formats
The Decimal Formats menu controls how decimals are displayed. This menu also controls where place-
holding zeros are displayed. This setting does not affect stored accuracy. If Display as Fractions is 
selected, this menu is not presented. 

Angular Accuracy
The Angular Accuracy menu affects the display of angles. Angles can be displayed as decimals or as 
degrees (0°), degrees with minutes (0° 0'), and degrees with minutes and seconds (0° 0' 0"). This setting 
does not affect stored accuracy.

Custom 
Custom units can be configured in the Custom Units dialog box. These custom controls can be useful 
for some users, but be careful. If you experience any problems with custom units, please call Graphsoft's 
Technical Support Department.

For more information about this dialog box, see The Custom Units Dialog Box.

Accuracy
The stored accuracy of a number can be controlled with these fields:

· Stored accuracy is the limit placed on the size of a fraction or a number. A number with only one 
place right of the decimal has a much greater rounding error than a number with nine places. 



The setting in this box defines the smallest unit stored in your drawing, and it determines the 
overall accuracy of your drawing. When setting a decimal value, use a number that is a power of 
ten. Custom fractions should be a power of 2 ( 2, 4, 8,16,.... 4096). There are very few reasons 
why you would want to reduce the stored accuracy in a MiniCad file.

· The Units Per Inch field allows for the use of units not available in the standard units menu. For 
example, to use decimeters as the base unit in the drawing, enter 0.2540 in this box since there 
are 0.2540 decimeters to an inch.

Defaults
Clicking the Defaults button returns to the standard Units dialog box. Any changes revert to the default 
settings.



The Custom Units Dialog Box

The controls for setting custom units are provided in the Custom Units dialog box. This dialog has the 
following options:

Format 
Controls whether numbers less than one are displayed as decimals or as fractions.

Display
Custom units can be configured to display numbers in different ways. The display fields are:

Unit Mark
Enter the label, up to twelve characters long, to describe units (e.g. mm).

Sq Unit Mark
Enter the label, up to twelve characters long, to describe square units (e.g.,"sq meters").

Min Unit
This field lets you enter the smallest number to be displayed. While there are no "illegal" values for 
this field, the minimum decimal unit should be divisible by ten and the minimum fraction should be 
divisible by two.

Angles
The Angular Accuracy pop-up menu affects the display of angles. Angles can be displayed as 
decimals or as degrees (0°), degrees with minutes (0° 0'), and degrees with minutes and seconds 
(0° 0' 0"). This setting has no effect on stored accuracy.

Leading 0's: 
Controls the display of leading zeros. Select if leading zeros are desired.

Trailing 0's:
Controls the display of trailing zeros. Select if trailing zeros are desired.



Unlock

The Unlock command reverses the Lock command on selected locked objects. 

After "unlocking" an object, it can be moved, deleted, or edited. Layer links, made with the Create Layer 
Link command, are automatically locked. Before a layer can be moved or deleted on a layer link, it must 
be unlocked. 

To Unlock an object, select the locked object and choose Unlock from the Edit menu.

For related information, see the following topics:
Lock



Use Full Screen

The Use Full Screen command expands the active window to the limits of the screen you are using, and 
it removes the title bar. 

Since the close box is unavailable the Close command on the File menu must be used to close the file. 

If the command is enabled, a checkmark is placed next to the command's name on the menu. Choosing 
the command when it is enabled returns the window to its normal configuration.



Worksheets 

The Worksheets command on the Window menu is used to open a worksheet that that has been 
created in the drawing. 

A worksheet is opened by clicking its name in the Worksheets command's submenu. If the worksheet is 
already open, a diamond appears next to its name. 

For more information about using worksheets in a drawing, see the Resource Palette.



Working Planes 

The Working Planes command on the Window menu is used to open the Working Plane palette. 

The palette is closed by clicking the close box. 

For more information about this palette, see the Working Plane Palette.



    Arc
Key Equiv = 3

The Arc tool on the 2D Tool palette draws circular arcs of any degree, at any angle. The area within the 
arc can have a fill pattern or color, and the arc lines can be of any color (even invisible), thickness or 
dash pattern.

When the Arc tool is selected, the arc icons are displayed in the mode bar. They allow you to define your 
arc using one of five methods. 

If the icon representing the method you want to use is not already selected, click it before beginning to 
draw your arc.

Note: By double-clicking the Arc tool, you can create an arc by entering its parameters directly into the 
Create Arc dialog box. 

To complete this box, specify the arc's size in the Dx and Dy fields and its sweep in the Start Angle and 
Arc Angle fields. In the Position fields, enter the arc's XY position, or set the Next Click button, and 
use your mouse to specify the arc's position in the drawing.

For additional information, see the following topics:
Arc By Radius Mode

Arc By Three Points Mode

Arc Tangent To Line Mode

Arc By Two Points and a Center Mode

Arc By Two Points and a Radius Mode

Editing Arcs

For related information, see the following topics:
Quarter Arc

Ellipse

Polyline



    Arc By Radius
The Arc by Radius button is used to create an arc from a radius that you specify.

To draw an arc by specifying a radius line:

1. Select the Arc tool from the 2D Tool palette, then select the Arc by Radius icon in the mode bar

2. Position the cursor at the arc's center of rotation.

3. Drag the mouse to draw the radius line. 

4. When the radius line is the required length, release the mouse button and draw the arc to the 
desired point by moving the mouse.

5. Click the mouse button to complete the arc. 

6. Use the Data Display bar to verify the angle of the arc, the cursor's distance from the arc's 
vertex, its angle, and location on the screen.



    Arc By Three Points
The Arc by 3 Points mode creates arcs by selecting three points in the drawing through which the arc 
must pass. 

The first click defines the starting point of the arc. The arc passes through the point created with the 
second click. The third click defines the end point of the arc. 

Snap to Objects or Snap to Intersection aids in the alignment of the cursor. Use the Data Display bar 
to verify the angle of the arc, and to verify the cursor's distance from the arc vertex, its angle, and location 
on screen.



    Arc Tangent To Line
The Arc Tangent to a Line mode creates an arc that touches, but does not intersect, a line. 

To draw an arc tangent to a line:

1. Select the Arc tool from the 2D Tool palette, then select the Arc Tangent to a Line icon in the 
mode bar.

2. Place the cursor at the tangent point, then click and hold the mouse button.

3. Drag the mouse to another point to establish a vector for the tangent line, then release the 
mouse. 

4. Move the cursor to the endpoint of the arc and click the mouse button to set the arc.



    Arc By Two Points and a Center
The Arc by 2 Points and a Center mode allows you to set the start and end points of the arc as well as 
its radius. 

To create an arc by two points and a center:

1. Select the Arc tool from the 2D Tool palette, then select the Arc by 2 Points and a Center icon 
in the mode bar.

2. Click the mouse to set the beginning point of the arc.

3. Move (don't drag) the cursor to the end point of the arc.

4. Press and hold the mouse button to set the end point for the arc.

5. With the mouse button still down, drag the cursor to define the arc's radius. 

6. When the arc is the right shape, release the mouse button.



    Arc By Two Points and a Radius
The Arc by 2 Points and a Radius mode uses the mouse to set the start and end points of an arc, then 
uses the keyboard to set the arc's radius. 

To draw an arc by two points and a radius:

1. Select the Arc tool from the 2D Tool palette, then select the Arc by 2 Points and a Radius icon 
in the mode bar.

2. Click the mouse at the beginning point of the arc.

3. Click the mouse at the end point of the arc.

4. In the Radius dialog box, enter the arc's radius. (You may not enter a value less than the 
minimum shown in the dialog.)



Editing Arcs

Arcs can be edited with the mouse or with the Object Info Palette. 

Editing with the Mouse

· To edit an arc with the mouse, select the arc and place the selection cursor on one of the arc's 
handles. When the resize cursor appears, drag the handle. 

· Dragging the center handle edits the arc's radius. Dragging one of the arc's end points edits the 
sweep. 

· The Data Display bar will reflect the changes you make to the arc as you move its handles.

Editing with the Object Info palette

· To edit an arc with the Object Info Palette, select the arc and enter a new value in the 
appropriate field in the palette. (If the Object Info palette is not currently displayed, select the 
Object Info command.)



    Quarter Arc
The Quarter Arc tool on the 2D Tool palette creates arcs that are one quarter of an ellipse, with an 
angle limited to 90°. 

To create a Quarter Arc:

1. Select the Quarter Arc tool from the 2D Tool palette.

2. Press and hold the mouse button to set the beginning of the arc.

3. Drag the mouse in the direction in which you want the arc to appear.

4. Release the mouse button to set the end of the arc.

The Data Display bar displays the ratio of the arc's height to width. A ratio of 1.000, represents a quarter 
of a circle (i.e., a true arc).

Note: By double-clicking the Quarter Arc tool, you can create an arc by entering its parameters directly 
into the Create Quarter Arc dialog box. 

To complete this box , specify the arc's size in the Dx and Dy fields, and select the quadrant that you 
wish to have drawn. In the Position fields, enter the arc's XY position, or set the Next Click button and 
use your mouse to specify the arc's position in the drawing.

For additional information, see the following topics:
Editing Quarter Arcs

For related information, see the following topics:
Quarter Arc

Ellipse

Polyline



Editing Quarter Arcs

Quarter Arcs can be edited with the mouse or with the Object Info palette.

Important!      If you use the mouse to edit a quarter arc, the arc will be converted to a polyline. If you 
want to maintain the object as a quarter arc, edit it using the Object Info Palette.

Editing with the Object Info palette

· To edit a quarter arc with the Object Info Palette, select the quarter arc and enter a new value in 
the appropriate field in the palette. (If the Object Info palette is not currently displayed, select the 
Object Info command.)

· Note that the Object Info palette treats a circular quarter arc as "arc" and a noncircular quarter 
arc as a "polyline."

Editing with the Mouse

· To edit a quarter arc with the mouse, select the arc and place the selection cursor on one of the 
arc's handles. When the resize cursor appears, drag the handle. 

· Dragging the center handle edits the arc's radius. Dragging one of the arc's end points edits the 
sweep.

· As you move the handle, the Data Display bar will show the changes to the arc. 



    Chamfer
Key Equiv = 7

The Chamfer tool on the 2D Tool palette is used to place a line between two linear objects, at a 
specified distance from the intersection of the lines or objects. 

The Chamfer tool can be used to bevel the sides of rectangles or polygons. It can also be used to 
chamfer intersecting polylines or line segments (note: parallel lines cannot be chamfered with this tool). 

When the Chamfer tool is selected, the chamfer icons are displayed in the mode bar. These icons are 
used to select the type of chamfer you want MiniCad to draw. 

To draw a chamfer line:

1. Select the Chamfer tool from the 2D Tool palette.

2. Click the Chamfer Settings icon in the mode bar.

3. In the Chamfer Settings dialog box, do one of the following:

· Select First & Second Line if you want to define the chamfer in terms of its distance from the 
intersection of the two lines it will intersect.

· Select First Line & Angle if you want to express the chamfer's position in terms of a specific 
point and angle on one of the lines. 

4. Complete the distance (or distance and angle) information requested in the Chamfer Settings 
dialog, then click OK.

5. In the mode bar, select the type of chamfer you want to create.

6. Draw the chamfer line.

Note:    Once you specify values in the Chamfer Settings dialog box, you do not have to set them again 
unless you want to change them. They will automatically be applied to all subsequent chamfer 
operations.

For additional information, see the following topics:
Regular Chamfer

Split Chamfer

Trimmed Chamfer

For related information, see the following topics:
Fillet



    Regular Chamfer
The Regular Chamfer mode draws a chamfer as a separate line, but does not affect the object it 
intersects. 



    Split Chamfer
The Split Chamfer mode draws a chamfer line between two objects, "splitting off" the lines it intersects.

Note:    The Split Chamfer mode only works on line segments. Like fillets, the setting is applied to either 
object independent of the other's type. For example, placing a Split Chamfer between a line segment 
and a polygon will split the line and ignore the polygon. 



Trimmed Chamfer
The Trimmed Chamfer mode bevels the edge of a chamfered object by actually changing the endpoints 
of the chamfered lines.

A trimmed chamfer can be used on lines, polylines, rectangles and polygons. When a rectangle or 
polygon is chamfered in Trim mode, a single object is created with the chamfer as part of the object. If 
the original object is a rectangle, it becomes a polygon.



    Clip
Key Equiv = -

The Clip tool on the 2D Tool palette is used to cut objects. It can cut lines, arcs, rectangles, ellipses, 
polygons, and polylines. This tool is similar to the Clip Surface command, but requires fewer steps. 

When the Clip tool is selected, the clip icons are displayed in the mode bar. These icons are used to 
select the kind of clipping operation you want to perform. 

To clip an object:

1. Select the object you want to clip.

2. Select the Clip tool from the 2D Tool palette.

3. In the mode bar, select the type of clip operation you want to perform.

4. Drag a marquee with the cursor. When you release the mouse button, the specified clipping 
operation is performed.

Note:      If you clip a full arc or a circle, the resulting object is a polygon (the object is no longer an arc or 
a circle). If you clip a quarter arc or oval, the result is a polyline.

For additional information, see the following topics:
Remove Inside Mode

Remove Outside Mode

Split at Boundaries Mode



    Remove Inside Mode
The Remove Inside mode removes everything within the marquee.



    Remove Outside Mode
The Remove Outside mode removes everything outside of the marquee.



    Split at Boundaries Mode
The Split at Boundaries mode cuts the object along the marquee's perimeter. The objects are selected 
but nothing is deleted. This tool is similar to the Trim command.



    Duplicate Along Path
The Duplicate Along Path tool on the 2D Palette is used to replicate an object (or group of objects) at 
regular intervals along a predefined path, or along a path that you specify with the mouse. 

Note:    This tool lies beneath the Mirror 2D tool. To access the Duplicate Along Path tool, press and 
hold the Mirror 2D icon. When the pop-out icons appear, release the mouse over the Duplicate Along 
Path tool.

When the Duplicate Along Path tool is selected, the duplicate icons are displayed in the mode bar. 
These icons are used to specify duplication parameters and to specify which type of path the duplicated 
objects will be place on. 

For additional information, see the following topics:
Object Path Duplication

Path Duplication



    Object Path Duplication
The Object Path mode is used to duplicate an object along a path defined by the perimeter of another 
object.

To copy an object along a predefined path:

1. Select the object(s) to be copied.

2. Select the Duplicate Along Path tool in the 2D Tools palette.

3. Select the Object Path Duplication icon in the mode bar.

4. Select the Duplicate Preferences icon in the mode bar.

5. Set the appropriate parameters in the Duplicate Along Path dialog box. 

· If you want to create an object at specific intervals, select Fixed Distance and specify the 
distance that will be used to separate one copy from another.

· If you want to create a certain number of objects, equally spaced on the path, select Number 
of Duplicates, and specify the number of copies that will be created.

· If you want the copies placed tangent to the object rather than intersecting it, set Tangent to 
Path.

6. Click OK to close the dialog box.

7. Click the point at which you want the first copy placed.

8. If you selected Number of Duplicates above, the copies will automatically appear around the 
object when you click the start point.

9. If you selected Fixed Distance, drag the cursor along the object for the distance that you want 
objects copied. Release the mouse to end the operation.



    Path Duplication
The Path Duplication mode is used to duplicate an object along a path defined by the mouse.

To copy an object along a path drawn with the mouse:

1. Select the object(s) to be copied.

2. Select the Duplicate Along Path tool in the 2D Tools palette.

3. Select the Path Duplication icon in the mode bar.

4. Select the Duplicate Preferences icon in the mode bar.

5. Select the Fixed Distance option and specify the distance that will separate one copy from 
another.

6. Click OK to close the dialog box.

7. Click at the path's start point and at each vertex on the path.

8. Double-click to end the operation.



    Duplicate Symbol in Wall
The Duplicate Symbol in Wall tool on the 2D Tool palette is used to replicate the active symbol 
(typically a door or window) at a specified interval in a wall.

Note:    This tool is only available when the AEC Overlay is active. If the Duplicate Symbol In Wall icon 
does not appear on the 2D Tool palette, select AEC Overlays using the Overlays command on the File 
menu.

When the Duplicate Symbol in Wall tool is selected, the duplicate icons are displayed in the mode bar. 
These icons are used to specify duplication parameters, and to specify whether the symbol will be 
duplicated with or without first flipping it. 

To duplicate the active symbol in a wall:

1. Select the Duplicate Symbol in Wall tool in the 2D Tools palette.

2. If you want the symbol to be flipped before it is placed in the drawing, select the Flip & Duplicate 
icon in the mode bar. Otherwise, select the Duplicate icon.

3. Select the Duplicate in Wall Preferences icon in the mode bar.

4. In the Duplicate Symbol in Wall dialog box, enter the distance from the beginning of the wall 
and the first symbol, or select the Next Click button to use the mouse to determine this distance. 

5. In the Spacing field, enter the distance between the duplicated symbols, or select the Next Click 
button to use the mouse to specify this distance.

6. If you want the symbol duplicated a certain number or times, enter a value in the Copies field.

7. Click OK to close the dialog box.

8. Click the wall.

For related information, see the following topics:
Symbols and Walls

Duplicate Along Path



    Ellipse
Key Equiv = 6

The Ellipse tool on the 2D Tool palette is used to draw circles and ellipses.

The area within the figure can have a fill pattern or color, and the figure's lines can be of any color (even 
invisible), thickness or dash Pattern.

When the Ellipse tool is selected, the ellipse icons are displayed in the mode bar. They allow you to 
define your figure using one of four methods. 

If the icon representing the method you want to use is not already selected, click it before you begin to 
draw your figure.

Note: By double-clicking the Ellipse tool, you can create an ellipse or circle by entering its parameters 
directly into the Create Oval dialog box. 

To complete this box, specify the figure's size in the Dx and Dy fields. In the Position fields, enter the 
figure's XY position, or set the Next Click button, and use your mouse to specify the figure's position in 
the drawing.

For additional information, see the following topics:
Ellipse by Box Mode

Circle by Radius Mode

Circle by Diameter Mode

Circle by Three Points Mode

Editing an Ellipse or a Circle



    Ellipse by Box
The Ellipse by Box mode lets you create a circle or ellipse by drawing a bounding box. 

To constrain the figure to a circle, you can:

· Hold the Shift key while drawing the bounding box, or

· Select the Symmetrical Constraint icon on the Constraint Palette.



    Circle by Radius 
The Circle by Radius mode lets you draw a circle from its center point. 

To create a circle:

1. Select the Ellipse tool in the 2D Tools palette.

2. Select the Circle by Radius icon in the mode bar.

3. Drag the mouse in any direction to create the circle.

4. When the circle is the correct size, release the mouse to set the circle into the drawing. 

Note:    The L field in the Data Display reports the length of the radius as you draw the circle. You may 
also type the radius value directly into the Data Display bar.



    Circle by Diameter 
The Circle by Diameter mode lets you create a circle by defining its diameter. 

To create a circle:

1. Select the Ellipse tool in the 2D Tools palette.

2. Select the Circle by Diameter icon in the mode bar.

3. Drag the mouse in any direction to create the circle.

4. When the circle is the correct size, release the mouse to set the circle into the drawing. 

Note:    The L field in the Data Display reports the length of the diameter as you draw the circle. You 
may also type the diameter directly into the Data Display bar.



    Circle by Three Points Mode
The Circle by Three Points mode lets you create a circle by selecting the circle's coordinates with the 
mouse. 

Three points must be selected with the mouse. This tool uses the bull's-eye cursor. 

The L field in the Data Display reports the distance from point to point. The A field reports the angle 
from point to point. You may type these values directly into the Data Display bar.



Editing an Ellipse or a Circle

An ellipse (or circle) can be edited with the mouse or with the Object Info palette.

Editing with the Mouse

· To edit an ellipse with the mouse, select the figure and place the selection cursor on one of the 
figure's handles. When the resize cursor appears, drag the handle. 

· The Data Display bar will reflect the changes you make to the figure as you move its handles.

Editing with the Object Info palette

· To edit an ellipse with the Object Info Palette, select the figure and type new values into the 
appropriate fields of the palette. (If the Object Info palette is not currently displayed, open it with 
the Object Info command.)



    Extend
The Extend tool on the 2D Tool palette lengthens or "extends" one object to meet another object. This 
tool can extend any line, arc, open polygon, or open polyline to any selected line, arc, rectangle, polyline, 
ellipse, or polygon. 

Note:    This tool lies beneath the Trim tool on the 2D Tool palette. To access the Extend tool, press and 
hold the Trim icon. When the pop-out icons appear, release the mouse over the Extend tool. 

Note:    The Extend tool will extend an object only if, when lengthened, it intersects the target object.

When the Extend tool is selected, the extend icons are displayed in the mode bar. These icons 
represent the two ways in which you can extend an object.

Extending an Object by Dragging it to the Target

1. Select the Extend Object to Object icon in the mode bar.

2. Click on the object to be extended. 

3. Position the pointer on the object and drag it to the target.

4. Release the mouse button. 

5. The object is extended to intersect the target.

Extending an Object to the Nearest Selected Object

1. Select the target object(s) 

2. Select the Extend Object to Selected Object(s) icon in the mode bar.

3. Click on the object to be extended. 

The object is extended to intersect the nearest surface of the target.



    Eyedropper
The Eyedropper tool on the 2D Tool palette is used to "pick up" attributes from one object and apply 
them to another. It can also be used to change the current default values.

When the Eyedropper tool is selected, the eyedropper icons appear in the mode bar. The Pick up and 
Put Down icons are used specify which operation will be performed--a "pick up" or an "apply." 

The Preferences icon is used to specify which attributes are applied to an object. It is also used to 
specify whether the attributes become the drawing's new default values.

Note:    You can use the Control key to toggle between Pick Up Attribute and Put Down Attribute 
mode while you are using this tool.

For additional information, see the following topics:
Pick Up Attributes

Put Down Attributes

Eyedropper Preferences



    Pick Up Attributes
The Pick Up Attributes mode is used to copy an object's attributes into the eyedropper. It can also be 
used to automatically set the default attributes from those of an existing object.

Note:    All attributes are copied by the Eyedropper tool. You may selectively apply these attributes to 
other objects by selecting them with the Eyedropper Preferences button.

To pick up an object's attributes:

1. Select the Eyedropper tool in the 2D Tool palette.

2. Select the Pick Up Attributes icon in the mode bar.

3. If you want the attributes that are copied by this tool to automatically become new default values, 
select the Eyedropper Preferences icon in the mode bar and enable the Pick Up Sets Defaults 
option.

4. Click OK to close the dialog box.

5. Click the object whose attribute you want to copy.

If the Use Sound option is on, you will hear a "slurping" sound as the attributes are picked up.



    Put Down Attributes
The Put Down Attributes mode is used to apply attributes from the eyedropper to an object. 

Note:    Before using this tool you must have already "picked up" attributes from an object. See Pick Up 
Attributes. 

To apply attributes with the Eyedropper:

1. Select the Eyedropper tool in the 2D Tool palette.

2. Select the Eyedropper Preferences icon in the mode bar.

3. In the Pick Up/Put Down Filter dialog box, select the attributes you want to apply, then close the 
dialog box.

4. Select the Put Down Attributes icon in the mode bar.

5. Place the cursor on the object to which you want attributes applied. When you are over an object 
that can accept the attributes, your cursor will turn to an inverted paint can.

6. Click the mouse.



    Eyedropper Preferences 
The Eyedropper Preferences tool is used to specify which attributes will be applied with the Put Down 
Attributes tool.

When you select this tool, the Pick Up/Put Down Filter dialog box is displayed. Select the attributes that 
you want applied to an object when the Put Down Attributes tool is used. Click OK to close the dialog 
box. The choices you've made will remain in effect until you use this tool to change them again.



    Fancy Door
The Fancy Door tool on the 2D Tool palette is used to create a door in a front elevation. The door can 
have raised panels, rectangular windows, and a semicircular top window.

Note:    This tool is only available when the AEC Overlay is active. If the Fancy Door icon does not 
appear on the 2D Tool palette,    select AEC Overlays using the Overlays command on the File menu.

When the Fancy Door tool is selected, the door icons are displayed in the mode bar. These icons are 
used to specify the door's components and to specify various options. 

To create a door using the Fancy Door tool:

1. Select the Fancy Door icon.

2. Click the Fancy Door Preferences icon in the mode bar.

3. In the Fancy Door dialog box, enter a value for the frame's thickness and any bevel for the 
panels and windows. 

4. If the door will have panels, enter the number of rows and columns it will have.

5. Click OK to close the dialog box.

6. Click the Door Slab icon in the mode bar.

7. Draw the door.

Refer to the Data Display bar if you want to see the size of the door as you are drawing it.

8. If the door will have windows or panels, click the appropriate icon in the mode bar to create them. 

Note:    The finished door is a 2D object. You may use it in this form, even in a 3D elevation view, 
however, it won't project in isometric views. In order to have it project properly, it must be converted to a 
polygon using the Convert to 3D Polygons command.



    Fillet
Key Equiv = 7

The Fillet tool on the 2D Tool palette is used to places an arc (fillet) between two objects, making the 
arc tangent to each object at the fillet's end points. 

The Fillet tool can be used between lines, boxes, polygons, polylines, circles (but not ovals), and arcs. It 
can also fillet adjacent sides of rectangles, polygons, or polylines. (Parallel or concentric objects cannot 
be filleted.) 

When the Fillet tool is selected, the fillet icons are displayed in the mode bar. These icons are used to 
select the type of fillet you want MiniCad to draw. 

To draw a fillet:

1. Select the Fillet tool from the 2D Tool palette.

2. Click the Fillet Radius icon in the mode bar.

3. In the Fillet Settings dialog box, set the fillet's radius.

4. Click OK to close the dialog box.

5. In the mode bar, select the type of fillet you want to create.

tip!    If you are using Normal or Trim mode, and you want to fillet all vertices of a box, polygon, 
or polyline, just click the figure and skip the following steps. 

6. Position the crosshair cursor over the first object of the pair to be filleted.

7. The cursor will appear as a crosshair cursor only when it is over an object that can be filleted.

8. Drag the cursor to the second object.

9. Release the mouse button.

Note:    In some cases (particularly those involving two circular objects), the fillet radius setting may be 
too small or too large for the fillet requested. When this happens, MiniCad warns you that the fillet cannot 
be placed, and ignores the command. 



    Freehand Line
Key Equiv = 5

The Freehand Line tool on the 2D Tool palette produces a polygon along a path that is specified by 
dragging the mouse.

Note:    This tool creates a polygon, not a polyline. Curves are composed of line segments, whose 
number and size are determined by the curvature of the shape and the speed of the mouse. A fast-
moving mouse dragged in a straight line creates fewer vertices than one moved slowly in a very tight arc.

To create a Freehand Line

1. Select the Freehand Line tool from the 2D Tool palette.

2. Position the cursor at the beginning of the line you want to draw.

3. Press and hold the mouse button while you draw the line.

4. When you are finished drawing the line, release the mouse button.

Once created, a Freehand Line can be reshaped or edited using the 2D Reshape tool or the 
Object Info Palette.



    Single Line
The Single Line tool on the 2D palette is used to create constrained and unconstrained single lines. 

When the Single Line tool is selected from the tool palette, the line icons are displayed in the mode bar. 
These icons allow you to create your line in constrained or unconstrained mode. 

To draw a line:

1. Select the Single Line tool from the 2D Tool palette.

2. In the mode bar, select the type of line you want to draw--constrained or unconstrained.

3. Position the cursor at the beginning of the line.

4. The way in which you draw the line will depend on how you have configured your copy of 
MiniCad with the Preferences command:

· If it is in Click-Drag mode, click and hold the mouse. Drag it to the end of the line, then 
release the mouse button.

· If it is in Click-Click mode, click the mouse button. Then, move the cursor to the end of the 
line and click again.

Note: By double-clicking the Single Line tool, you can create a line by entering its parameters directly 
into the Create Line dialog box. Or, you can select the Single Line tool and enter it's dimensions directly 
into the Data Display bar.

For additional information, see the following topics:
Constrained Lines Mode

Unconstrained Lines Mode

Editing a line



    Constrained Lines Mode
The Constrained Lines Mode is used to create lines at angles of 30°, 45°, 90°, and their complements. 

Note:    Additional angle constraints can be set with the Preferences command.



    Unconstrained Lines Mode
The Unconstrained Lines mode is used to draw a line at any angle. 

· If you want to constrain a line drawn in Unconstrained Line mode, hold the Shift key while 
drawing the line. 

· If the Constrain Angle constraint is enabled in the Constraint Palette, it will override the 
unconstrained line mode, forcing lines to be constrained. 



Editing a line

A line can be edited with the mouse or with the Object Info palette.

Editing with the Mouse

· To edit a line, select it, then place the selection cursor on one of its handles and drag it. 

· The Data Display bar will reflect the changes you make to the line as you move its handle.

Editing with the Object Info palette

· To edit a line with the Object Info palette, select the line and type new values into the appropriate 
fields of the palette. (If the Object Info palette is not currently displayed, open it with the Object 
Info command.)



    Double Line
The Double Line tool on the 2D palette is used to create constrained and unconstrained double lines. 

Note:    This tool lies beneath the Single Line tool on the 2D Tool palette. To access the Double Line 
tool, press and hold the Single Line icon. When the pop-out icons appear, release the mouse over the 
Double Line tool. 

When the Double Line tool is selected from the tool palette, the line icons are displayed in the mode bar. 
They allow you to create your line in constrained or unconstrained mode. They also specify the way in 
which the line is drawn.

To draw a line:

1. Select the Double Line tool from the 2D Tool palette.

2. Select the Double Line Preferences icon in the mode bar, and, in the Double Line Preferences 
dialog box, specify the characteristics of your line (cavity lines are defined with this dialog).

3. In the mode bar, select the control line position. The control line is the invisible line on which the 
pair is aligned. 

The control line defines the double-line's length and position. It is the line that is aligned on the 
drawing's snap points. It is also the line from which the line's thickness is measured (e.g. if the 
double line is 4" thick, and a center control line is specified, the lines are drawn 2" from either side 
of the control line).

Select... If you want...

The control line to follow the top line of the pair.

The control line to follow the center of the pair.

The control line to follow the bottom of the pair.

The control line to follow a specific offset that you have specified in 
Double Line Preferences.

4. In the mode bar, select the type of line you want to draw--constrained or unconstrained.

5. Position the cursor at the beginning of the line.

6. The way in which you draw the line will depend on how you have configured your copy of 
MiniCad with the Preferences command:

· If it is in Click-Drag mode, click and hold the mouse. Drag it to the end of the line, then 
release the mouse button.

· If it is in Click-Click mode, click the mouse button. Then, move the cursor to the end of the 
line and click again.

For additional information, see the following topics:
Constrained Double Line Mode

Unconstrained Double Line Mode

Double Line Preferences

Mitering Double Lines



    Constrained Double Line Mode
The Constrained Double Line Mode is used to create lines at angles of 30°, 45°, 90°, and their 
complements.

Note:    Additional angle constraints can be set with the Preferences command.



    Unconstrained Double Line Mode
The Unconstrained Double Line mode is used to draw a line at any angle. 

· If you want to constrain a line drawn in unconstrained mode, hold the Shift key while drawing the 
line. 

· If the Constrain Angle constraint is enabled in the Constraint Palette, it will override 
unconstrained line mode, forcing lines to be constrained. 



    Double Line Preferences
The Double Line Preferences icon is used to specify characteristics of a double line. When you select 
this button, the Double Line Preferences dialog box opens.

Note:    This dialog will automatically open if you attempt to draw a double line and Double Line 
Preferences have never been set.

This dialog box contains the following options:

Separation Field
The Separation field controls the distance between the two lines as they are drawn. 

Control Off Field
The Control Offset field determines the offset of the control line. This value is used when the Offset 
Control Line option is selected on the mode bar.

Create Lines
Creates a double line.

Create Polygons
Creates a closed polygon instead of a double line.

Create Lines and Polygons
Creates a double line and a polygon.

Cavity Lines
Displays the Cavity Line dialog box, which is used to create a cavity line. A cavity line is a line that is 
automatically drawn between the pair of lines. A double line may have more than one cavity line. 

To create a cavity line:

1. Click the New Cavity button. 

2. Specify the position of the line by entering its offset from the center of the double line. 

3. Enter the line's weight (thickness) and dash pattern in the Line field.

4. If you want a filled line, select the Filled Cavity check box, then enter a value in the Width field 
and select a pattern in the Fill field. 

5. Repeat these steps for each cavity line you want to create.



Mitering Double Lines

Double lines can be drawn with mitered ends. The miters are made by toggling the Tilde (~) and Control 
keys in different combinations. 

Note:    If you want to join double lines, it is easier to use the Join command rather than mitering their 
corners. Corner mitering is primarily provided for compatibility with older versions and for use in 
exploded details.

The Control key controls the starting point of the selected line. The default is no miter. 

· The first time the Control key is pressed the miter is cut from left to right. 

· The next time the Control key is pressed, the miter is cut from right to left. 

· The next time the Control key is pressed, the default (no miter) is selected. 

· Each time the Control key is pressed, it toggles once through the cycle.

The Tilde key controls the end point of the selected line. Each time the Tilde key is pressed, it toggles 
once through the cycle at the end point.



    Leader Line
The Leader Line tool on the 2D palette is used to create a 2-segment, leader line. A leader line can be 
constrained or unconstrained.

Note:    This tool lies beneath the Single Line tool on the 2D Tool palette. To access the Leader Line, 
press and hold the Single Line icon. When the pop-out icons appear, release the mouse over the 
Leader Line tool. 

When the Leader Line tool is selected, the leader-line icons appear in the mode bar. 

To draw a Leader Line:

1. Select the Leader Line tool from the 2D Tool palette.

2. In the mode bar, select the type of line you want to draw--constrained or unconstrained.

Note:    Both segments of a "constrained"    Leader Line are restricted to angles of 30°, 45°, 90°, 
or their complements. 

3. Position the cursor at the beginning of the line.

4. Drag the cursor to the end of the first segment.

5. Release the mouse.

6. Position the second segment with the mouse.

7. Click the mouse to set the line in the drawing.

The second segment of the Leader Line is automatically given a marker (e.g., an arrowhead). This 
marker can be changed using the Attribute Palette.



    2D Locus
Key Equiv = 0

The Locus 2D tool on the 2D Tool palette is used to place a 2D reference point (represented by a 
diagonal cross) on the drawing. 

A locus has the following uses:

· It serves as a "point of reference."

· It enables the Snap to Objects constraint to snap to a locus.

· It aligns a group of objects to a specific position when used with the Align Objects command

· It serves as the center of rotation when included in a group of rotated objects

· When Snap to Loci is set, it creates a vertical and horizontal "snap line" from each locus on the 
active layer to which the cursor snaps.

A locus has no dimension, only a location (the tools on the Constraint Palette can help in precisely 
placing a locus). It can be moved but it cannot be reshaped. 

A locus, like any other object, can be cut, copied and pasted through the Clipboard. 

For related information, see the following topics:
3D Locus



    2D Mirror
The 2D Mirror tool on the 2D Tool palette is used to make a mirror image of a selected object.

When the 2D Mirror tool is selected, the mirror icons appear in the mode bar. They determine whether 
the selected object is flipped (mirrored) or whether a mirror-image copy is made of it. 

For additional information, see the following topics:
Mirror Mode

Mirror/Duplicate Mode

For related information, see the following topics:
Rotate

Rotate 2D

3D Mirror



    Mirror Mode
The Mirror 2D mode flips the selected object on a specified axis. The axis is used to designate the 
offset, if any, of the mirrored object. 

To mirror an object

1. Select the object you want to flip.

2. Select the 2D Mirror tool from the 2D Tool palette.

3. Select the Mirror icon in the mode bar.

4. Drag a line to designate the axis around which the object will be flipped. 

Note:    By drawing this line outside the object, you can offset the mirrored result from the object's 
current position. 

5. Release the mouse button. 

The object is mirrored.



    Mirror/Duplicate Mode
The Mirror/Duplicate mode creates a mirror-image copy of the selected object. 

To mirror/duplicate an object:

1. Select the object you want to copy and flip.

2. Select the 2D Mirror tool from the 2D Tool palette.

3. Select the Mirror/Duplicate icon in the mode bar.

4. Drag a line to designate the axis around which the copied object will be flipped. 

Note:    By drawing this line outside the object, you can offset the copy from the original. 

5. Release the mouse button. 

The mirrored copy is produced.



    Move Page
The Move Page tool on the 2D Tool palette is used to move the drawing around the drawing page. It is 
often used to align the drawing within the print boundary. 

Note:      Move Page physically moves drawing on the page. If you just want to move the view of the 
page, use the Pan tool.

Note:    This tool lies beneath the Pan tool on the 2D Tool palette. To access the Move Page, press and 
hold the Pan icon. When the pop-out icons appear, release the mouse over the Move Page tool. 

To move the drawing page, choose the Move Page tool, then drag the drawing boundary to a new 
location. 

The old location is shown for reference as the drawing is moved.

For related information, see the following topics:
Shift Drawing



    Number Stamp
The Number Stamp tool on the 2D Tool palette is used to place a marker with an identifying number on 
the drawing. The number automatically increments each time the tool is used. 

Note:    This tool is only available when the AEC Overlay is active. If the Number Stamp icon does not 
appear on the 2D Tool palette,    select AEC Overlays using the Overlays command on the File menu.

When the tool is selected, the Number Stamp preferences icon appears in the mode bar. This icon is 
used to specify the stamp's size, shape and content in the Number Stamp Preferences dialog box. 
(You can also open this dialog by double-clicking the Number Stamp icon.)

A number stamp can also be attached to a database record. This allows you to use the number stamp to 
specify objects and symbols in a schedule. 

To assign a database record to the Number Stamp tool, select the Number Stamp Preferences icon 
and click the Attach button. When the dialog box opens, specify the record and fields you want to 
associate with the stamp, then click OK.

Now, each time you use the stamp, the selected record will automatically be attached to the marker.

For related information, see the following topics:
Record Formats



    Offset
The Offset tool on the 2D Tool palette is used to create a new object whose outline is at a constant 
distance from the selected object. 

The Offset tool can be used with lines, arcs, rectangles, polylines, ovals, and polygons to create 
concentric figures.

Note:    This tool lies beneath the Trim tool on the 2D Tool palette. To access the Offset tool, press and 
hold the Trim icon. When the pop-out icons appear, release the mouse over the Offset tool. 

When the Offset tool is selected, the offset icons appear in the mode bar. They are used to specify the 
offset position, and to position the object using one of two methods.

For additional information, see the following topics:
Offset by Distance Mode

Offset to a Point Mode



    Offset by Distance Mode
The Offset by Distance mode is used to position the offset at a specified distance from another.

To create an offset by specifying distance:

1. Select an object to offset.

2. Select the Offset tool from the 2D Tool palette.

3. Select the Offset by Distance icon in the mode bar.

4. Select the Offset Preferences icon in the mode bar.

5. In the Offset Preferences dialog box, enter the distance by which the new object will be offset.

6. Click OK to close the dialog box.

7. Place the cursor anywhere along the side of the object on which you want the offset object 
placed. 

8. Click the mouse.



    Offset to a Point Mode
The Offset to a Point Mode is used to specify the distance between the original object and its offset, 
using the mouse.

To create an offset by selecting a point:

1. Select an object to offset.

2. Select the Offset tool from the 2D Tool palette.

3. Select the Offset to a Point icon in the mode bar.

4. Place the cursor over the position at which you want the offset object drawn.

5. Press and hold the mouse button.

A shadow of the offset shape appears, which can be moved by dragging the mouse.

6. When the shadow object is in the correct position, release the mouse button.

The offset object is place in the drawing.



    Pan
Key Equiv = Z

The Pan tool is used to move the view of the active drawing. It is useful for fine positioning or making 
large movements. If is usually a much faster way of moving around a drawing than using the scroll bars. 

Note:    The Pan tool can also be used to redraw the screen. If the Pan tool is double-clicked, the screen 
will redraw. The screen also redraws if the mouse is clicked in the drawing window while the Pan tool is 
selected.

When the Pan tool is used, the drawing itself is unchanged-only the view is changed. This is unlike the 
Move Page tool, which physically moves the drawing on the page.

To use the Pan tool:

1. Select the Pan tool from the 2D or 3D Tool palette.

2. Drag the mouse to move the view of the drawing around the screen. 

3. The Pan tool will remain active until another tool is selected. 

Note:    A drawing also can be panned using the arrow keys. When an arrow key is pressed, the drawing 
view moves half a screen in the direction of the arrow.



    Parking Space
The Parking Space tool on the 2D Tool palette is used to create evenly-spaced lines for parking lots. 

Note:    This tool is only available when the AEC Overlay is active. If the Parking Space icon does not 
appear on the 2D Tool palette, select AEC Overlays using the Overlays command on the File menu.

To use the Parking Lot tool:

1. Select the Parking Space tool from the 2D Tool palette.

2. Select the Parking Space Preferences iconin the mode bar.

3. In the Parking Space Tool dialog box, enter the specifications for your parking spaces. If the 
Maximum Width option is enabled, the individual space widths are widened to completely fill a 
row if the row cannot accommodate another full space.

4. Click OK to close the dialog box.

5. Drag the mouse the specify the location of the stripes.



    2D Polygon
The 2D Polygon on the 2D Tool palette is used to create polygonal shapes. A polygon can contain 
segments of any length or number. It can have as few as two vertices. It can be an open or closed 
shape. The polygon, whether open or closed, can have a fill.

To create a single line polygon:

1. Select the 2D Polygon tool from the 2D Tool palette.

2. Place the cursor at the polygon's starting point.

3. Click the mouse.

4. Move the cursor to the next vertex (hold the Shift key if you want to constrain the line).

5. Click the mouse.

6. Repeat the last two steps for each vertex. Double-click the last vertex to end the operation.

Note: By double-clicking the 2D Polygon tool, you can create a polygon by entering parameters for 
each vertex directly into the Create Polygon dialog box. Enter the parameters for the first vertex, then 
click Add to create a new vertex.

For related information, see the following topics:
Editing a Polygon

3D Polygon

Extruded Polygon



Editing a Polygon

A polygon size can be edited by using the mouse. Its size and shape can be modified with the 2D 
Reshape tool or the Object Info Palette.

Editing with the Mouse

· To edit a polygon's size, select it, then place the selection cursor on one of its handles and drag it 
to a new position. 

· The Data Display bar will reflect the changes you make to the polygon as you move its handle.



    Double Line Polygon
The Double Line Polygon tool on the 2D Tool palette is used to create double line polygons with the 
option of having lines only, polygons only, or both lines and polygons. 

The polygon can contain segments of any length or number. It can have as few as two vertices. It can be 
an open or closed shape. The polygon, whether open or closed, can have a fill. Additionally, the space 
between the double lines can have a fill, or can contain a cavity line.

Note:    This tool lies beneath the 2D Polygon tool on the 2D Tool palette. To access the Double Line 
Polygon tool, press and hold the 2D Polygon icon. When the pop-out icons appear, release the mouse 
over the Double Line Polygon tool. 

When the Double Line Polygon tool is selected from the tool palette, the polygon icons are displayed in 
the mode bar. These icons are used to specify the way in which double lines are drawn.

To draw a Double Line Polygon:

1. Select the Double Line Polygon tool from the 2D Tool palette.

2. Select the Double Line Preferences icon in the mode bar, and, in the Double Line Preferences 
dialog, specify the characteristics of the double line.

3. In the mode bar, select the control line position. The control line is the invisible line on which the 
pair is aligned. 

The control line defines the double-line segment's length and position. It is the line that is aligned 
on the drawing's snap points. It is also the line from which the double line's thickness is measured 
(e.g. if the double line is 4" thick, and a center control line is specified, the lines are drawn 2" from 
either side of the control line.

Select... If you want...

The control line to follow the top line of the pair.

The control line to follow the center of the pair.

The control line to follow the bottom of the pair.

The control line to follow a specific offset that you have set in Double 
Line Preferences

4. Place the cursor at the polygon's starting point.

5. Click the mouse.

6. Move to the cursor to the next vertex (hold the Shift key if you want to constrain the line).

7. Click the mouse.

8. Repeat the last two steps for each vertex. Double-click the last vertex to end the operation.



    Regular Polygon
Key Equiv = 8

The Regular Polygon tool on the 2D Tool palette is used to create a closed polygon whose sides are 
equal in length. 

Note:    This tool lies beneath the 2D Polygon tool on the 2D Tool palette. To access the Regular 
Polygon tool, press and hold the 2D Polygon icon. When the pop-out icons appear, release the mouse 
over the Regular Polygon tool. 

When the Regular Polygon tool is selected, the polygon icons appear in the mode bar. These icons 
determine how many sides the polygon has, and how it is drawn. 

If the icon representing the method you want to use is not already selected, click it before beginning to 
draw your figure.

tip!    The U key can be used to toggle among the polygon drawing icons. The I key can be used to 
select the Polygon Preferences icon.

For additional information, see the following topics:
Inscribed Mode

Circumscribed Mode

Edge-Specified mode



    Inscribed Mode
The Inscribed mode lets you draw a regular polygon from center point to vertex.

To create an inscribed polygon:

1. Select the Regular Polygon tool in the 2D Tools palette.

2. Click the Polygon Preferences icon in the mode bar.

3. In the Regular Polygon Settings dialog box, enter a value from 3 to 4000, representing the 
number of sides the polygon will have.

4. Click OK to close the dialog box.

5. Select the Inscribed Polygon icon in the mode bar.

6. Drag the mouse in any direction to create the polygon.

tip!      The Control key can be used to toggle between inscribed and circumscribed modes while 
drawing the polygon. 

7. When the figure is the correct size, release the mouse to set it into the drawing. 

Note:    The L field in the Data Display reports the length of the radius as you draw the polygon. The 
radius of an Inscribed Polygon reflects the distance from the center of the polygon to a vertex. You may 
also enter the radius value directly into the Data Display bar.



    Circumscribed Mode
The Circumscribed Polygon mode lets you draw a regular polygon that is defined by a radius that 
extends to the midpoint of a side.

To create a circumscribed polygon:

1. Select the Regular Polygon tool in the 2D Tools palette.

2. Click the Polygon Preferences icon in the mode bar.

3. In the Regular Polygon Settings dialog box, enter a value from 3 to 4000, representing the 
number of sides the polygon will have.

4. Click OK to close the dialog box.

5. Select the Circumscribed Polygon icon in the mode bar.

6. Drag the mouse in any direction to create the polygon.

tip!      The Control key can be used to toggle between inscribed and circumscribed modes while 
drawing the polygon. 

7. When the figure is the correct size, release the mouse to set it into the drawing. 

Note:    The L field in the Data Display reports the length of the radius as you draw the polygon. The 
radius if a Circumscribed Polygon reflects the distance from the center of the polygon to the midpoint 
of a side. You may also enter the radius value directly into the Data Display bar.



    Edge-Specified mode
The Edge Specified mode lets you create a polygon by drawing one of its sides. 

To create an Edge Specified polygon:

1. Select the Regular Polygon tool in the 2D Tools palette.

2. Click the Polygon Preferences icon in the mode bar.

3. In the Regular Polygon Settings dialog box, enter a value from 3 to 4000, representing the 
number of sides the polygon will have.

4. Click OK to close the dialog box.

5. Select the Edge Specified icon in the mode bar.

6. Drag the mouse in any direction to draw a line representing one side of the polygon. You may 
rotate the polygon as it is being drawn.

tip!      The Control key can be used to flip the polygon over the defining line as you are drawing 
it.

7. When the figure is the correct size, release the mouse to set it into the drawing. 



    Polyline
Key Equiv = 5

The Polyline tool on the 2D Tool palette is used to create a connected series of arcs, curves and lines 
that are treated as a single entity. Polylines can be drawn with any line weight, color, or dash pattern. A 
polyline can also have a fill pattern.

Like a polygon, a polyline can be closed or opened. However, polylines can have any number of control 
points in addition to, or in place of, polygonal vertices. These control points can be one of three types: 

· Bezier Point

· Cubic Spline

· Arc Radius

Occasionally a polyline is converted into a polygon, such as when the Smoothing command's No 
Smoothing option (i.e., corner point option) is used.

When the Polyline tool is selected, the polyline icons appear in the mode bar. These icons are used to 
create polylines with different types of control points.

Note: By double-clicking the Polyline tool, you can create a polyline by entering the parameters for each 
vertex directly into the Create Polyline dialog box. Select a curve type and enter the parameters for the 
first vertex, then click Add to create a new vertex.

Curves and arcs follow very rigid rules regarding how they are constructed and where their tangent 
points are placed. 

Each curve segment needs three points to be drawn. If a curve segment is described with three points; 
labeled Point 1, the Control Point, and Point 2, the curve is drawn so that, at Point 1 and Point 2, the 
curve is tangent to the line extending from the Control Point. In the case of an arc, a line segment can be 
added to satisfy this condition. 

If the curve borders a control point, Point 1 and Point 2 are set to the previous and next vertex on the 
polyline. If the curve borders another curve on either side, Point 1 and/or Point 2 are set to a point 
midway between the bordering control point and the Control Point itself. 

Note:    In an open polyline, the end point can be a curve point. When this is the case, the bordering 
curve segment starts at the midway between its control point and the end point. This occurs because the 
last curve segment is always a line that extends from the end point to the mid point.

For additional information, see the following topics:
Corner Vertex

Bezier Vertex

Cubic Vertex

Arc Vertex

Editing Polylines



    Corner Vertex
The Corner Vertex icon is used to create a polyline with corner point controls.



    Bezier Vertex
The Bezier Vertex icon is used to create a polyline with Bezier controls. 

A Bezier control point is the vertex. It does not touch the surface of the polyline. Instead, it pulls the 
curve toward the point. 



    Cubic Vertex
The Cubic Vertex icon is used to create a polyline with Cubic control points. 

A Cubic control point produces a curve that passes through the control point. This curve is similar, but 
not identical to, a cubic polynomial curve fitting. 

MiniCad automatically calculates a Bezier curve to pass through a particular point on the curve. A 
phantom control point exists for each Cubic curve, which can be seen by selecting the Cubic Vertex.

Hint!      When using cubic segments, it is often useful to surround them with Bezier segments. Bezier 
segments have the useful property of being able to set the tangent of the curve at the beginning and 
end. 



    Arc Vertex
The Arc Vertex icon is used to create a polyline with Arc Radius control points. 

An arc radius control point is identical to a fillet placed at the vertex. The curve follows a circle of a preset 
radius, which joins the lines approaching from either side of the vertex. If the fillet radius is set to 0 then 
the largest fillet possible is inserted.

To specify the arc's radius, select the Radius Settings icon in the mode bar. 

With arcs the control point is the vertex.



Editing Polylines

A polyline's size can be edited with the mouse. Its size and shape can be modified with the 2D Reshape 
tool or the Object Info Palette. It can also be edited with the    Smoothing command.

Editing with the Mouse

· To edit a polyline's size, select it, then place the selection cursor on one of its handles and drag it 
to a new position. 

· The Data Display bar will reflect the changes you make to the polyline as you move its handle.



    Property Bounds
The Property Bounds tool on the 2D Tool palette is used to create a polygon based on bearing and 
distance values. The boundary line can be made of line segments or curves.

Note:    This tool is only available when the AEC Overlay is active. If the Property Bounds icon does 
not appear on the 2D Tool palette, select AEC Overlays using the Overlays command on the File 
menu.

To draw a property boundary line:

1. Select the Property Bounds tool from the 2D Tool palette.

2. Click in the drawing at the first coordinate.

3. In the, Create Property Bounds dialog box, enter the data for the first segment. Select either the 
Line or Curve button, and enter the distance and bearing in the appropriate fields. 

4. Click the Apply button to add the line segment to the boundary.

5. Repeat the last two steps for each segment in the boundary. 

Note:    If you need to remove a segment you've already added, highlight it and click Remove.

6. When all coordinates have been entered, click Done.



    Rectangle
The Rectangle tool on the 2D Tool palette is used to create a rectangle or a square.

A rectangle is created by selecting the Rectangle tool, then dragging the mouse diagonally in the 
drawing. You can constrain the figure to a square by holding the Shift key as you draw it, or by setting 
the Constrain Symmetrical option in the Constraint Palette.

The area within the figure can have a fill pattern or color, and the figures lines can be of any color (even 
invisible), thickness or dash pattern.

Note: By double-clicking the Rectangle tool, you can create a rectangle or square by entering its 
parameters directly into the Create Rectangle dialog box. 

To complete this box, specify the figure's size in the Dx and Dy fields. In the Position fields, enter the 
figure's XY position, or set the Next Click button, and use your mouse to specify the figure's position in 
the drawing.

You can also create a rectangle by selecting the Rectangle tool and entering its dimensions directly into 
the Data Display bar.

For related information, see the following topics:
Editing Rectangles

Regular Polygon

Rotated Rectangle

Rounded Rectangle



Editing Rectangles

A rectangle can be edited with the mouse or with the Object Info palette.

Editing with the Mouse

· To edit a rectangle, select it, then place the selection cursor on one of its handles and drag it. 

· The Data Display bar will reflect the changes you make to the line as you move its handle.

Editing with the Object Info palette

· To edit a rectangle with the Object Info Palette, select the rectangle and type new values into the 
appropriate fields of the palette. (If the Object Info palette is not currently displayed, open it with 
the Object Info command.)



    Rotated Rectangle
The Rotated Rectangle tool on the 2D Tool palette is used to create a rectangle at any angle. (The 
object created by this tool is actually a polygon, not a rectangle.)

Note:    This tool lies beneath the Rectangle tool on the 2D Tool palette. To access the Rotated 
Rectangle, press and hold the Rectangle icon. When the pop-out icons appear, release the mouse over 
the Rotated Rectangle tool. 

To create a rotated rectangle:

1. Select the Rotated Rectangle tool from the 2D Tool palette.

2. Position the mouse at one corner of the rectangle.

3. Drag the mouse the angle and length of one side.

4. Release the mouse.

5. Move the mouse to specify the length and position of the perpendicular side.

6. Click to finish the operation.

For related information, see the following topics:
Editing Rotated Rectangles

Rectangle

Regular Polygon

Rounded Rectangle



Editing Rotated Rectangles

Because a rotated rectangle is actually a polygon, not a rectangle, it is edited like a polygon.

A polygon's size can be edited with the mouse. Its size and shape can be modified with the 2D Reshape 
tool or the Object Info Palette.

Editing with the Mouse

· To edit a polyline's size, select it, then place the selection cursor on one of its handles and drag it 
to a new position. 

· The Data Display bar will reflect the changes you make to the polyline as you move its handle.



    Rounded Rectangle
The Rounded Rectangle tool on the 2D Tool palette is used to create rectangles with rounded corners. 
The arcs forming the corners of the rectangle can be proportional, symmetrical, or both. 

The area within the figure can have a fill pattern or color, and the figures lines can be of any color (even 
invisible), thickness or dash pattern.

Note:    This tool lies beneath the Rectangle tool on the 2D Tool palette. To access the Rounded 
Rectangle, press and hold the Rectangle icon. When the pop-out icons appear, release the mouse over 
the Rounded Rectangle tool. 

To create a Rounded Rectangle:

1. Select the Rounded Rectangle tool from the 2D Tool palette.

2. Select the Rounded Rectangle Preferences icon in the mode bar.

tip!    You can select this icon from the keyboard by pressing the U key. 

3. In the Rounded Rectangle Preferences dialog box, select the type of corner you want to the 
rectangle to have.

· If you want the corner to be drawn proportionally to the length of each side (diameter of the 
arc = 1/3 side length), check Proportional Corners.

· If you want the corner arc to be drawn symmetrically (i.e. with equal length sides), check 
Symmetrical Corners.

· If you want the same-size horizontal and vertical arc lengths, check Symmetrical Corners 
and Proportional Corners.

· If you want to specify your own arc parameters, leave Symmetrical Corners and 
Proportional Corners unchecked, and type your values directly into the X Diam and Y Diam 
fields.

4. Click OK to close the dialog box.

5. Position the cursor at one corner of the rectangle.

6. Drag the mouse diagonally to form the rectangle.

You can constrain the figure to a rounded square by holding the Shift key as you draw it, or by 
setting the Constrain Symmetrical option in the Constraint Palette.

7. When the rectangle is the correct size and shape, release the mouse button.

Note: By double-clicking the Rounded Rectangle tool, you can create the figure by entering its 
parameters directly into the Create Rounded Rectangle dialog box. 

To complete this box, select a corner type, then specify the figure's size in the Dx and Dy fields. In the 
Position fields, enter the figure's XY position, or set the Next Click button, and use your mouse to 
specify the figure's position in the drawing.

You can also create a rectangle by selecting the Rectangle tool and entering its dimensions directly into 
the Data Display bar.

For related information, see the following topics:
Editing Rounded Rectangles

Rectangle

Regular Polygon

Rotated Rectangle



Editing Rounded Rectangles

A rounded rectangle can be edited with the mouse or with the Object Info palette.

Editing with the Mouse

· To edit a rounded rectangle, select it, then place the selection cursor on one of its handles and 
drag it. 

· The Data Display bar will reflect the changes you make to the figure as you move its handles.

· In addition to the standard corner handles, a rounded rectangle has an additional handle inside it. 
This is the reshape handle. The corner diameters of a rounded rectangle can be edited by 
dragging the reshape handle. 

· The Data Display bar will reflect the current arc size when you drag the reshape handle.

Editing with the Object Info palette

· To edit a rectangle with the Object Info Palette, select the rectangle and type new values into the 
appropriate fields of the palette. (If the Object Info palette is not currently displayed, open it with 
the Object Info command.)



    2D Reshape
Key Equiv = -

The 2D Reshape tool on the 2D Tool palette is used to edit polygons and polylines, including freehand 
lines. It is also used to "hide" a segment of a polygon or polyline.

When the 2D Reshape tool is selected, the edit icons appear in the mode bar. These icons are used to 
perform various editing operations.

The first group of icons represent editing operations. If the icon representing the editing operation you 
want to use is not already selected, click it before beginning to edit your figure.

tip!    The U key can be used to toggle among the first group of icons. The I key can be used to toggle 
among the second group of icons. The O key can be used to select the Set Arc Radius icon.

When the 2D Reshape tool is active, selected objects are displayed in "reshape mode." In reshape 
mode, an object's vertices and mid-points are shown rather than its bounding-box handles. (An object 
that cannot be reshaped with this tool is displayed with the standard bounding box handles.)

For additional information, see the following topics:
Move Vertex Mode

Change Vertex Mode

Add Vertex Mode

Delete Vertex Mode

Show/ Hide Edge



    Move Vertex Mode
The Move Vertex mode is used to reposition a polyline vertex. 

When the Move Vertex icon is selected, the cursor changes to the resize cursor when it is over a vertex 
or mid-point of a selected polygon or polyline. The vertex can be moved by dragging it with the mouse.

Note:    .You can move multiple vertices at once by drawing a marquee around them. Any vertices within 
this marquee can be moved as the marquee is manipulated.



     Change Vertex Mode

The Change Vertex mode is used to change a vertex to another type (i.e., Corner, Bezier, Cubic or Arc). 

To change a vertex type:

1. Select the object you want to edit.

2. Select the 2D Reshape tool from the 2D Tool palette.

3. Select the Change Vertex icon in the mode bar.

4. Select one of the Vertex icons in the mode bar.

Select... If you want to...

Convert the vertex to a Corner Point 

Convert the vertex to a Bezier control point

Convert the vertex to a Cubic control point

Convert the vertex to an Arc control point

5. If you selected an Arc vertex above, click the Radius Settings icon in the mode bar and specify 
the radius value to be used for the for arc. Then, click OK to close the dialog box.

6. In the drawing, click the vertex you want to change.

Note:    If you change the vertex of a polygon it will automatically be converted to a polyline (a polygon 
contains only corner points).

For related information, see the following topics:
Smoothing



     Add Vertex Mode

The Add Vertex mode is used to add a vertex to a polyline or polygon.

To add a vertex:

1. Select the object you want to edit.

2. Select the 2D Reshape tool from the 2D Tool palette.

3. Select the Add Vertex icon in the mode bar.

4. Select one of the vertex icons in the mode bar.

Select... If you want to...

Add a Corner Point vertex

Add a    Bezier control point

Add a Cubic control point

Add an Arc control point

5. If you selected an Arc vertex above, click the Radius Settings icon in the mode bar and specify 
the radius value to be used for the for arc. Then, click OK to close the dialog box.

6. In the drawing, click on any point between two vertices.

The new vertex can be dragged into position as it is created. If it is not moved, the vertex is 
added precisely at the mid-point between the two existing vertices. 



    Delete Vertex Mode
The Delete Vertex mode is used to remove a vertex from a polyline or polygon.

To delete a vertex:

1. Select the object you want to edit.

2. Select the 2D Reshape tool from the 2D Tool palette.

3. Select the Delete Vertex icon in the mode bar.

4. In the drawing, click the vertex you want to remove.



    Show/ Hide Edge
The Show/Hide Edge icon is used to selectively make segments of a polyline (or polygon) invisible. 

To Hide a segment in a Polygon or Polyline:

1. Select the object you want to edit.

2. Select the 2D Reshape tool from the 2D Tool palette.

3. Select the Show/Hide Edge icon in the mode bar.

4. In the drawing, click the edge (or segment) you want to hide. 

If a segment of a polyline curve is hidden, the entire curve is hidden. If an edge of a polygon is 
hidden, the object is converted into a polyline.

To Unhide a segment in a Polygon or Polyline:

To unhide an edge (or curve) that has been hidden, follow the procedure above, selecting the 
hidden segment in step 4. 



    Resize
The Resize tool on the 2D Tool palette is used to scale an object. It resizes all vertices using a fixed 
point on the drawing as the fulcrum. If the fixed point is at the exact center of the object, the reshape is 
performed symmetrically. If the fixed point is anywhere but the center, the object is skewed as it is 
resized.

Note:    This tool lies beneath the 2D Reshape tool on the 2D Tool palette. To access the Resize tool, 
press and hold the 2D Reshape icon. When the pop-out icons appear, release the mouse over the 
Resize tool. 

To resize an object:

1. Select the object.

2. Select the Resize tool from the 2D Tool palette.

3. Click a point on the drawing. The point can be anywhere on the drawing.

4. Drag the mouse to resize the object.



    Revision Cloud
The Revision Cloud tool on the on the 2D Tool palette is used to create a revision cloud. A revision 
cloud is typically used to mark changes that have been made to a set of plans.

Note:    This tool is only available when the AEC Overlay is active. If the Revision Cloud icon does not 
appear on the 2D Tool palette, select AEC Overlays using the Overlays command on the File menu.

When the Revision Cloud tool is selected, the drawing-mode icons appear in the mode bar. These 
icons determine which method is used to draw a revision cloud.

For additional information, see the following topics:
Revision Cloud by Oval

Revision Cloud By Polygon



    Revision Cloud by Oval
The Revision Cloud by Oval mode creates a revision cloud by drawing an oval. 

To create an oval revision cloud:

1. Select the Revision Cloud tool from the 2D Tool palette.

2. Select the Revision Cloud by Oval icon in the mode bar.

3. Place the cursor in the drawing window where you want the revision cloud to appear.

4. Drag an oval, moving the mouse as needed to form the general shape of the cloud.

5. When the cloud's size and position are correct, release the mouse button.

The cloud is formed. 



    Revision Cloud By Polygon
The Revision Cloud by Polygon mode creates a revision cloud that can be any polygonal shape. 

To create an polygonal revision cloud:

1. Select the Revision Cloud tool from the 2D Tool palette.

2. Select the Revision Cloud by Polygon icon in the mode bar.

3. Place the cursor in the drawing window where you want the revision cloud to appear.

4. Click the mouse to set the first point. 

5. Move the mouse to the second point and click. 

6. Continue clicking to set the points that form the cloud. 

7. When you've clicked the last point, position the cursor on the start point and click once to finish 
the cloud.



    Rotate 2D
Key Equiv = =

The Rotate 2D tool on the 2D Tool palette is used to rotate a selected object. Rotation occurs in the 
screen plane. 

To rotate a selected object:

1. Select the object(s) to be rotated.

2. Select the Rotate 2D tool from the 2D Tool palette.

3. Position the cursor at the point around which you want the object to pivot.

4. Press the mouse and draw a line to serve as a fulcrum for the rotation.

5. Release the mouse when the fulcrum line is properly positioned.

6. Move the mouse in the direction you want the object to rotate.

7. When the object is correctly positioned, click the mouse to end the operation.

For related information, see the following topics:
Rotate

Rotate 3D

2D Mirror



    2D Selection
The 2D Selection tool on the 2D Tool palette is used to select a 2D object in the drawing window. In 
general, an object must be "selected" before any action can be taken upon it.

To select a single object:

1. Select the 2D Selection tool. 

2. Position the mouse over the object.

3. Click the mouse. 

Handles are displayed at the corners of the object's bounding box to show that it is "selected."

To select a multiple objects using the Shift key method:

1. Select the 2D Selection tool.

2. Position the mouse over the first object.

3. Click the mouse.

4. Press and hold the Shift key.

5. Position the mouse over the next object.

6. Click the mouse.

7. While continuing to hold the Shift key down, repeat the last two steps until all objects in the group 
are selected.

To select multiple objects using the Marquee method:

1. Select the 2D Selection tool.

2. Place the cursor near the group of objects to be selected.

3. Drag the selection arrow diagonally across the object or group of objects.

4. A marquee is drawn around the objects. Objects completely encompassed by the marquee are 
selected. 

Note:    All of an object's handles must be encompassed by the marquee in order for it to be 
selected. Keep in mind that some objects have handles that may not lie in close proximity to the 
visible object (polylines for example).

If you want to select all objects that the marquee touches (rather than encompasses), hold the 
Control key while drawing the marquee. This lets you select partially-captured objects.

5. If you want to deselect an object, hold the Shift key and click the object. If you want to deselect 
the entire group, click on an empty portion of the drawing. 

For additional information, see the following topics:
Smart Cursor



Smart Cursor

The Selection arrow can change as circumstances warrant. 

For example:

· The Selection arrow changes to the Move cursor when it passes over an object. You can move 
the object by dragging it.

· The Selection arrow changes to the Resize cursor when it is placed over a handle of a selected 
object. Dragging the handle with the mouse scales the object horizontally and/or vertically. 

If you have configured MiniCad for Eight Selection Handles with the Preferences command, 
objects will have mid-point handles in addition to corner-point handles. When a mid-point is 
dragged, only that handle's dimension is changed.



    Shear
The Shear tool on the 2D Tool palette skews all of the vertices of a rectangle, polygon or ellipse using a 
fixed point on the drawing as a fulcrum. 

Note:    This tool lies beneath the 2D Reshape tool on the 2D Tool palette. To access the Shear tool, 
press and hold the Reshape icon. When the pop-out icons appear, release the mouse over the Shear 
tool. 

To shear an object:

1. Select the object you want to shear.

2. Select the Shear tool from the 2D Tool palette.

3. Click on a point anywhere in the drawing. 

4. Drag the mouse to shear the object. 

5. Release the mouse when you are satisfied with the object's shape.

Note:     Rectangles and ellipses are converted to polygons when they are sheared.



    Shutters
The Shutter tool on the 2D Tool palette is used to create window shutters in front elevation.

Note:    This tool is only available when the AEC Overlay is active. If the Shutters icon does not appear 
on the 2D Tool palette,    select AEC Overlays using the Overlays command on the File menu.

To create a shutter:

1. Select the Shutter tool in the 2D Tool palette.

2. In the Shutter dialog box, enter the frame width and the slat height.

3. Click OK to close the dialog box.

4. Position the cursor on the drawing and drag a rectangular shape.

Note:    The finished shutter is a 2D object. You may use it in this form, even in a 3D elevation view, 
however, it won't project in isometric views. In order to have it project properly in a 3D view, it must be 
extruded or converted to a 3D polygon.



    Straight Stair
The Straight Stair tool on the 2D Tool palette is used to create stairs. It can be used to    make stairs 
with an open or closed riser. The stairs can be 2D, 3D or both, and they can show the required ceiling 
clearance. 

Note:    This tool is only available when the AEC Overlay is active. If the Straight Stair icon does not 
appear on the 2D Tool palette,    select AEC Overlays using the Overlays command on the File menu.

When the Straight Stair tool is selected, the stair icons appear in the mode bar. These icons are used to 
select stair alignment, landing alignment and other specifications.

tips!      Keep the following information in mind when creating stairs:

· The Stair tool must be used in Top/Plan view. If the tool is selected when the drawing is in any 
other view, you will automatically be switched to Top/Plan

· The number of risers in the staircase is determined by both the tread and the floor-to-floor 
dimension that the stairs will span. Both of these values are useful to have at hand when using 
the Straight Stair tool. 

· The dimension of the riser and the number of treads are reported in the Data Display bar when 
the stairs are created. If the riser dimension and tread count needs to be noted on the floorplan, 
make note of them before releasing the mouse.

· If the stairs have both a 2D and 3D component, it is a good idea to convert the combined 
staircase into a symbol. As a symbol, the staircase becomes a hybrid object that will appear 
correctly in any 2D or 3D view.

For additional information, see the following topics:
Stair Preferences



    Stair Preferences
The Stair Preferences icon is used to specify parameters for the Straight Stair tool. When this icon is 
selected, the Straight Stair Preferences dialog box is opened. 

Note:    This dialog will automatically open if you attempt to create stairs and Straight Stair Preferences 
have never been set.

This dialog box contains the following options:

2D Checkbox
Creates a 2D stair. 

3D Checkbox
Creates a 3D stair.

Ascending and Descending Buttons
Specifies the direction of a set of 3D stairs

Square Landing
Creates a landing using the dimensions entered in the Stair Width field. 

Draw 2D Stair Break
Draws a stair break. Because a staircase can traverse from one floor to another on a floorplan, a 
standard drawing technique is to draw a staircase only partially, and show the continuation with a stair 
break. 

Open Risers
Creates stairs with open risers. When selected, the fields for tread and stringer thickness become active. 

Denote Head Clearance
Activates the fields for the minimum clearance and ceiling height. Because code requirements vary, be 
sure the values entered in these fields are correct for the particular stairs being drawn.

Tread
Used to specify the dimension of the stair's tread.

Fit to Height 
Calculates the number of risers required to create the staircase. When this checkbox is selected, the 
Height field becomes active. The value in this field is the dimension taken from the top of the floor at the 
first level, to the top of the floor of the next level.

Two additional fields, for the minimum and maximum dimension of the riser, are displayed when Fit to 
Height is selected. These values are used in conjunction with the values entered in the Tread and 
Height fields to calculate the number of treads in the staircase. 

Stair Width
Used to specify the width of the stair (i.e., distance from stringer to stringer). This value is also used for 
the landing, if the Square Landing checkbox is selected.

Starting Z
Used to specify the point in 3D space where the stairs originate. Generally, Starting Z will be zero.



    Insert 2D Symbol
The Insert 2D Symbol tool on the 2D Tool palette is used to place symbols in the drawing in 2D or Plan 
projection. 

When the 2D Symbol tool is selected, each click of the mouse places a copy of the active symbol on the 
drawing. (The active symbol is specified in the Resource Palette). 

Note:    Every symbol has an insertion point; which was specified when the symbol was created. When 
the symbol is placed in the drawing, this point is aligned on the point that you select with your mouse.

A symbol can be rotated as it is inserted by moving the mouse. After a symbol has been placed, you may 
rotate it with the Rotate 2D tool, or move it with the mouse or the Move command.

For related information, see the following topics:
Symbols and Walls

Resource Palette

Symbol Edit

Insert 3D Symbol



Symbols and Walls

If a symbol is placed in a wall, the symbol is automatically inserted into the wall with its insertion point on 
the wall's control line. The wall is automatically cut at the insertion point to fit the symbol, and the symbol 
rotates to match the angle of the wall.

A symbol can be removed by selecting it and dragging it away from the wall. If a symbol is dragged out 
of a wall, the cut in the wall is automatically sealed. 

A symbol can be relocated in the wall by selecting it and dragging it to a new location. The old insertion 
point is sealed, and the new one is created automatically. 

A symbol can be rotated to one of four positions by dragging the mouse as the symbol is inserted. This 
rotation can only be done at insertion however.

If a rotated symbol is relocated to another part of the wall, it retains its rotation angle, unless it's insertion 
point is on one side and it is inserted into a wall in the opposite direction. Such a symbol can be rotated 
at insertion to orient it correctly. However, if such a symbol is dragged away from the wall and then 
dragged back, it reverts to its original orientation. When this occurs, drag the symbol away from the wall, 
delete it, then reinsert it rotating it to the proper orientation.

Symbols are created with a specific Dz. If you need to change the Dz position of one specific instance of 
a symbol, use the 3D Reshape tool. This tool lets you change the selected symbol's Dz value without 
affecting other instances of the symbol in the drawing. 

You can switch to 2D/Plan projection to select a symbol in a wall. This is often easier than trying to select 
the symbol in a 3D projection.

For related information, see the following topics:
Insert 2D Symbol

Insert 3D Symbol

Resource Palette

Symbol Edit



    Symbol Paint
The Symbol Paint tool on the 2D Tool palette is used to place multiple copies of the active symbol in 
the drawing by dragging the mouse. (The active symbol is specified in the Resource Palette). 

The symbol is inserted with its    standard insertion point. Once a symbol has been inserted, it can be 
moved or rotated with the standard object-manipulation tools.

Note:    This tool lies beneath the Insert 2D Symbol tool on the 2D Tool palette. To access the Symbol 
Paint tool, press and hold the Insert 2D Symbol icon. When the pop-out icons appear, release the 
mouse over the Symbol Paint tool. 

The Snap to Grid constraint on the Constraint Palette must be enabled to use the Symbol Paint tool 
because it is used to control the placement of the symbols. For example, if the grid is set to 1/8", a 
symbol is placed at 1/8" intervals along the path over which the mouse is dragged. 

The Symbol Paint tool can be used in one of two modes. 

· One mode places symbols and ignores any already-placed symbols on the drawing. 

· The other mode replaces any already-placed symbol if the cursor moves near the center of the 
existing symbol's bounding box.



    Text
The Text tool on the 2D Tool palette is used to place text anywhere on a drawing. A text block can have 
multiple fonts, and those fonts can have multiple sizes, colors, case, and styles.

Text can be rotated to any angle (this works best with PostScript and TrueType fonts--substantial quality 
loss usually occurs with other fonts). Text can also be scaled. If you want text to be scaled like other 
objects in the layer, set the Scale Text option with the Layers command.

To add text to a drawing:

1. In the Text menu, select the character font, size and style you want to use (these attributes will 
become the default).

2. Select the Text tool from the 2D Tool palette.

3. Move the cursor to the drawing.

The I-beam cursor appears.

4. Position the cursor at the point where text will begin and do one of the following:

· If you need to type only a few words (less than a line or two), simply click the point at which 
you want text to begin and start typing. When you need to begin a new line, press Enter. 

· If you need to enter several lines of text, drag the cursor diagonally to create a "text block." 
Release the mouse when the block is approximately the size you need (you can easily 
change its size later). Type your text in the block. Your words will automatically wrap to fit 
within the block.

5. To end text mode, click anywhere in the drawing, or select another tool.

Handles are placed around the text. The text object may now be moved, reshaped or rotated. 

For additional information, see the following topics:
Editing Text



Editing Text

The Text tool on the 2D Tool palette is used to edit text in a text box.

To edit text in a drawing:

1. Select the text block you want to edit.

2. Select the Text tool from the 2D Tool palette.

3. Place the cursor over the text block.

4. Click the mouse. 

The text block is placed in "edit mode," and you can add, delete or modify text within it.

5. To end text mode, click anywhere in the drawing, or select another tool.



    Trim
The Trim tool on the 2D Tool palette is used to remove a portion of an object using another object as a 
cutting tool. Lines, arcs, rectangles, polylines, ovals, and polygons can be trimmed, or they can be used 
as cutting objects.

To trim an object:

1. Select the cutting object(s).

Important!    The cutting object(s) must intersect the object to be trimmed. 

2. Select the Trim tool from the 2D Tool palette.

3. Place the cursor over the portion of the object to be removed.

4. Click the mouse.

The piece between the object's boundary and the cutting tool is removed. If the object is 
intersected by two cutting objects, the piece between the cutting objects is removed. 

For related information, see the following topics:
Clip

Clip Surface 

Trim

Intersect Surface



    Wall
The Wall tool on the 2D Tool palette is used to create walls. Walls can have a fill and can contain a 
cavity line. Sections of wall can be joined, capped or trimmed. 

Note:    This tool is only available when the AEC Overlay is active. If the Wall icon does not appear on 
the 2D Tool palette,    select AEC Overlays using the Overlays command on the File menu.

The Wall tool is a hybrid tool. It creates objects in 2D that are seen as 3D objects when viewed in a 3D 
orthogonal projection. A wall appears as a 3D object, and can be displayed as wireframe or rendered 
solidly with a color or fill. Unless the wall is given a custom Dz, the wall has the default Dz for the layer. 

A wall can be resized or reshaped, and a peak can be added with the 3D Reshape tool.

Note:    You should consider using the Wall tool, even if you generally view your floor plan only in 2D. 
Walls have special properties that comparable objects (e.g. double line objects) can't provide. For 
example, when a    window or door symbol is inserted into a wall, a hole is automatically cut to receive it. 
If the symbol is subsequently removed, the hole is automatically sealed. 

When the Wall tool is selected, the wall icons appear in the mode bar. These icons are used to create, 
join and edit a wall. They are also used to specify the way in which the wall is drawn.

tip!    The U key can be used to toggle among the first group of icons. The I key can be used to toggle 
among the second group of icons. The O key can be used to select the Wall Preferences icon.

To create a wall:

1. Place the drawing in 2D/Plan projection (the Wall tool must be used in 2D/Plan view). 

2. Select the Wall tool from the 2D Tool palette.

3. Select the Wall Preferences icon in the mode bar, and specify the characteristics of the wall line.

4. In the mode bar, select the control line position. The control line is the invisible line on which the 
wall is aligned. 

The control line defines the wall's length and position. It is the line that is aligned on the drawing's 
snap points. It is also the line from which the wall's thickness is measured (e.g. if the wall is 4" 
thick, and a center control line is specified, the lines are drawn 2" from either side of the control 
line). 

The control line is also the line on which symbols are aligned when they are placed in the wall.

Select... If you want...

The control line to follow the top line of the 
wall.

The control line to follow the center of the 
wall.

The control line to follow the bottom of the 
wall.

The control line to follow a specific offset 



that you have set in Wall Preferences.

4. Select the Create Wall icon in the mode bar.

5. Position the cursor where you want the wall to begin.

6. Drag the mouse to form the wall.

7. When the wall is the correct length, release the mouse button.

8. The wall is placed in the drawing. A wall is a "special group" of objects, and is treated differently 
than other objects.

· Wall are always are restricted to the vertical axis of the working plane.

· Walls are a "special group" of objects. Do not ungroup them. Once a wall is ungrouped it is no 
longer a wall, and there is no way to convert it back into a wall.

· Walls are drawn with an invisible control line, whose position is established when the wall is 
created. All measurements involving a wall (e.g., area, perimeter, length, and width) are taken 
from the control line. 

· The control lines of all walls must be considered when grouped walls are reshaped. 
Unexpected results can occur.

· Because the control line is used as the insertion point for symbols, the wall's thickness must 
be considered when the insertion point is set for the symbol. To place symbols properly within 
the wall, you can specify a user-defined control line, or adjust the symbol's insertion point.

· Walls have a "direction," which is determined by the direction the mouse was dragged when 
the wall was created (or by its start point, if the wall was created by a dialog box). 

This characteristic affects the placement of symbols having an insertion point on one side (it 
has no effect on an insertion point At Object Center). A symbol with an insertion point on the 
left side of the symbol can be inserted into a wall with the insertion point on the right side. 
This reversal of insertion point is because the wall was drawn in the opposite direction of the 
insertion point. If the symbol flips when inserted, rotate the symbol at insertion to the proper 
orientation.

For additional information, see the following topics:
Join Wall

Remove Break

Wall Preferences



    Join Wall
The Join Wall icon is used to connect wall segments by dragging a line from one wall segment to 
another. It automatically determines the type of joint to form (i.e., whether to create a "T" "L" or "X" join). 

The Join Wall icon works the same as the Join command. 

Note:     If you have multiple walls converging at odd angles, they may not join properly using the Wall or 
Butt-Join Wall tools. In this event, use the Y-Join Wall tool to join the walls



    Remove Break
The Remove Break mode cleans up a wall after editing. 

By dragging a marquee around the affected area, the previous joins are cleaned, breaks caused by 
symbols are removed, and any caps at the ends of walls are removed.



Wall Preferences

The Wall Preferences icon is used to specify parameters for the Wall tool. When this icon is selected, 
the Wall Preferences dialog box is opened. 

This dialog box contains the following options:

Separation
The Separation value specifies the overall thickness of the wall. You must enter the thickness of the 
whole wall (e.g., for an exterior wall add the siding, sheathing, stud wall and interior wallboard). This 
insures that your 3D models are accurately proportioned.

Control Off field
The Control Offset field determines the offset of the control line. This value is used when the custom 
control line button is selected on the mode bar (i.e., the last button in the second group).

Caps
The Caps option specifies whether the wall's ends are capped. The choices are: None, Start, End, and 
Both.

Type
The Type option specifies the type of wall cap to be used, Flat or Round.

Cavity Lines
Displays the Cavity Line dialog box, which is used to create a cavity line. A cavity line is a line that is 
automatically drawn within the wall. A wall may have more than one cavity line. 

To create a cavity line:

1. Click the New Cavity button. 

2. Specify the position of the line by entering its offset from the center of the wall. 

3. Enter the line's weight (thickness) and dash pattern in the Line field.

4. If you want a filled line, select the Filled Cavity check box, then enter a value in the Width field 
and select a pattern in the Fill field. 

5. Repeat these steps for each cavity line you want to create.



    Butt-Join Wall
The Butt-Join tool on the 2D Tool palette is used to join walls with corners butted together instead of 
mitered. 

Butt-joined walls reflect the corner construction of actual walls in a structure. When walls are butt-joined, 
takeoffs are more accurate, as the true length of the bearing walls are always known. Butt-joined walls 
insure that beams and other structural members are sized correctly. 

Note:    This tool is only available when the AEC Overlay is active. If the Butt-Join Wall icon does not 
appear on the 2D Tool palette, select AEC Overlays using the Overlays command on the File menu.

To use the Butt-Join tool:

1. Select the Butt-Join tool from the 2D Tool palette.

2. Drag the mouse from the non-bearing wall to the bearing wall.

3. If the walls have no caps, select the bearing walls and open the Object Info Palette. In the 
Object Info palette, choose Both in the Caps menu, and Flat in the Type menu.

Note:      If you have multiple walls converging at odd angles, they may not join properly using the 
Wall or Butt-Join Wall tools. In this event, use the Y-Join Wall tool to join the walls



    Y-Join Wall
The Y-Joint tool on the 2D Tool palette is used to join multiple walls that come together at odd angles, 
and cannot be joined using the Wall or Butt-Join Wall tools.

Note:    This tool is only available when the AEC Overlay is active. If the Y-Join Wall icon does not 
appear on the 2D Tool palette, select AEC Overlays using the Overlays command on the File menu.

To use the Y-Join tool:

1. Use the Wall tool's Join Wall button to join two of the walls. 

2. Draw the next wall segment, stopping just short of the junction of the first two walls.

Note:    All walls should have a fill.

3. Select the first two walls.

4. Select the Y-Join tool on the 2D Tool palette.

5. Click on the new wall segment. 

It joins the first two walls at their junction. 



    Align Plane
The Align Plane tool on the 3D Tool palette allows 3D objects to be aligned to the working plane in both 
rotation and translation. Since the working plane can be set easily to a plane of an existing object, the 
Align Plane tool allows any two objects to be aligned precisely to each other. 

After alignment, the working plane remains at the plane between these two objects. This allows the 
objects to be moved or rotated relative to each other while maintaining this precise alignment.

To use the Align Plane tool:

1. Set the working plane to the plane to which you want to align one or more objects.

2. Select the objects.

3. Select the Align Plane tool. 

If the drawing is in wireframe, three snap points must be clicked to set the plane which aligns to the 
working plane. In solid mode, simply click the face of the object. 

Note that the Align Plane tool is used exactly like the Set Working Plane tool.

While the Align Plane tool works with precision in solid mode, even more control is available in 
wireframe. This is because the three points also completely define the axes that align to the working 
plane axes. When a plane is selected in solid mode, the axes are derived from the points of the polygon 
that is clicked.



    Flyover
The Flyover tool on the 3D Tool palette is used to move the view of the drawing by dragging the mouse. 
It changes the angle of view, while constraining the viewer to an upright position. It is the easiest way to 
manipulate your view of 3D space.

When the Flyover tool is selected, the flyover icons are displayed in the mode bar. These icons are used 
to select an origin, and to perform rotation in discrete steps. 

tip!    The U key can be used to toggle among the first group of icons. The four motion buttons can be 
selected from the keyboard using the I, O, P, and [ keys, respectively.

In Flyover mode, the following mouse movements rotate the drawing.

· Vertical mouse movements change the viewer's latitude with respect to an imaginary sphere 
about the currently-selected center of rotation.

· Horizontal mouse movements change the viewer's longitude with respect to an imaginary 
sphere about the currently-selected center of rotation.

If the Control key is pressed while the mouse is moved, the viewpoint can be modified in ways that are 
useful in a perspective projection:

· Control Key + Vertical mouse movements changes the viewer's height from the ground plane. 
This movement is only useful in perspective projection. 

You can also use the Up and Down buttons on the mode bar instead of the mouse. These 
buttons let you move up and down in step-like fashion. Each click of the button results in a single 
step in the requested direction.

· Control Key + Horizontal mouse movements changes the distance between the viewer and 
the currently-selected center of rotation. Moving the mouse right increases the distance from 
center. Moving it left decreases the distance from center. This movement is only useful in 
perspective projection.

You can also use the In and Out buttons on the mode bar instead of the mouse. These buttons 
let you move in and out in step-like fashion. Each click of the button results in a single step in the 
requested direction.

If a model is rendered solid, it will turn to wireframe during rotation. It will be re-rendered solid when the 
mouse is released.

To achieve the best possible performance, MiniCad optimizes the drawing by reducing the level of detail 
it displays. This is done to retain the same level of control in a complex model as in a very simple one.

You will find that a slow computer will have less range of control than a faster computer. You can use 
MiniCad's 3D Rotation preference to optimize the performance of this tool on your system. This option is 
specified using the Preferences command is on the File menu. 

For related information, see the following topics:
Rotate 3D View

Rotate View

Walkthrough



    3D Locus
The Locus 3D tool on the 3D Tool palette is used to place a 3D reference point (represented by a triad) 
on the drawing. 

A 3D Locus has a location (x. y and z coordinates), but no dimension. It can be moved, but not 
reshaped. A locus can be placed more reliably if the Snap to Objects constraint is on. If the 3D Locus 
isn't snapped to an object, it is placed on the working plane. 

If you want to move a 3D Locus, use the Object Info Palette. It has the controls to position the locus in 
relation to the working plane or the ground plane. The Move 3D command can also be used to place the 
locus.

A 3D Locus, like any other object, can be cut or copied and pasted through the Clipboard

For related information, see the following topics:
2D Locus



    3D Mirror
The 3D Mirror tool on the 3D Tool palette is used to make a mirror image of a selected object in 3D 
space. 

When the 3D Mirror tool is selected, the mirror icons appear in the mode bar. They determine which 
mirror operation is performed. 

For additional information, see the following topics:
Mirror 3D mode

Mirror/Duplicate 3D mode

Mirror Across Working Plane mode

For related information, see the following topics:
Rotate 3D

Rotate

2D Mirror



    Mirror 3D mode
The Mirror 3D mode flips the selected object on a specified axis. The axis is used to designate the 
offset, if any, of the mirrored object. 

To mirror a 3D object

1. Select the object you want to flip.

2. Select the 3D Mirror tool from the 2D Tool palette.

3. Select the Mirror icon in the mode bar.

4. Drag a line to designate the axis around which the object will pivot. 

5. Note:    By drawing this line outside the object, you can offset the mirrored result from the object's 
current position. 

6. Release the mouse button. 

The object is mirrored.



    Mirror/Duplicate 3D mode
The Mirror/Duplicate 3D mode creates a mirror-image copy of the selected object. An axis line is drawn 
to designate the pivot point around which the object will rotate. 

To mirror/duplicate an object:

1. Select the object you want to duplicate and mirror.

2. Select the 3D Mirror tool from the 3D Tool palette.

3. Select the Mirror/Duplicate icon in the mode bar.

4. Drag a line to designate the axis around which the copied object will pivot. 

Note:    By drawing this line outside the object, you can offset the copy from the original. 

5. Release the mouse button. 

The mirrored copy is produced.



    Mirror Across Working Plane mode
The Mirror Across Working Plane mode is used to automatically mirror an object and reposition it on 
the opposite side of the working plane.

To mirror across the working plane:

1. Select the 3D object you want to mirror.

2. Select the 3D Mirror tool from the 3D Tool palette.

3. Select the Mirror Across Working Plane icon in the mode bar.



    Extruded Polygon
The Extruded Polygon tool on the 3D Tool palette is used to extrude objects in 3D without drawing 
them in 2D first. This command actually creates a mesh object, not an extrude. 

Note:    This tool lies beneath the 3D Polygon tool on the 3D Tool palette. To access the Extruded 
Polygon, press and hold the 3D Polygon icon. When the pop-out icons appear, release the mouse over 
the Extruded Polygon tool. 

To create an Extruded Polygon:

1. Place the drawing in any 3D projection. 

2. Select the Extruded Polygon tool from the 3D Tool palette.

The cursor for the tool will project on the ground plane or a specified working plane. 

3. Position the cursor at one of the polygon's vertices.

4. Drag the mouse up to set the height of the polygon.

The Dz field in the Data Display bar reports the height of the figure as the mouse is dragged.

5. When the cursor is at the correct height (i.e., z position), release the mouse button. 

Note:     If the height vertex is zero, or if the object is created in top view, a dialog box will prompt 
you for the object's height. If, for the sake of accuracy, you prefer to enter the polygon's height via 
a dialog, click once at the start point to bring up the dialog box.

6. Move the cursor to the next vertex. 

7. Click the mouse.

8. Repeat steps 6 and 7 for each vertex. Double-click the last vertex to end the operation. (If the last 
point is also the polygon's start point, a single click will end the operation).

If a point snaps outside the working plane, it projects into the working plane.

For additional information, see the following topics:
Editing Extruded Polygons



Editing Extruded Polygons

Extruded polygons are edited using the Object Info Palette. Because the object is a mesh, individual 
vertices of the object can be edited.

To edit the figure, select it, then enter new values into the appropriate fields of the Object Info palette. (If 
the Object Info palette is not currently displayed, open it with the Object Info command.) The palette's 
Edit option lets you choose between editing a single vertex or multiple vertices. 

For related information, see the following topics:
Extrude

Multiple Extrude

2D Polygon

3D Polygon

Extruded Rectangle



    3D Polygon
The 3D Polygon tool on the 3D Tool palette is used to create 3D polygons without drawing them in 2D 
first.

A 3D polygon does not have a depth, it does have a z value, which gives it a location in 3D space. A 3D 
polygon can be rotated, placed in perspective, and translated in space like any other 3D object. Unlike a 
2D polygon, 3D polygons must be rendered to apply a fill pattern to them.

To draw a 3D polygon:

1. Select the 3D Polygon tool from the 3D Tool palette.

2. Place the cursor at the polygon's starting point.

3. Click the mouse.

4. Move the cursor to the next vertex (hold the Shift key if you want to constrain the line).

5. Click the mouse.

6. Repeat the last two steps for each vertex. Double-click the last vertex to end the operation. If the 
last point is also the polygon's starting point, a single click will end the operation.

Note:     The perpendicular constraint allows points to be specified outside the working plane. The 
constraint vector is determined by the location of the mouse when the constraint is activated. It 
can be repositioned by deactivating the constraint, repositioning the mouse, and activating the 
constraint again. Use the keyboard to control the constraint in order to control the location of the 
constraint vector.

For related information, see the following topics:
Extrude

Multiple Extrude

2D Polygon

Extruded Polygon

Extruded Rectangle



     Extruded Rectangle

The Extruded Rectangle on the 3D Tool palette creates a 3D rectangle in one operation (i.e., without 
having to first draw it in 2D and then extrude it).

A mesh object is created when this tool is used. The rectangle is created at the working plane axes.

To create an Extruded Rectangle:

1. Place the drawing in any 3D projection. 

2. Select the Extruded Rectangle tool from the 3D Tool palette.

The cursor for the tool will project on the ground plane or on a specified working plane. 

3. Position the cursor at one of the rectangle's corner points.

4. Drag the mouse up to set the height of the rectangle.

The Dz field in the Data Display bar reports the height of the rectangle as the mouse is dragged.

5. When the cursor is at the rectangle's height (i.e., z position), release the mouse button. 

6. Note:     If the height vertex is zero, or if the object is created in top view, a dialog box will prompt 
you for the rectangle's height. If, for the sake of accuracy, you prefer to enter the object's height 
via a dialog, click once at the start point to bring up the dialog box.

7. Move the mouse to form the extruded rectangle.

8. Click to finish the operation. 

If a point is snapped outside the working plane, it is projected into the working plane so that the 
extruded rectangle is planer. Click once on the start point or double-click anywhere to end the 
operation.

For related information, see the following topics:
Editing Extruded Rectangles

Extrude

Multiple Extrude

Extruded Polygon



Editing Extruded Rectangles

Extruded rectangles are edited using the Object Info Palette. Because the object is a mesh, individual 
vertices of the object can be edited.

To edit the figure, select it, and enter new values into the appropriate fields of the Object Info palette. (If 
the Object Info palette is not currently displayed, open it with the Object Info command.) The palette's 
Edit option lets you choose between editing a single vertex or multiple vertices. 



    3D Reshape
The 3D Reshape tool on the 3D Tool palette is used to edit extrudes, walls, roofs and 3D polygons.

The 3D Reshape tool can be used to reshape a single 3D object. But, because of conflicting constraints 
imposed on different 3D objects, this tool cannot be used on a group of objects.

In reshape mode, an object shows all reshape handles and, if necessary, the working plane changes. If 
points can be added or deleted from an object, then the mode bar will shows those options.

3D operations that allow movement perpendicular to the working plane do not work if the working plane 
is being viewed straight on. This means that operations that allow movement only in the working plane 
will work if the working plane is viewed on its side. For example, it is impossible to edit the height of an 
object if viewed from above. Because of this, you may want to use an isometric view of the working 
plane when using the 3D Reshape tool.

Note:    The 3D Reshape tool cannot be used on 3D polygons or extruded rectangles. Because these 
figures are mesh objects, not true extruded objects, they must be reshaped as mesh objects.

For additional information, see the following topics:
Reshaping Extrudes

Reshaping Walls

Reshaping Roofs

Reshaping 3D Polygons



Reshaping Extrudes

The 3D Reshape tool can be used to change the height of an extruded object. At the center of each end 
face is a control handle, which can be dragged along the vector perpendicular to the face of the extrude. 

If a 3D point is snapped during this operation, that point is projected onto the constraint vector, aligning 
the extruded face to that point. 

In order to edit an extrude, the Edit Group command must be used.



Reshaping Walls

The 3D Reshape tool can be used to change the height of the top and bottom surface, change the 
height and location of any point peak and change the location of the end points. All reshape operations 
affect the wall's front and back faces.

Because a wall must remain vertical with respect to the ground plane, reshape operations on a wall 
constrain its freedom of motion. Moving the top or bottom surface at its end point constrains movement 
perpendicular to the ground plane and prevents creation of a wall of a negative height.

The "+" and "-" icons on the mode bar can be used to add or delete peak points. 

· To add a peak point, click on an existing peak or end point and drag a new peak point from it. 

· To delete a peak point, click on the point to remove it.



Reshaping Roofs

The 3D Reshape tool can be used to reshape the rise/run (angle) of a roof. 

Control handles are placed on the defining plane of the roof (on which the roof axis lies) at the corners of 
the area enclosing the entire roof. A roof reshape is constrained to 0° - 85° inclination. If another 3D point 
is snapped during reshape, the roof is aligned such that the point specified lies in the roof plane.

Note that the roof plane is the top surface of a horizontally-mitered roof, the bottom surface of a 
vertically-mitered roof, and the surface intersecting the lowest corner of a double-mitered roof.



Reshaping 3D Polygons

The 3D Reshape tool can be used to reshape a 3D polygon. If the 3D polygon is a planar polygon, the 
working plane is set to that plane. The polygon is edited in the working plane in the same way as a 2D 
polygon is edited.

If a point is snapped to a point outside of the plane, the polygon becomes non-planar. If the 
perpendicular constraint is active, a point is constrained to the vector that passes through it 
perpendicular to the working plane.

If the polygon is non-planar when it is selected, the current working plane remains set and editing 
operations take place in that plane.

For related information, see the following topics:
2D Reshape



    Rotate 3D
The Rotate 3D tool on the 3D Tool palette is used to rotate a selected object in 3D space. An object can 
be optionally copied when it is rotated. 

To use the Rotate 3D tool, the drawing must be in 3D view and a 3D object must be selected. 

When the Rotate 3D tool is selected, the 3D rotation icons appear on the mode bar. The first set of icons 
determine whether the selected object or a duplicate of it is rotated. The second set of icons specifies 
the rotation method. 

tip!    The U key can be used to toggle among the first group of icons. The I key can be used to toggle 
among the second group of icons.

For additional information, see the following topics:
Standard Rotation

Alignment Rotation



    Standard Rotation
The Standard Rotation mode rotates selected objects about the working plane normal. 

To perform a standard rotation of a 3D object:

1. Select the 3D object you want to rotate.

2. Switch to an orthogonal projection.

3. Select the Rotate 3Dtool from the 3D Tool palette.

4. If you want to rotate a copy of the selected object, select the Rotate Duplicate Object icon in the 
mode bar. Otherwise, select the Rotate Selected Object icon.

5. Select the Standard Rotation icon on the mode bar.

6. Drag a rotation axis and release the mouse.

7. Move the mouse to rotate the object. 

The object rotates with the "lever" you created with the axis line. If the Snap To Points constraint 
is active, the axis allows precise rotation.

8. Click to end the rotation.



    Alignment Rotation
The Alignment Rotation mode rotates the selected object so that the rotation lever aligns with an 
alignment vector. 

To perform an alignment rotation of a 3D object:

1. Switch to an orthogonal projection.

2. Select the Rotate 3Dtool from the 3D Tool palette.

3. If you want to rotate a copy of the selected object, select the Rotate Duplicate Object icon in the 
mode bar. Otherwise, select the Rotate Selected Object icon.

4. Select the Alignment Rotation icon on the mode bar.

5. Select the object and snap to a center of rotation. 

6. Drag to a second point defining the rotation lever and snap to this point.

7. Release the mouse and snap to a third point. This aligns the rotation lever with the alignment 
lever defined by the first and third points. 

8. Click again to end the rotation.



    Rotate View
The Rotate View tool on the on the 3D Tool palette is used to change a model's angle of view. It allows 
full control over the three rotation axes, allowing any view orientation. 

Note:    This tool lies beneath the Flyover tool on the 3D Tool palette. To access Rotate View, press and 
hold the Flyover icon. When the pop-out icons appear, release the mouse over the Rotate View tool. 

When the Rotate View tool is selected, the rotate view icons appear on the mode bar. These icons are 
used to set the center of rotation and the direction of rotation.

tip!    The U key can be used to toggle among the first group of icons. The I key can be used to select the 
Rotate Clockwise icon; the O key can be used to select the Rotate Counter-clockwise icon.

In Rotate View mode, the active area of the screen is divided into nine sectors, made up of three vertical 
and three horizontal stripes. Each stripe responds to mouse motion, such that the entire screen becomes 
a virtual trackball.

Vertical Mouse Movement

Mouse movement in sectors 1-4-7 and 3-6-9 rotates the world about the direction of view, "tilting" the 
viewer orientation.

Mouse movement in sector 2-5-8 rotates the world about the axis parallel to the x axis of the screen, 
passing through the center of rotation selection in the mode bar.

Horizontal Mouse Movement

Mouse movement in sectors 1-2-3 and 7-8-9 rotates the world about the direction of view, "tilting" the 
viewer orientation.

Mouse movement in sector 4-5-6 rotates the world about the axis parallel to the y axis of the screen and 
passing through the center of rotation selected in the mode bar. 

Note:    The Rotate View tool provides so much movement that it can become awkward to use. If you 
want to constrain the view attitude, use the Flyover tool.

For related information, see the following topics:
Rotate 3D View

Translate View

Walkthrough

Flyover



Rotate



    3D Selection
Key Equiv = X

The 3D Selection tool on the 3D Tool palette is used to select objects in 3D orthogonal views. This tool 
works with the 3D SmartCursor to allow 3D snaps and constraints.

When the 3D Selection tool is selected, the standard views icons appear in the mode bar. These views 
are identical to the views available with the Standard Views command.



    Set Working Plane
The Set Working Plane tool on the 3D Tool palette is used to set the working plane based on either a 
currently extant object's plane or three points in space specified by the user.

The "working plane" is a movable, user-defined plane that allows precise 3D editing. When 3D tools are 
active, the mouse's position in 3D space is determined by the working plane. It is a constant reference 
that is used with all 3D tools.

The working plane can change temporarily to facilitate editing operations when the 3D SmartCursor 
snaps to points that are not in the current working plane. 

The working plane is set by clicking on any face of a rendered object or by snapping to any three points 
in wireframe mode with the Set Working Plane tool.

To select a working plane by selecting three points:

1. Select the Set Working Plane tool from the 3D Tool palette.

2. Snap to first the point, press the mouse button and hold down (this becomes the working plane 
origin).

3. Move the mouse to next point and release. (This vector is the x axis of the working plane.)

4. Snap to the last point and click.

The working plane is set to the plane that intersects the three points you've specified. Remember 
that the working plane can be set only by snapping to points on an object. If the mouse is clicked 
when the selection pointer is not located over a snap point, the working plane is set to its default 
state and aligns with the ground plane.

For related information, see the following topics:
Move Working Plane

Working Plane Palette



    Insert 3D Symbol
The Insert 3D Symbol tool on the 3D Tool palette is used to insert symbols in 3D orthogonal 
projections. 

Symbols are selected from the Resource Palette. You can open the Resource Palette by selecting the 
Resources command on the Window menu, or by    double-clicking the Insert 3D Symbol tool.

Note:    The selected symbol becomes the default symbol,. It will remain so until a new symbol is 
selected.

To place a symbol in a 3D orthogonal view:

1. Select the Insert 3D Symbol tool. 

2. Position the mouse pointer at the symbol's insertion point.

3. Click the mouse.

The selected symbol is inserted.

The symbol appears with its origin at the insertion point and is aligned such that the coordinate axes of 
the symbol align with the current working-plane axes. If the mouse is dragged after inserting the symbol, 
it is rotated about the vertex through its origin, which is normal to the current working plane.

3D symbols that do not have a 2D component, are visible in the 2D/Plan view. The symbols appear the 
same as in 3D Top view.



    Translate View
The Translate View tool on the 3D Tool palette moves the 3D projection around the page. (Translate is 
a mathematical term for changing a coordinate system's origin, or zero point. In effect, this moves 
objects through 3D space without rotating them or changing their shape.)

Note:    This tool lies beneath the Walkthrough tool on the 3D Tool palette. To access Translate View, 
press and hold the Walkthrough icon. When the pop-out icons appear, release the mouse over the 
Translate View tool. 

The Translate View tool can move the viewpoint up, down, left, right, in or out. It uses the current-view 
orientation as a reference for translation axes. This means the viewpoint changes relative to the viewer's 
current position in space. 

When the Translate View tool is selected, the translate icons appear in the mode bar. These buttons 
allow movement in steps along the axis perpendicular to the screen. 

The Translate View tool also allows perspective to be altered if it is used with the Shift key pressed. 
Drag the mouse to the right to decrease perspective. Drag to the left to increase it.

In Translate View mode, the mouse is used to move the view point.

· Vertical mouse movements move the viewpoint up or down with respect to the current direction 
of view. This, in effect, moves the 3D projection down and up on the page.

· Horizontal mouse movements move the viewpoint left or right with respect to the current 
direction of view. This, in effect, moves the 3D projection right and left on the page.

If the Control key is pressed while the mouse is moved, the viewpoint can be modified in ways that are 
useful in a perspective projection:

· Control Key + Vertical mouse movements move the viewpoint in and out along the direction of 
view. This movement is only useful in perspective projection.

    

You can also use the In and Out buttons on the mode bar instead of the mouse. These buttons 
let you move in and out in step-like fashion. Each click of the button results in a single step in the 
requested direction.

· Control Key + Horizontal mouse movements change the amount of perspective, or the "focal 
length" of the perspective. Moving the mouse right increases the focal length (telephoto). Moving 
it left decreases the focal length (fisheye). This movement is only useful in perspective projection.

For related information, see the following topics:
Rotate 3D View

Rotate View

Walkthrough

Flyover

Rotate



    Walkthrough
The Walkthrough tool on the 3D Tool palette is used to visualize an architectural model. Movement and 
rotation is centered around the viewer, giving one the sense of walking or driving in the 3D world. 

The Walkthrough tool is used in the perspective projection. If this projection is not active when the tool 
is selected, you will be prompted to switch to this mode.

In Walkthrough mode, movements forward, backward, left and right are performed using the mouse. 
(Movement is always constrained to the plane parallel to the ground plane.)

· When the mouse is in the center of the screen, no movement occurs.

· When the mouse is above the horizontal center of the screen, you move forward.

· When the mouse is below the horizontal center of the screen, you move backward.

· When the mouse is on the left of the vertical center of the screen, you turn left.

· When the mouse in on the right of the vertical center of the screen, you turn right.

The Shift key can be used in conjunction with the mouse to move up and down, or look up and down.

· When the Shift key is pressed while the mouse is above the horizontal center of the screen, you 
move up (perpendicular to the ground plane).

· When the Shift key is pressed while the mouse is below the horizontal center of the screen, you 
move down (perpendicular to the ground plane).

· When the Shift key is pressed while the mouse is on the left of the vertical center of the screen, 
you look up.

· When the Shift key is pressed while the mouse is on the right of the vertical center of the screen, 
you look down.

    

You can also perform these actions in incremental movements using the buttons on the mode bar.

The Reset button on the mode bar resets the orientation so that you are level and facing the front of the 
model. This is useful when a walkthrough begins. You can also set the starting point for a walkthrough 
with the Set 3D View command.

For related information, see the following topics:
Flyover

Rotate 3D View

Translate View

Rotate View

Rotate



    Zoom In
Key Equiv = C

The Zoom In tool on the 2D Tool and 3D Tool palettes magnifies the view of the drawing. Each double-
click of the Zoom In tool doubles the magnification. (Selected objects are centered in the magnified 
view.)

The magnification level is displayed in the mode bar. A value of 100% represents the drawing's normal 
scale (the scale at which the drawing is printed), a value of 200% represents twice the normal scale, and 
so forth.

Note:    The Zoom In tool does not affect the physical size (scale) of the drawing. It merely magnifies 
your view of it. To change the drawing's scale, you must use the Scale command. 

The Zoom In tool can also be used to magnify a specific section of a drawing. 

To magnify a section of the drawing:

1. Select the Zoom Tool.

2. Drag a marquee around the area to be examined.

3. Release the mouse.

The area within the marquee is magnified to fill the screen

tip!    There are many built-in shortcut keys to zoom the display to different levels. See the Zoom 
Keyboard commands for a complete list.

For related information, see the following topics:
Fit to Window

Fit to Objects

Normal Scale



    Zoom Out
Key Equiv = V

The Zoom Out tool on the on the 2D Tool and 3D Tool palettes reduces the view of the drawing. Each 
double-click on the Zoom Out tool reduces the view by half. 

The magnification level is displayed in the mode bar. A value of 100% represents the drawing's normal 
scale (the scale at which the drawing is printed), a value of 50% represents half the normal scale, and so 
forth.

There are many built-in shortcut keys to zoom the display to different levels. See the Zoom Keyboard 
commands for a complete list.

Note:      The Zoom Out tool does not affect the physical size (scale) of the drawing. It merely reduces 
your view of it. To change the drawing's scale, you must use the Scale command. 

For related information, see the following topics:
Fit to Window

Fit to Objects

Normal Scale



Zoom Keyboard commands

Additional zoom operations are available through the keyboard and the command menu.

Key Combination Description

Cntrl-1 Enlarges the drawing by a factor of 2

Cntrl-Shift Enlarges the drawing by a factor of 4

Cntrl-2 Reduces the drawing by half

Cntrl-Shift-2 Reduces the size of the drawing to 25% 
of its normal size

Cntrl-4 Fits the page into the screen (same as 
the Fit to Window command)

Cntrl-3 Displays the drawing at normal scale 
(same as the Normal Scale command)

Constraint Palette

The Constraint palette is used to position the cursor at a specific point when drawing, moving or 
reshaping objects (i.e., snapping an object to a position). It is also used to limit a tool to a specific angle, 
shape or position (e.g., constraining the Rectangle tool to produce only squares).

The Constraint palette is opened using the Constraints command on the Window menu. It is closed by 
clicking the Close box in the corner of the palette.

The Constraint palette automatically shows 2D constraints when a 2D drawing tool is selected and 3D 
constraints when a 3D tool is selected. 

Icons on the palette can be selected by clicking them with the mouse or by typing their key equivalent. A 
constraint can be selected before you draw an object or while you are drawing the object. 

Tool Description

The Snap to Grid (2D) tool causes the cursor to align 
on the snap grid.

The Snap to Grid (3D) tool constrains objects on the 
working plane.

The Snap to Object (2D) tool causes objects to align 
on an object's "snap points."

The Snap to object (3D) tool makes the snap points 
at 3D vertices active.

The Snap To Surface tool causes the cursor to snap 
to the surface (side) of an object.



The Constrain to the Working Plane tool projects 
any point outside the working plane to the working 
plane.

The Snap to Intersection tool causes the cursor to 
snap to the intersection of objects.

The Snap to Distance (2D) tool snaps the cursor at a 
specified distance from a vector.

The Snap to Distance (3D) tool lets you to snap to a 
specified distance from either end of any 3D vector.

The Constrain Parallel tool lets you produce parallel 
or concentric objects.

The Constrain Perpendicular tool allows a vector to 
be drawn perpendicular to or from an object.

 The Constrain Angle (2D) tool constrains vectors to 
30°, 45° and 90°.

The Constrain Angle (3D) tool constrains angles to 
30°, 45° and 90° in current working plane space

The Constrain Symmetrical (2D) tool restricts 
objects to a height:width ratio of one (1:1)

The Constrain Symmetrical (3D) tool is used to 
constrain all 3D drawing to the working plane.

The Constrain Tangent tool constrains lines to be 
tangent to or from arcs, ovals, and circles.

The Constrain Perpendicular (3D) tool is used to 
snap objects perpendicular to the working plane. 

    Snap to Grid (2D)
This constraint causes the cursor to align on the snap grid when objects are drawn, moved or reshaped. 
The snap grid is defined using the Set Grid command.



    Snap to Object (2D)
This constraint causes objects to align on an object's "snap points." Every object has snap points. On a 
line they are its end points. In a rectangle, they are its center and its corners. In a polygon, they are the 
vertices. 

Note:     Grouped objects retain their constituent object's snap points.

If the Preferences command has been used to turn on screen hints, a label will appear at the snap 
points, and a dotted line will connect the point to your cursor arrow.



    Snap To Surface
This constraint causes the cursor to snap to the surface (side) of an object. 

When this constraint is selected, a "snap dot" will appear next to the cursor when it is within three pixels 
of an object's surface. This dot signals that clicking or releasing the mouse will snap the object to that 
point.

You can designate a specific object to be the only one affected by this constraint, by double-clicking the 
Snap to Surface icon, or by typing the S key twice in rapid succession. Then, when the Finger Tip 
cursor is on the desired object, click the mouse. The selected object will be the only object subject to the 
Snap to Surface constraint. 

To deactivate the constraint on this object, deselect the Snap to Surface icon.



    Snap to Intersection
This constraint causes the cursor to snap to the intersection of objects.

If the Preferences command has been used to turn on screen hints, a circle labeled "Intersect" will 
appear at the intersection, and a dotted line will connect the circle to your cursor.



    Snap to Distance
This constraint allows you to snap the cursor at a specified distance from either end of a vector in the 
drawing.

To set the snapping distance, select the object and double-click the Snap to Distance icon. In the Snap 
Distance dialog box, set the distance in terms of a fraction, percent or distance. 

When you move the cursor along a vector, it snaps it to the nearest Snap To Distance point. If the 
Preferences command has been used to turn on screen hints, the description "Along Line" appears 
when the cursor is in snap position.



    Constrain Parallel
This constraint restricts a drawing tool to producing parallel or concentric objects. If the constrain parallel 
icon is dim, it means that a parallel object cannot be created with the selected drawing tool.

To use this constraint:

1. Select the Constrain Parallel icon.

2. Click and draw toward the line the new line is to be parallel with. When the cursor is within three 
pixels, the new line positions itself parallel to the existing line.

3. Click on the line to be parallel to the new line. While drawing the new parallel object, the cursor 
can be moved to either side of the line.

You can designate a specific object to be the only one affected by this constraint, by double-clicking the 
Constrain Parallel icon, or by typing the E key twice in rapid succession. Then, when the Finger Tip 
cursor is on the desired object, click the mouse. The selected object will be the only object subject to the 
parallel constraint. 

When the line tool is selected, the Tab key can be used to enter the Offset field in the Data Display bar.

When objects are created parallel to lines or other objects, they retain the height-to-width ratio of the 
objects they are drawn parallel to. This allows concentric objects can be drawn with the parallel 
constraints.



    Constrain Perpendicular
The Constrain Perpendicular tool allows a vector to be drawn perpendicular to or from an object. This 
constraint can be used with the following drawing tools:

Tool Constrain Perpendicular Effect 

Single Line or Double Line Can be used to constrain the line 
to any Line, Rectangle, Wall or 
Polygon 

Full Arc or Quarter Arc Can be used to constrain the 
radius to any Line, Rectangle, Wall 
or Polygon

Polyline Can be used to constrain a 
polyline segment to any Line, 
Rectangle, Wall or Polygon 

Wall Can be used to constrain the wall 
to any Line, Rectangle, Wall or 
Polygon

Polygon Can be used to constrain a 
polygon segment to any Line, 
Rectangle, Wall or Polygon 

You can designate a specific object to be the only one affected by this constraint, by double-clicking the 
Constrain Perpendicular icon or typing the F key twice in rapid succession. Then, when the Finger Tip 
cursor is on the desired object, click the mouse. The selected object will be the only object subject to the 
perpendicular constraint. 



    Constrain Angle (2D)
The Constrain Angle tool will constrain vectors to 30°, 45°, 90° and their complements. 

An additional constraint angle can be set with the Preferences command on the File menu.



    Constrain Symmetrical (2D)
The Constrain Symmetrical constraint restricts objects to a height:width ratio of one (1:1). 

This constraint can be used with the following drawing tools:

Tool Constrain Symmetrical Effect

Rectangle tool Creates squares

Rounded Rectangle tool Creates rounded squares

Ovals tool Creates circles 

Quarter Arc tool Creates quarter circles

    Constrain Tangent
The Constrain Tangent tool constrains lines to be tangent to or from arcs, ovals, and circles. It also 
allows a tangent-to-tangent constraint between two circles.

· When drawing to an arc, oval, or circle, the line snaps tangent to it.

· When drawing from an arc, oval, or circle, the line floats around the surface until the end point of 
the line is set. Pressing the Control key flips the tangent line to the opposite side of the oval or 
circle.

You can designate a specific object to be the only one affected by this constraint, by double-clicking the 
Constrain Tangent icon, or by typing the T key twice in rapid succession. When the Finger Tip cursor is 
on the desired object, click the mouse. The selected object will be the only object subject to the tangent 
constraint. 



    Snap to Grid (3D)
The Snap to Grid constraint on the 3D Constraint palette constrains objects on the working plane. 
When the working plane also is the ground plane, the Snap to Grid constraint works as it does in 2D. 
However, if the working plane is set to some other plane, then the snapping is based on the working 
plane origin and orientation. 

The snap grid is defined using the Set Grid command.



    Snap to object (3D)
The Snap to Object constraint on the 3D Constraint palette makes all snap points at vertices of 3D 
objects active in 3D space for both snapping and alignment with the 3D SmartCursor. 

It is possible to snap to objects between layers when three conditions are met:

· The Layer Options command is set to Show Snap Others or Show/Snap/Modify Others.

· The layers have been set to normal (visible) with the Layers command.

· The layers are in the same scale, projection, and view.

The 3D cursor location is normally at the intersection of the mouse vector and the working plane. All 
points specified in 3D are on the working plane unless the cursor is over a 3D snap point, and the Snap 
to Object constraint is selected. 

If screen hints are on, the type of snap point is shown and visual clues are given as to where the point is 
in relation to the current working plane. A dashed line is displayed perpendicular to the working plane 
which passes through the snap point and intersects the crosshairs on the working plane.



    Constrain to the Working Plane
This constraint projects any point outside the working plane to that point on the working plane directly 
beneath the original. 

When using this constraint, if a point is snapped outside the current working plane, the point specified is 
that point on the working plane that is the shadow of the original.



     Constrain Symmetrical (3D)

The Constrain Symmetrical tool on the 3D Constraint palette is used to constrain all 3D drawing to the 
working plane.



    Snap to Distance (3D)
The Snap to Distance tool in the 3D Constraint palette allows you to snap to a specified distance from 
either end of any 3D vector in the drawing. To set the snapping distance, double-click the Snap to 
Distance tool and specify the distance in the Snap Distance dialog box. 



    Constrain Angle (3D)
The Constrain Angle tool on the 3D Constraint palette works in current working plane space. Angles 
are constrained to 90°, 60°, 45°, or 30°. An additional constraint can be specified with the Preferences 
command.



    Constrain Perpendicular (3D)
The Constrain Perpendicular tool on the 3D Constraint palette is used to snap objects perpendicular 
to the working plane. 



Standard Dimension Palette

The tools on the Standard Dimension palette are used to measure linear and angular dimensions. 
Some tools produce measurement lines and place them in the drawing. Others (e.g., the Tape Measure 
and the Protractor) simply report a dimension, but do not create an object.

The Standard Dimensions palette is opened using the Tools command on the Window menu. It is 
closed by clicking the Close box in the corner of the palette. It contains the following tools:

Tool Description

The Diagonal Dimension tool is used to measure and 
mark linear dimensions of any angle.

The Constrained Linear Dimension tool is used to 
measure and mark vertical and horizontal linear 
dimensions that are constrained to the horizontal and 
vertical axes.

The Circular Dimension tool is used to measure and 
mark the diameter or radius of an arc or circle. 

The Center Mark tool is used to place a center mark in 
a circle, ellipse, rectangle or rounded rectangle.

The Angular Dimension tool is used to measure and 
mark an angle. 

The Tape Measure tool is used to measure the 
distance between points on the drawing. 

The Protractor tool is used to measure the angle 
between points on the drawing.

    Diagonal Dimension
The Diagonal Dimension tool on the Standard Dimension palette is used to measure and mark linear 
dimensions of any angle. 

When the Diagonal Dimension tool is selected, the diagonal icons are displayed in the mode bar. 
These icons are used to select the type of dimensioning operation you want to perform. 

For additional information, see the following topics:
Unconstrained Linear Dimension

Unconstrained Chain Dimension

Unconstrained Baseline Dimension



    Unconstrained Linear Dimension
The Unconstrained Linear Dimension mode measures and marks the distance between any two 
points in the drawing.

To create an unconstrained linear dimension:

1. Select the Diagonal Dimension tool from the Standard Dimension palette.

2. Select the Unconstrained Linear icon in the mode bar.

3. Position the cursor at the beginning of the line.

4. Press and hold the mouse button. 

5. Drag the cursor to the end point of the line.

6. Release the mouse. 

The dimension outline appears.

7. Move the cursor to where you want the dimension line placed.

8. Click the mouse to set the line in the drawing.



    Unconstrained Chain Dimension
The Unconstrained Chain Dimension mode measures and marks the distance between multiple points 
on the same line.

To create an unconstrained chain dimension:

1. Select the Diagonal Dimension tool from the Standard Dimension palette.

2. Select the Unconstrained Chain icon in the mode bar.

3. Position the cursor at the first point on the line.

4. Press and hold the mouse button. 

5. Drag the cursor to the end of the first segment in the chain.

Note:    the position of this segment establishes the angle for the entire chain.

6. Release the mouse button.

7. Move the cursor to where you want the dimension line drawn.

8. Click the mouse.

The cursor changes to a bull's-eye.

9. Move the cursor to the endpoint of the next segment.

10. Click the mouse.

11. Repeat steps 9 and 10 for each segment in the chain. When you reach the last point, double-click 
the mouse or press Esc to end the operation.



    Unconstrained Baseline Dimension
The Unconstrained Baseline mode measures the distance between a point (or set of points) and a 
fixed baseline drawn at any angle.

To create an Unconstrained Baseline dimension:

1. Select the Diagonal Dimension tool from the Standard Dimension palette.

2. Select the Unconstrained Baseline icon in the mode bar.

3. Position the cursor at the start point of the first length you want to measure. 

4. Press and hold the mouse button. 

5. Drag the cursor to the end of the first length you want to measure.

Note:      the position of this line establishes the angle for the rest of the measurement.

6. Release the mouse button.

7. Move the cursor to the offset position at which you want this first dimension line to appear.

8. Click the mouse. The cursor changes to a bull's-eye.

9. Move the cursor to the endpoint of the next length to be measured.

10. Click the mouse. 

11. Repeat steps 9 and 10 for each length to be measured. When you reach the last point, double-
click the mouse or press Esc to end the operation.



    Constrained Linear Dimension
The Constrained Linear Dimension tool on the Standard Dimension palette is used to measure and 
mark vertical and horizontal linear dimensions. As its name implies, measurements are always taken on 
(i.e., constrained to) the horizontal or vertical axes.

When the Constrained Linear Dimension tool is selected, the linear icons are displayed in the mode 
bar. These icons are used to select the type of dimensioning operation you want to perform. 

For additional information, see the following topics:
Constrained Linear Dimension

Constrained Chain Dimension

Constrained Baseline Dimension

Ordinate Dimension

Auto dimension selected objects mode



    Constrained Linear Dimension
The Constrained Linear mode measures the distance between any two points on the drawing. 

To create a Linear dimension:

1. Select the Constrained Linear Dimension tool from the Standard Dimension palette.

2. Select the Constrained Linear icon in the mode bar.

3. Position the cursor at the start point of the length you want to measure. 

4. Press and hold the mouse button. 

5. Drag the cursor to the end point of the dimension.

6. Release the mouse button.

7. Move the cursor to the offset position at which you want the dimension line to appear.

8. Click the mouse.

The dimension line is drawn and labeled.



    Constrained Chain Dimension 
The Constrained Chain mode measures the distance between multiple points on a line. 

To create a Chained dimension:

1. Select the Constrained Linear Dimension tool from the Standard Dimension palette.

2. Select the Constrained Chain icon in the mode bar.

3. Position the cursor at the start point of the line. 

4. Press and hold the mouse button. 

5. Drag the cursor to the end of the first segment in the chain.

6. Release the mouse button.

7. Move the cursor to the offset position at which you want the dimension line to appear.

8. Click the mouse.

9. Move the cursor to the endpoint of the next segment.

10. Click the mouse.

11. Repeat steps 9 and 10 for each segment in the chain. When you reach the last point, double-click 
the mouse or press Esc to end the operation.



    Constrained Baseline Dimension
The Constrained Baseline mode measures the distance between a point (or set of points) and a fixed 
vertical or horizontal baseline.

To create a Baseline dimension:

1. Select the Constrained Linear Dimension tool from the Standard Dimension palette.

2. Select the Constrained Baseline icon in the mode bar.

3. Position the cursor at the start point of the first length you want to measure. This point establishes 
the baseline from which all subsequent points are measured.

4. Press and hold the mouse button. 

5. Drag the cursor to the end of the first length you want to measure.

6. Release the mouse button.

7. Move the cursor to the offset position at which you want the first dimension line to appear.

8. Click the mouse. The cursor changes to a bull's-eye.

9. Move the cursor to the endpoint of the next length to be measured.

10. Click the mouse. 

11. Repeat steps 9 and 10 for each length to be measured. When you reach the last point, double-
click the mouse or press Esc to end the operation.



    Ordinate Dimension
The Ordinate Dimension mode is similar to Constrained Baseline mode in that it measures the 
distance between a point (or set of points) and a fixed baseline. However, Ordinate Dimension mode, 
rather than labeling each interval with an individual dimension line, labels the intervals along a fixed, 
offset line.

To create a Ordinate dimension:

1. Select the Constrained Linear Dimension tool from the Standard Dimension palette.

2. Select the Ordinate Dimension icon in the mode bar.

3. Position your cursor on the baseline, placing it where you want the measurement labels to 
appear. This point establishes the baseline from which all subsequent points are measured. 

4. Move the cursor to the second point.

5. Click the mouse.

6. Repeat the two steps above for each point to be measured. When you reach the last point, 
double-click the mouse or press Esc to end the operation.



    Auto dimension selected objects mode
The Auto Dimension mode measures and marks the horizontal and vertical dimensions of a selected 
object (or objects). If multiple objects are selected, the total measurement from end to end of the multiple 
selection is given.

To Auto Dimension an object or group of objects:

1. Select the object, or group of objects, you want to measure.

2. Select the Constrained Linear Dimension tool from the Standard Dimension palette.

3. Select the Auto Dimension icon in the mode bar.

4. Press and hold the mouse button. 

5. Move the cursor to where you want the dimension line drawn.

6. Release the mouse.

The dimension line is placed in the drawing.

Note:    When clicking inside the object to be dimensioned, the tool returns horizontal dimensions by 
default. Press the Control key to place a vertical dimension inside a selected object.

When clicking outside the object to be dimensioned, the type of dimension is determined by where the 
mouse is clicked.



    Circular Dimension
The Circular Dimension tool on the Standard Dimension palette is used to measure and mark the 
diameter or radius of an arc or circle. 

When the Circular Dimension tool is selected, the circular icons are displayed in the mode bar. These 
icons are used to select the type of dimensioning operation you want to perform. 

The Leader icons are used by all four circular dimensioning modes. They specify the position of the 
leader line relative to the measurement label (i.e., whether the line is placed to the left or right of the 
text).

For additional information, see the following topics:
Interior Diametrical Dimension

Exterior Diametrical Dimension

Interior Radial Dimension

Exterior Radial Dimension



    Interior Diametrical Dimension
The Interior Diametrical mode is used to draw an interior line representing the diameter of a circle or 
arc.

To create an Interior Diametrical dimension:

1. Select the Circular Dimension tool from the Standard Dimension palette.

2. Click the Left Leader or Right Leader icon, depending upon which side of the label you want the 
leader line to stem from.

3. Select the Interior Diametrical icon in the mode bar.

4. Position the cursor inside the arc or circle.

5. Press the mouse button and while holding it down, drag the mouse toward the opposite side of 
the arc or circle. 

· If you want the measurement to appear inside the circle or arc, release the mouse button on 
the opposite side of the circle. 

· If you want the measurement to appear outside the circle or arc, drag the mouse outside of 
the arc or circle before releasing the mouse button.



    Exterior Diametrical Dimension
The Exterior Diametrical mode is used to mark a circle or arc's diameter on the outside of the object.

To create an Exterior Diametrical dimension:

1. Select the Circular Dimension tool from the Standard Dimension palette.

2. Click the Left Leader or Right Leader icon, depending upon which side of the label you want the 
leader line to stem from.

3. Select the Exterior Diametrical icon in the mode bar.

4. Position the cursor inside the arc or circle.

5. Press the mouse button and drag the cursor to the point where you want the diameter to appear.

6. Release the mouse button.



    Interior Radial Dimension
The Interior Radial mode is used to draw an interior line representing the radius of a circle or arc.

To create an Interior Radial dimension:

1. Select the Circular Dimension tool from the Standard Dimension palette.

2. Click the Left Leader or Right Leader icon, depending upon which side of the label you want the 
leader line to stem from.

3. Select the Interior Radial icon in the mode bar.

4. Position the cursor inside the arc or circle.

5. Press the mouse button and while holding it down, drag the mouse toward the opposite side of 
the arc or circle. 

· If you want the measurement to appear inside the circle or arc, release the mouse button on 
the opposite side of the object. 

· If you want the measurement to appear outside the circle or arc, drag the mouse outside of 
the arc or circle before releasing the mouse button.



    Exterior Radial Dimension
The Exterior Radial mode is used to mark a circle or arc's radius on the outside of the object.

To create an Exterior Radial dimension:

1. Select the Circular Dimension tool from the Standard Dimension palette.

2. Click the Left Leader or Right Leader icon, depending upon which side of the label you want the 
leader line to stem from.

3. Select the Exterior Radial icon in the mode bar.

4. Position the cursor inside the arc or circle.

5. Press the mouse button and drag the cursor to the point where you want the radius to appear.

6. Release the mouse button.



    Center Mark
The Center Mark tool on the Standard Dimension palette is used to place a center mark in a circle, 
ellipse, rectangle or rounded rectangle.

Note:    This tool lies beneath the Circular Dimension tool on the Standard Dimension palette. To 
access the Center Mark tool, press and hold the Circular Dimension icon. When the pop-out icons 
appear, release the mouse over the Center Mark tool. 

To create a center mark in a circle, ellipse, rectangle or rounded rectangle:

1. Select the Center Mark tool from the Standard Dimension palette.

2. Click the object you want to mark. 

The center mark appears.

To create a center mark in the corner of a rounded rectangle:

1. Select the Center Mark tool from the Standard Dimension palette.

2. Press the Control key and click the corner of the rectangle you want to mark. 



    Angular Dimension
The Angular Dimension tool on the Standard Dimension palette is used to measure and mark an 
angle. 

When the Angular Dimension tool is selected, the angular icons are displayed in the mode bar. These 
icons are used to select the method you want to use to specify the angle. 

For additional information, see the following topics:
Angular Dimension

Reference Dimension



    Angular Dimension
The Angular Dimension mode is used to specify an angle from surface to surface. 

To mark an angle in Angular mode

1. Select the Angular Dimension tool from the Standard Dimension palette.

2. Click the Angular icon in the mode bar.

3. Position the cursor over the first line (or surface) to be dimensioned.

4. Press and hold the mouse button down. 

5. Drag the mouse to the other line (or surface). 

6. When the cursor is positioned correctly, release the mouse. 

An outline of the dimension appears. 

7. Move the mouse to position the dimension inside or outside the angle as needed.

8. Click the mouse to set the dimension.



    Reference Dimension 
The Reference Dimension mode is used to specify an angle between a reference line and a surface. 

To mark an angle in Reference Dimension mode

1. Select the Angular Dimension tool from the Standard Dimension palette.

2. Click the Reference Dimension icon in the mode bar.

3. Draw a reference line. This line may be drawn at any angle. 

4. Place the fingertip cursor on the surface forming the opposite side of the angle.

An outline of the dimension appears. 

5. Move the mouse to position the dimension inside or outside the angle as needed.

6. Click the mouse to set the dimension.



    Tape Measure
The Tape Measure tool on the Standard Dimension palette is used to measure the distance between 
points on the drawing. This tool reports a linear measurement but does not place it in the drawing.

Multiple, consecutive, line segments can also be measured with this tool. When multiple segments are 
drawn, the length of the active segment and the length of the total line are reported in the Data Display 
bar. 

To measure between two points:

1. Select the Tape Measure tool from the Standard Dimension palette.

2. Position the cursor at the first point on the line.

3. Drag the cursor to the second point and release the mouse.

The length of the line segment is shown in the L field of the Data Display bar. The length of the 
total line is shown in the TL field.

4. If you want to add another segment to the line, move the mouse and click at the segment's end 
point. 

5. When you are finished, double-click the mouse.

The tape measure disappears.



    Protractor
The Protractor tool on the Standard Dimension palette is used to measure the angle between points 
on the drawing. This tool reports the angle measurement, but does not place it in the drawing.

When the Protractor tool is selected, the protractor icons appear in the mode bar. They let you measure 
the angle in one of two ways.

For additional information, see the following topics:
Two Lines Mode

Three Points Mode



    Two Lines Mode
The Two Lines mode is used to measure the angle between two objects.

To use Two Line mode:

1. Select the Protractor tool from the 2D Tool palette.

2. Select the Two Lines Mode icon in the mode bar.

3. Place the cursor on one of the objects to be measured.

4. Drag the cursor to the second object. 

The angle is reported in the Data Display bar. It will be displayed until you release the mouse 
button.



    Three Points Mode
The Two Lines mode is used to measure the angle between two lines that you draw.

To use Three Points mode:

1. Select the Protractor tool from the 2D Tool palette.

2. Select the Three Points Mode icon in the mode bar.

3. Position the mouse at the start point and click. 

4. Move the mouse to the end of the first line and click.

5. Move the mouse to form the second line.

The angle is reported in the Data Display bar.

6. Click to end the operation. 



Attribute Palette

The Attribute palette is used to control the line and color attributes of a graphic object.

The Attribute palette is opened using the Attributes  command on the Window menu. It is closed by 
clicking the Close box in the corner of the palette.

When an object is selected, the Attribute palette displays the attributes of the object. To change the 
object's attributes, simply change the attribute in the palette. Multiple objects can be selected and 
changed in this way too (when multiple objects are selected, the palette displays the attributes of the first 
object selected).

To change default attributes, change the Attribute palette while nothing is selected Default attributes are 
the ones automatically assigned to all new objects you create.

For additional information, see the following topics:
Fill Foreground & Background Color

Pen Foreground & Background Color

Patterns

Line Style & Weight

Marker Style



Fill Foreground & Background Color

The two Fill swatches on the Attribute Palette are used to specify the colors used to fill an object. The 
top swatch specifies the fill pattern's foreground color and the rear swatch specifies the fill pattern's 
background color. 

Generally, when a solid fill is used, the background swatch is the one that specifies the color.

To change a fill color, click the swatch you want to change, then, in the 256-color pop-out palette, select 
a new color.

Note:     The content of the color palette can be changed using the Edit Attributes command.



Pen Foreground & Background Color

The two Pen swatches on the Attribute Palette are used to specify the colors assigned to the pen's 
pattern. The pen produces the outline of an object. 

The top swatch specifies the pen's foreground color and the rear swatch specifies the pen's background 
color. 

Generally, when a solid pen pattern is used, the foreground swatch specifies the color of the pen.

To change a pen color, click the swatch you want to change, then, in the 256-color pop-out palette, select 
a new color.

Note:     The content of    the color palette can be changed using the Edit Attributes command.



Patterns

The Pattern segment of the Attribute Palette is used to select the pattern that will be used for the pen 
and for the fill. 

Note:     Both the pen and fill patterns can be set to "no pattern," making them invisible.

The outside box in this segment represents the pen's pattern. To change the pen's pattern, click the ring, 
and in the pop-up menu, select a new pattern.

The center box in this segment represents the fill pattern. To change this pattern, click the box, and 
select a new pattern from the pop-up menu that is opened.

Note:     The content of    the pattern pop-up menu can be changed using the Edit Attributes command.



Line Style & Weight

The Line Style segment of the Attribute palette is used to specify a line's thickness and its dash 
pattern.

To change a line's attributes, click the Line Style segment in the Attribute Palette. 

In the top section of the menu, specify the line's thickness. If you want to use a thickness that is not 
listed on the menu, select the Set Thickness option at the top of the menu, and specify a custom 
thickness.

If you want the line's dimensions to be displayed with the line, select the -- xx -- option in the middle of 
the menu.

In the bottom section of the menu, select the line's dash pattern. 

Note:     The content of    the line thickness and dash pattern portions of the pop-up menu can be 
changed using the Edit Attributes command.

For related information, see the following topics:
Marker Style



Marker Style

The objects at the bottom of the Attribute palette are used to assign line markers to a line (often 
arrowheads). 

The large button in the lower-right corner is used to select which style of marker is used. To change the 
marker style, click this button. In the marker style menu, select a new style. If the style you want to use 
isn't listed, select the Edit option to create a new one (or use the Edit Attributes command).

The two small buttons in the lower left corner are used to assign line markers to a line. When enabled, 
the left button assigns a marker to the beginning of the line, and the right button, the end (if a line is to be 
drawn without line markers, these two buttons should be disabled).

For related information, see the following topics:
Line Style & Weight



Working Plane Palette

 The Working Plane palette is used to select and save a working plane. (See An Overview of Working 
Planes for additional information on working palettes).

The Working Plane palette is opened using the Working Planes  command on the Window menu. It is 
closed by clicking the Close box in the corner of the palette. It can be moved to any position on the 
screen by dragging its title bar.

A working plane is activated by selecting it from the Saved Working Planes list, or by activating one of 
the current, unnamed planes using the Current Working Plane buttons. 

The Working Plane palette contains the following controls

Saved Working Planes

The Saved Working Planes list displays the names of all saved working planes. To activate one of 
these planes, double-click its name in the list.

Current Working Plane

The Current Working Plane buttons are used to toggle among the current working planes. The ten most 
recently created working planes are maintained in an unnamed list. To activate one of these working 
planes, click the left or right arrow to cycle through the list of current working planes.

Add
The Add button is used to permanently save the active working plane. When you click Add, the Assign 
Name dialog box is opened. Enter a unique name for the working plane and click OK. The name will be 
added to the Saved Working Planes list at the top of the Working Planes palette, and can be activated 
at any time by double-clicking it.

Delete
The Delete button is used to remove a saved working plane. To delete a working plane, highlight its 
name in the Saved Working Planes list at the top of the palette and click Delete.

Note:    The Ground Plane cannot be deleted or renamed.



Rename
The Rename button is used to assign another name to a saved working plane. To rename a working 
plane, highlight its name in the Saved Working Planes list at the top of the palette and click Rename. 
Enter a new, unique name in the dialog box and click OK.

Note:    The Ground Plane cannot be deleted or renamed.

The Top View button is used to place the drawing in top view.

The i, j, k button is used to place the display in i, j, k mode.

The x, y, z button is used to place the display in x, y, z mode.



An Overview of Working Planes

In MiniCad, all objects are created on the working plane which, by default, is also the ground plane. 
However, the working plane can be changed so that you can create 3D objects in place, rather than 
having to create them on the ground plane, and rotate them into position afterwards. 

On a color monitor, MiniCad displays the ground plane in light blue and the working plane in pink. The x 
and y axes of the working planes are defined by small dots or handles, at the edge of the plane. The 
center of the working plane also is represented with a handle. If the Show 3D Axis Labels preference is 
active, the two axes are shown with their respective labels.

The working plane's position can be changed with the Set Working Plane tool or by moving one of its 
handles. A working plane's angle can be changed by dragging one of its handles or by entering a value 
in the plane's Angle field on the Data Display bar.

When the cursor is placed directly over one of the working plane handles, the SmartCursor shows you 
the axis that is affected by the movement of that handle. Additionally, a small marker indicates what 
movement is possible with that handle. 

When you drag the plane to a 30°, 45°, 60°, or 90° angle, the cursor's dotted line becomes a solid line 
and, if the Use Sound preferences is set, you will hear a click.

MiniCad automatically maintains a list of the last ten working planes (more than enough for most 
drawings). These working planes are recorded in the order in which they were created. They can be 
accessed using the Current Working Plane buttons on the Working Plane Palette. When the eleventh 
working plane is created, the first plane on the list is purged.

A plane can be permanently saved using the Add button on the Working Plane palette. Saved planes 
are listed at the top of the Working Plane palette, and can be activated by double-clicking its name in 
the list.



Object Info Palette

The Object Info palette is used to inspect or change an object's size, shape or position. It is also used to 
inspect or change information relating to an object's database record.

This palette has two panes:

The Shape pane contains an object's size shape and position information. It will also report the area and 
perimeter of a closed shape.

The Data pane contains an object's database information.

You can switch between panes by clicking the tabs at the bottom of the palette.

The Object Info palette is opened using the Object Info command on the Window menu. It is closed by 
clicking the Close box in the corner of the palette. It can be moved to any position on the screen by 
dragging its title bar

For additional information, see the following topics:
The Shape Pane

The Data Pane



The Shape Pane

The Shape pane on the Object Info Palette is used to inspect or change the size, shape or position of 
a selected object(s). It can also be used to change the layer on which an object is placed, and the class 
to which it is assigned.

The specific contents of the Shape pane varies depending upon the type of object you have selected 
(e.g., when an Arc is selected, this palette will contain a Sweep field, when a polyline is selected it will 
contain a Vertex list, and so forth). However, it always has the following basic controls.

Note:     When a group is selected, only its bounding box and position can be edited. To select individual 
objects in the group you must use the Edit Group command or use the Ungroup command to break 
the group into its component parts.

Object Type

 An object's type is always displayed at the top of the palette next to the Object Selection buttons. The 
arrow buttons can be used to step through a multiple selection one object at a time. The center button is 
used to identify the currently selected object.

If nothing is selected, this field will read "No Selection."

Class
The Class field displays the selected object's class. To change an object's class assignment, click the 
Class field and select a new class from the pop-up menu.

If no objects are selected, selecting a class from this menu will change the active class.

For more information about classes, see the Classes command.

Layer
The Layer field displays the layer on which the selected object exists. The object can be moved to 
another layer by clicking the Layer field and selecting another layer from the pop-up menu (if it is moved 
to an invisible layer, or one that is not active, the object will disappear). 

X, Y, Z Fields
The X, Y and Z fields on the Shape pane represent the object's position in the drawing. You can move 
an object by changing the values in these fields.

The X, Y, Z fields are accompanied by a diagram of the object's bounding box, which specifies the 
handle aligned on the point specified by X, Y, Z. 

Note:    When a 3D object is selected, the Shape pane contains buttons allowing you to specify the 
object's position relative to the ground plane (X, Y, Z) or the working plane (I, J, K).

DX, DY DZ Fields
The DX, DY and DZ fields on the Shape pane represent the object's size. You can change the object's 
size by entering new values in these fields.

Note:     When a line object is selected the Shape pane contains buttons allowing you to specify the 
line's length using DX, DY coordinates or using polar coordinates (i.e. length and angle).



The Data Pane

The Data pane on the Object Info Palette is used to attach a database record to the selected object, or 
to edit a record that has already been attached. It is also used to assign a unique name to an object.

Object Name
This field is used to assign a unique name to an object in the drawing. To give a name to an object, click 
in the Object Name field and type a new name. This name must be different from the name of any other 
object, layer, class, symbol or record format in the drawing.

Record List
This segment of the Data Pane specifies the format of the record assigned to the object. It contains a list 
of all record formats in the drawing. See the Resource Palette for more about record formats.

To attach a record to the selected object, click the empty checkbox next to the record format's name in 
the list. If the selected object is a symbol, this record will also be attached to the symbol in the library. 
This means that, from now on, it will automatically be assigned whenever the symbol is inserted.

Note:    Changing the record format assignment of a symbol does not affect instances of the symbol 
already placed in the drawing. If you wish to attach a record to existing instances of this symbol, you 
must use the Data Pane to attach it to each instance individually.

To detach the object's record, click the checkbox to uncheck it.

If the checkbox contains a grayed checkmark, some of the selected objects are attached to the record. If 
you click the checkbox, the record will be attached to all selected objects.

Field List
This segment of the Data pane displays the individual fields of the selected object's database record. 
You can change the contents of this record by selecting the field's name in the list and editing its 
contents at the bottom of the palette.

If you change the contents this field when multiple objects are selected, your change will be applied to 
the records of all selected objects.



Resource Palette

The Resource palette is used to access and manage the following components (i.e., resources):

    · Symbols

    · Worksheets

    · Macros

    · Hatch Patterns

    · Record Formats

Except for macros, which can be stored as external text files, all of these resources are maintained 
within your drawing. They are created, accessed and edited using the Resource palette. When 
necessary, the Resource palette can also be used to import these resources from other drawings.

The Resource palette is opened using the Resources command on the Window menu. It is closed by 
clicking the Close box in the corner of the palette. It can be moved to any position on the screen by 
dragging its title bar.

The list box in this palette displays the resources in the selected file. 

By default, the resource list shows all resources in the selected file. To simplify the display, you can use 
the Show/Hide buttons at the bottom of the palette to limit the list to a particular resource type or type(s).

When a Show/Hide button is pressed, resources of that type are "hidden." That is, they are not 
displayed in the Resource Palette's list box. 

When a resource type is hidden, its button is displayed with a large "X' on its face. For example, if you 
want only symbol and worksheet resources to appear in the palette, you would click the Macros, Hatch 
Pattern and Record Format buttons to exclude these resources from the list. These 3 buttons would be 
displayed with a large, red "X" across each of them.



The Show/Hide buttons are toggles. To unblock a suppressed resource, simply click the button again.

When the Resource Palette's list box contains external file names, not drawing-file resources, these 
buttons are dimmed. They are automatically re-activated when a drawing file or library is entered.



Symbols

The Resource Palette is used to select, edit and import symbols. A symbol is an object that has been 
saved into the drawing's symbol library using the Create Symbol command. 

 Note:    Check the status of the Symbol button at the bottom on the palette. If the button has a large, 
red "X" across it, click it to allow symbols to be listed in the palette. 

Before a symbol can be placed in a drawing, it must "selected" in the Resource palette. This makes it 
the "active" symbol, which means it is available to, and can be placed with, the Insert 2D Symbol or 
Insert 3D Symbol tool. 

tip!     You can also select the active symbol my double-clicking the Insert 2D Symbol or Insert 3D 
Symbol icon. This action will open the Resource Palette.

For additional information, see the following topics:
Selecting Symbols

Importing Symbols

Editing Symbols

Creating a New Symbol Folder

Renaming a Symbol

Deleting Symbols

Moving Symbols to other Folders

Attaching Symbols to a Record Format



Selecting Symbols

Symbols are selected from the scrolling list in the Resource Palette. When a symbol is selected, its 
thumbnail is displayed in the palette's preview window in the lower-right corner. 

If you want to make this the "active" symbol, click the << button at the bottom of the palette. This action 
copies the symbol to the window in the lower-left corner, which makes it the "active" symbol.

Symbols can be selected from the drawing's internal library, or from an external MiniCad file (e.g. 
another drawing or library). To select a symbol from an external file, select the file using the pop-up 
menu at the top of the palette, then select a symbol from within it.

Note:     The Find button can be used to locate a symbol anywhere on your system. When clicked, the 
Find button opens the Find Resource dialog box. Enter the name of the symbol you want to locate, use 
the Set Where button to set the search path and click OK.

When you make an external symbol, the "active" symbol, it will automatically be imported into your 
drawing the first time it is placed. If your drawing already contains a symbol with the imported symbol's 
name, MiniCad compares the two versions. (MiniCad time-stamps symbols, so it knows which version is 
the most current.) 

If the versions are the same, the version already in the drawing's library is used. If the versions are 
different, you will be asked whether the older version of the symbol should be replaced by the newer 
one.

For related information, see the following topics:
Symbols

Importing Symbols

Editing Symbols



Importing Symbols

The Resource palette can be used to import symbols from other drawings. This process will happen 
automatically if you select and place a symbol from an external file. 

You can also import an entire folder of symbols. When an external folder is selected in the Resource 
Palette, it can be imported by clicking the Import button on the palette. 

If your drawing already contains a symbol with an imported symbol's name, you will be asked whether 
the existing symbol should be replaced by the imported one.

If an symbol has components in different classes, this class information is retained when the symbol is 
imported. If it contains class information that differs from the active file, that class information is 
automatically added to the active file.

If you import a folder(s) of symbols, but don't end up using all of the symbols in it, the unused symbols 
can easily be removed with the Purge Unused Objects command.

For related information, see the following topics:
Symbols

Selecting Symbols

Editing Symbols

Renaming a Symbol

Deleting Symbols

Creating a New Symbol Folder

Moving Symbols to other Folders



Editing Symbols

A symbol can be edited by selecting its name in the Resource Palette and clicking the Edit button. You 
can also edit a symbol by double-clicking its name in the list box. 

When the Edit Symbol dialog box is displayed, choose whether you want to edit the symbol's 2D or 3D 
component. 

The symbol will be presented in the Symbol Edit window. Make the changes you need. 

Important!       Any edits you make will be applied to all instances of this symbol in the drawing.

The symbol's insertion point is represented by the x, y axes of the window. On a 3D symbol, the symbol's 
z dimension can be changed by editing the z value.

When you are finished editing the symbol, close the window. The symbol will be updated. If you had 
added 2D components to a 3D symbol (or vice versa), MiniCad will automatically apply them to the 
appropriate version when it updates the symbol 

You can also edit a symbol directly in the drawing using the Edit Group command. 

For related information, see the following topics:
Symbols

Selecting Symbols

Importing Symbols

Renaming a Symbol

Deleting Symbols

Creating a New Symbol Folder

Moving Symbols to other Folders



Creating a New Symbol Folder

The New button on the Resource Palette is used to create folders to organize your symbol library. 
When the Symbol Folder button is clicked, a dialog box opens for the new folder's name. Like all 
objects in MiniCad, symbol folders must be given a unique name.

For related information, see the following topics:
Symbols

Moving Symbols to other Folders

Importing Symbols

Renaming a Symbol

Deleting Symbols



Renaming a Symbol

Symbols in the active document's library can be renamed. To rename a symbol, select its name in the 
Resource Palette and click the Rename button. A dialog box opens to enter the new name for the 
symbol. 

Every symbol in a drawing must have a unique name. If a symbol is giving a name that already exists, 
you will be asked whether you want to replace the existing resource with the newer one.

For related information, see the following topics:
Symbols

Selecting Symbols

Creating a New Symbol Folder

Moving Symbols to other Folders

Deleting Symbols



Deleting Symbols

Symbols can be deleted from the active document's library by selecting the symbol's name in the 
Resource Palette and clicking the Delete button. 

In the drawing, any instances of the deleted symbol are removed and replaced with loci.

For related information, see the following topics:
Symbols

Selecting Symbols

Editing Symbols

Renaming a Symbol

Moving Symbols to other Folders



Moving Symbols to other Folders

Symbols can be consolidated into folders within the symbol library. To move a symbol to another folder, 
select the symbol's name in the Resource Palette and click the Move button. Multiple symbols can be 
selected for this operation.

A list of symbol folders in the library is opened. The pop-up menu at the top of the dialog box is used to 
navigate through the folders in the library. 

Select the desired folder and click the Open button. Once the folder is open, click OK.

For related information, see the following topics:
Symbols

Creating a New Symbol Folder

Selecting Symbols

Renaming a Symbol

Deleting Symbols



Attaching Symbols to a Record Format

To assign a record format to a symbol, select the symbol's name in the Resource Palette and click the 
Attach button. In the Attach Record dialog box, select the record format to be attached to the symbol. 
Click OK.

From this point forward, the specified database record will automatically be assigned to the symbol 
whenever it is place. 

Note:    This action does not affect any instances of this symbol already in the drawing. If you wish to 
assign a database record to an existing instance of the symbol, you must attach it using the Data pane in 
the Object Info Palette.

A record format can be "detached" from a library symbol by selecting the symbol in the Resource 
palette, clicking the Attach button, and deselecting the record's checkbox in the Attach Record dialog 
box.

For related information, see the following topics:
Symbols

Selecting Symbols

Editing Symbols

Record Formats



Worksheets

The Resource Palette is used to create, open, and import worksheets.

Note:    Check the status of the Worksheet button at the bottom of the palette. If the button has a large, 
red "X" across it, click it to allow worksheets to be listed in the palette. 

MiniCad worksheets provide a fully functional spreadsheet facility with over thirty built-in functions. 
Additionally, MiniCad's worksheets can return virtually any 2D information contained in a drawing. They 
can be used to perform counts, calculations and generate schedules. 

A worksheet can be linked to other worksheets within the same drawing. You can also export information 
to other spreadsheets and databases, and import information from other MiniCad drawings or from other 
spreadsheet applications.

For additional information, see the following topics:
Creating a Worksheet

Opening a Worksheet

Importing a Worksheet

Renaming a Worksheet

Deleting a Worksheet

Basic Worksheet Editing

The Worksheet Window & Commands



Creating a Worksheet

The New button on the Resource palette is used to create a new worksheet in a drawing. When you 
click the New button, the Create Resource dialog box opens. Select the Worksheet button, then click 
Create. 

You will be asked to name the worksheet. This name must be different from any other named resource 
or object in the drawing. 

You will also be asked to specify the number of rows and columns your worksheet requires. The default 
is ten rows and five columns. Be aware that every cell within a worksheet has an overhead of 4 bytes per 
cell, so don't make the worksheet unnecessarily large. Specify a size that will initially accommodate your 
needs and click OK. The worksheet can be easily resized later if you need to make it larger. 

A worksheet editing window is opened in which you can create your worksheet. Close the window when 
you are finished working with it.

For additional information, see the following topics:
Importing a Worksheet

Basic Worksheet Editing

The Worksheet Window & Commands



Opening a Worksheet

A worksheet in the drawing can be opened by selecting its name from the list box in the Resource 
Palette and clicking the Open button. You can also double-click the worksheet's name to open it.

When a worksheet is opened, it is presented in its own a worksheet editing window.

For related information, see the following topics:
Importing a Worksheet

Basic Worksheet Editing

The Worksheet Window & Commands



Importing a Worksheet

The Resource palette can be used to import worksheets from other drawings. 

A worksheet can be imported by selecting its name from the list box in the Resource Palette and 
clicking the Import button. You can also double-click the worksheet's name to import it. 

Note:     The Find button is can be used to locate a worksheet anywhere on your system. When clicked, 
the Find button opens the Find Resource dialog box. Enter the name of the worksheet you want to 
locate, use the Set Where button to set the search path and click OK.

When a worksheet is imported, the original worksheet is copied into the active drawing. The original 
worksheet is not affected by any editing you do to it in the active drawing.

If the imported worksheet's name already exists in your drawing, you will be asked whether you want it to 
replace the one in your drawing. 

Note:     The Copy and Paste commands in the drawing window can also be used to move portions of a 
worksheet to another worksheet. Single cells, or a range of cells can be copied.

Spreadsheets from applications such as Excel or Lotus can be imported using the Import command on 
the File menu.

For related information, see the following topics:
Basic Worksheet Editing

The Worksheet Window & Commands



Renaming a Worksheet

Worksheets can be renamed by selecting the worksheet's name in the Resource Palette list box and 
clicking the Rename button. You will be prompted for a new name. Remember that every worksheet in a 
drawing must have a unique name.



Deleting a Worksheet

Worksheets can be deleted from the active document by selecting the worksheet's name in the 
Resource Palette list box and clicking the Delete button.

Deleting a worksheet permanently removes it and its contents from a drawing. When you delete a 
worksheet you will be asked to confirm your request.



Basic Worksheet Editing

Anyone familiar with spreadsheets will be right at home using MiniCad's worksheet facility because it is 
similar to many common spreadsheet programs. 

Keep the following in mind when using MiniCad's worksheets: 

· Select a range first, then execute a command.

· A row is either a spreadsheet row or a database row.

· Enter a formula using an equal sign (=) as its first character.

· Use two periods (..) to denote a range of cells, instead of the colon (:) used by Microsoft Excel.

· A worksheet uses its own menus for worksheet functions and the main drawing window menus 
for text (font, font style) and editing (cut, copy and paste).

· A worksheet can be placed in the drawing.

· Worksheets are printed independent of the drawing.

Worksheets can be linked to share information. In addition, the formulas and values on a worksheet can 
be copied and pasted from one worksheet to another. 

A worksheet row can be used as either a spreadsheet or a database. Spreadsheets have cells which 
contain formulas or values. 

A database row is linked to a specific criteria, as selected by the Search Criteria dialog box. A database 
row becomes a header for the records that match its criteria. The matching records are listed as subrow 
beneath the database row.

Each time the database row is recalculated, it expands or contracts to hold the number of objects 
matching its search criteria. Each subrow in the database returns a value based on the formula in the 
header.

For related information, see the following topics:
The Worksheet Window & Commands



The Worksheet Window & Commands

Every worksheet opens in its own window with its own scroll bars, cursors, and separate menus. 

There are two menus in a MiniCad worksheet.

· The Main Menu is accessed by clicking the menu icon in the upper left corner of the worksheet. 
This menu is used to perform global tasks such as recalculating and printing.

· The Row Menu is accessed by clicking a row heading. This menu is used to choose between 
spreadsheet and database functions. It is also used to determine functions and search criteria 
used for the database row. 

To the right of the menu icon are three icons that are used with database rows. These icons are active 
only when a Database Row is selected.

· The first two are sort icons, used to sort database rows into ascending and descending order. 
Drag either the Ascending or the Descending icon to the column heading of the column to be 
sorted. Up to three sort icons can be placed on a Database Row.

· The last icon is a summation icon. The Summation icon can be dragged to a column heading for 
a Database Row, where it sums all subrows that meet the search criteria. Up to three summation 
fields can be placed in a database row

For additional information, see the following topics:
Main Menus (worksheets)

Row Menus (worksheets)

Entering Worksheet Data

Selecting Cells & Moving Around the Worksheet

Using a Worksheet as a Database

Placing a Worksheet as a Graphic

Resizing worksheets



Main Menu (worksheets)

The Main menu is accessed by clicking the menu icon in the upper left corner of the worksheet. The 
menu is used to perform global tasks such as recalculating and printing.

This menu contains the following worksheet commands:

Recalculate
Paste Criteria
Paste Function

Database Headers
Number
Alignment
Border
Column Width
Preferences

Insert
Delete

Page Setup
Print



Recalculate

The Recalculate command on a worksheet's Main menu updates the worksheet to reflect a change in 
the drawing, a change to the values on the worksheet, or to update external references.

MiniCad calculates on the basis of the stored value in a cell, not the displayed values. 



Paste Criteria

The Paste Criteria command on a worksheet's Main menu displays the Search Criteria dialog box, 
which allows the construction of complicated conditional formulas to be used in your worksheet. 

Search criteria are objects or attributes that can be used as a standard on which a judgment can be 
made. The following are search criteria codes used in a MiniCad formula. They are placed in a formula, 
with proper parentheses and syntax by the Search Criteria dialog box. They can also be typed directly 
in the formula edit bar.

Object Symbol  Object Symbol

Object Name N Class Name C

Layer Name L Fill Pattern FP

Line Weight LW Line Style LS

Object Type T Symbol Name S

Selected Status Sel Object Record R

Pen Pattern PP Fill Foreground FF

Fill Background FB Pen Foreground PF

Pen Background PB Arrowhead AR

Visibility V Every Object All

Paste Function

The Paste Function command on a worksheet's Main menu presents a list of available functions, and 
places the selected function in the Formula Edit Bar. 

Worksheet functions can be used to calculate and return values based on information in the drawing or 
that you supply directly. 

Worksheet functions take a value, perform some operation on them, and return a result. Functions are 
calculated as soon as you enter them. However, if auto recalculation is off, any subsequent changes do 
not calculate automatically.

See MiniCad Functions for a complete description of the available functions.



Database Headers

A Database Row becomes a header for subrows, and any totals generated by the subrows are placed in 
the Database Row.

The Database Headers command determines whether a Database Row is displayed. When the 
command is enabled, the Database Row is visible Deselecting the command hides the Database Row.

Database Rows that are not displayed can still be referenced.



Number

The Number command on a worksheet's Main menu determines how a selected cell is formatted. 

Each cell in a MiniCad worksheet can be formatted to display numbers in a particular way. The stored 
value in the cell is stored as an extended-precision floating point number, which is accurate to about 
nineteen places.

Note:     The format in a database header controls how subrow cells are displayed.

When the Number command is selected, the Number dialog box is opened. It contains the following 
format types:

General
This format displays the whole numbers as written (internally it generates six decimal places, strips off 
any trailing zeros, and displays the result). Values that MiniCad interprets as text are aligned to the left 
side of the cell. Values that are numbers or integers are aligned to the right.

Decimal
When formatting a cell in decimals, you can choose to display commas with the number (by selecting the 
check box) and the number of decimal places that are displayed (by entering the value in the Decimal 
Places field). To display a value as currency, enter the appropriate symbol in the Leader field ($ or £ for 
example).

Scientific
This displays the number in scientific notation. Enter the desired display accuracy in the decimal place 
field.

Fractional
The Fractional option controls the denominator for rounding. For instance, enter a 4 if you want the 
numbers rounded to 1/4 unit. 

Dimension
Formatting a cell for dimensions displays the contents with the current unit setting as set in the Units 
command on the Page menu.

Angle
This option formats the cell in degrees, degrees and minutes, or degrees, minutes and seconds. The 
selection is made from a drop menu.

Date
MiniCad can display dates and time in thirteen combinations. The choices and results are shown below.

Format Example Format Example

mdy 5/17/97 mdy hmm 5/17/97    1:20

dmy 17/5/97 dmy hmm 17/5/97    1:20

ymd 97/5/17 ymd hmm 97/5/17    1:20

d-mmm-y 17 May 97 d-mmm 17 May

mmm-y May 97 h mm 1:20

h mm s 1:20:30 h mm (AM/PM) 1:20 PM

h mm s (AM/PM) 1:20:30 PM

Boolean
A Boolean formula returns a true or false value when evaluated. A Boolean cell can display a specific 
value depending on the evaluation of the formula. When Boolean is selected in the Number dialog box, 
fields labeled True and False are displayed.



To format a Boolean field, enter the values you want displayed when the formula is evaluated as true in 
the True field. Then, in the False field, enter the value you want displayed when the formula is evaluated 
as false. The fields can contain up to seven characters.

Leader
The characters in this field are prefixed to the value in the cell. The leader can be up to seven 
characters.

Trailer
The characters in this field are appended to the value in the cell. The trailer can be up to seven 
characters.



Alignment

The Alignment command on a worksheet's Main menu controls the alignment of the value within a cell. 
The default is General. The most recent setting overrides the previous setting.



Border

The Border command on a worksheet's Main menu specifies the type of border that is to be placed 
around the selected cell(s).

Individual cells, or ranges of cells, can have a border. The border can be on any or all of the four sides of 
the cell or range. The border color is always black, regardless of the pen color setting in the Attribute 
palette.

To put a border around a range, select the range and select the Outline checkbox in the Border dialog 
box. To put a border around every cell in a range, select Top, Bottom, Left and Right.



Column Width

The Column Width command on a worksheet's Main menu lets you control the column's width in points 
(there are 72 points to an inch). 

The default column width is 96 points.

Setting a column width to zero hides the column. (A hidden column can still be referenced.) 

To redisplay a column of zero width, select the column to the left and right of the hidden column, then set 
the column width to a value greater than zero. The columns are displayed at the specified width, and you 
can resize them individually as required.

Note:     Row height is not directly controllable in MiniCad. However, you can indirectly increase a row's 
height by increasing the font size within a cell. Rows cannot be hidden.

You can also increase the column width directly on the worksheet. When the cursor is dragged over a 
divider in the column header, it changes into the Column Resize cursor. Click on the divider with the 
Resize Cursor and drag the column to a new size.



Preferences

The Preferences command on a worksheet's Main menu is used to specify the following preferences for 
the active worksheet.

Note:    These preferences are applied to the open worksheet only. They do not affect any other open 
worksheet, nor are they carried over to new worksheets created in the drawing file.

Header
The header is text that appears at the top of every printed page of the worksheet. Only one font or style 
can appear in a header, and it must be text.

Footer
The footer is text that appears at the bottom of every printed page of the worksheet. Only one font or 
style can appear in a footer, and it must be text.

Margins
The page margins are set here. Be careful to stay within the margin required by your printer. 

Display
The check boxes control how these items display.

Show Grid
When checked, the reference grid is displayed. When displayed, the grid is printed.

Show Tabs
Shows tabs when the worksheet is in the drawing.

Auto-Recalculation
When checked, the worksheet recalculates internal references each time a formula is accepted.



Insert

The Insert command on a worksheet's Main menu allows you to add a new column or row to an existing 
worksheet. 

Data in the worksheet is not altered by an insertion, but a careless insertion can have negative effects 
because a referenced cell can be displaced. Columns and rows that are inserted into ranges are 
included in the range. Only whole rows and columns can be inserted in a worksheet. Any number of 
columns can be inserted into a worksheet.

To insert a column, select the column just to the right of where you want the new column inserted, and 
choose the Insert command. Multiple columns can be inserted.

Columns and rows can be inserted into ranges of cells but the range itself does not expand. The new 
rows are substituted for the existing rows displaced when the Insert command was chosen. This may 
have undesirable results. For example, if a new row is inserted into an existing range of cells that are 
referenced by a formula, the new row(s) will displace the cells in the range. This will cause the results of 
the formula to change. Always inspect a worksheet carefully before inserting rows to be sure you do not 
make inadvertent changes to formulas.



Delete

The Delete command on a worksheet's Main menu deletes a selected column or row from a worksheet. 

Be careful when deleting a column because you may not be aware of all referenced cells in the column 
to be deleted. Ranges that have had a column removed are reduced accordingly. Any formulas or values 
on the deleted rows and columns are removed.

To delete rows or columns from the worksheet, select the column(s) or row(s) to be deleted and choose 
the Delete command.



Page Setup

The Page Setup command on a worksheet's Main menu displays the currently selected printer's Page 
Setup dialog box. Selections remain active until changed and affect all items printed.



Print

The Print command on a worksheet's Main menu prints the active worksheet using the currently 
selected printer.



Row Menu (worksheet window)

A Row menu is opened when a row number is clicked. Commands selected from a Row menu affect 
only the selected row.

Spreadsheet
Database

Set Criteria
Edit Criteria

Select Data Items



Spreadsheet

The Spreadsheet command on a worksheet's Row menu designates the row as a Spreadsheet Row. 
Spreadsheets have cells that contain formulas or values.



Database

The Database command on a worksheet's Row menu designates the row as a Database Row. A 
Database Row is linked to a specific criteria, as selected by the Search Criteria dialog box. 

A database row becomes a header, and each instance of a match on the drawing with that row's search 
criteria is listed in a subrow below it. 

Each subrow in the database returns a value based on the formula in the header.



Set Criteria

The Set Criteria command on a worksheet's Row menu opens the Set Criteria dialog box. 

Any changes made with this command replace any previous settings for the row.



Edit Criteria

The Edit Criteria command on a worksheet's Row menu places the active Database Row in the 
Formula Edit Bar for editing.



Select Data Items

The Set Criteria command on a worksheet's Row menu selects all objects on the drawing that meet the 
search criteria for the selected row.



Entering Worksheet Data

The following types of data can be entered in a worksheet: 

· Constant values

· Formulas 

Constant values are typed directly in the Formula Edit Bar, which places the value in the cell. This value 
can be text, numbers, or dates. Constant values do not change unless you change them.

A formula is a sequence of functions, cell references and operators that produce a new value from 
existing values. A formula must always begin with an equal sign (=). Values produced as the result of a 
formula can be changed when the formula is evaluated.

For additional information, see the following topics:

Formula Edit Bar

Operators

Functions

Cell References



Formula Edit Bar

All entries are made to a worksheet cell by typing them in the Formula Edit Bar. 

The formula edit bar becomes active when a cell is active. It will display the contents, if any, of the active 
cell. 

The Formula Edit Bar has an Enter box and a Cancel box. After entering your formula or constant 
value, click the Enter box or press Enter or Tab to place the entry in the active cell. 

Entering Numbers
To enter a number as a constant, select a cell and type in the number. To enter a negative number, 
precede it with a minus sign. 

Do not format the number with commas or dollar signs as you enter it. (You can format the cell to display 
commas or dollar signs). If you enter a value containing commas or dollar signs, it will be treated as text. 

Dates And Times
Dates and times are stored as a unique sequential numbers. In Windows, time is measured from 
January 1, 1900. 

If you enter the date (e.g. 6/19/93) directly into an unformatted cell, MiniCad automatically formats it as a 
date cell and displays it correctly. 

If you enter the date into a cell that is formatted with a different number format, it is displayed as a 
number. For example, if you enter the date January 1, 2000, into a cell already formatted as currency, 
the number is displayed as 35064.00, which is the number of days from January 1, 1904 to January 1, 
2000.

Entering Text
In a MiniCad worksheet, text is any set of characters entered into a cell that is not a number, formula, 
date, or time.

To enter text as a constant, select the cell and type the text. As with any constant value, text entered into 
a cell remains until changed. Text can be entered into a cell as the result of a formula being executed. A 
cell can contain up to 255 characters of text. 

Text can be any character, letter, number, or any other character the selected font can produce. 

Text can be numbers, but to keep MiniCad from treating the cell as a number, enclose it in single 
quotation marks.

To enter a text string in a formula, enclose the text string in single quotation marks. You do not need to 
do this if the text string is a single word, but it is required if the text string has any spaces between the 
words. For example, notice the quotation marks in the following formula.

 =IF(H9>100,yes,IF(H9>90,maybe,IF(H9>80,'I don't know' ,'no contract'))) 

If you omit the quotation marks, MiniCad displays a message saying "comma expected" because it 
cannot evaluate a formula with a space in it.

Entering Formulas
Formulas are used to produce calculated values within the worksheets.

Formulas can contain cell references, operators, values, or functions. Many formulas can be constructed 
from dialog boxes with just a few mouse clicks. Formulas also can be typed directly in the Formula Edit 
Bar. 

A formula must begin with an equal sign (=). This tells MiniCad to evaluate this cell as a formula.

A formula will not evaluate properly if its syntax is not exactly correct. Parentheses must be in pairs, and 
commas are sometimes required even if an argument is not present. Refer to the MiniCad Functions 
reference for a list of the supported functions.



A formula can include references to another cell¾even cells on other worksheets¾in addition to constant 
values. 

Formulas are not case-sensitive. You may enter function names and cell addresses in upper or 
lowercase.

For additional information, see the following topics:

Cell References

Operators

Functions



Cell References

A cell reference identifies a cell or range of cells on a worksheet. They can be used to tell a formula 
where to find values needed to calculate the formula. 

A references can refer to cells in another worksheet, however the worksheet must be in the active 
drawing. If it exists in another drawing, you must import it. 

Although a referenced worksheet must be in the active drawing, it does not have to be open.

It is a good idea to put referenced cells and assumptions in a prominent place at the top of the 
worksheet. It is also a good idea to return the solutions to the worksheet formulas in the same area. This 
way you can easily change an assumption or value and immediately see the results (a "what if" 
analysis).

Cell references are based on the row and column headings on the worksheet. 

References in MiniCad can be relative or absolute. An absolute reference refers to a specific cell 
referring to that cell's "address." 

A relative reference tells MiniCad where to find a cell, "relative" to the cell that contains the formula. 
Relative references maintain the reference even if the cell is copied to another location on the 
worksheet. 

An absolute reference is a reference to a specific location on the worksheet. An absolute reference 
breaks if the referenced cell is copied to a new location.

Internal references can be entered by clicking on the referenced cell while constructing the formula. You 
can also type the cell address directly into the formula.

External references must be typed in using [worksheet name:cell/range address] format. 

External references are updated when the Recalculate command is chosen. The worksheet containing 
the external reference does not need to be open for the reference to be updated. 

For additional information, see the following topics:

Formula Edit Bar

Operators

Functions



Operators

MiniCad supports use of the following operators in a formula. If the operator can be created with a 
special key combination, it is shown.

Arithmetic Operators
The arithmetic operators perform basic mathematical operations. They combine numeric values and 
produce numeric results.

Operation Symbol

Addition +

Subtraction -

Multiplication *

Division /

Exponentiation _ or **

Comparison Operators
The comparison operators compares two values and produces the logical value TRUE or FALSE.

Comparison Symbol

Equal =

Not Equal <> or    (Control =)*

Less than <

Less than or equal to <= or    (Control <)*

Greater than >

Greater than or equal to >= or _ (Control >)*

Reference Operators
The reference operator combines two cell references into a single joint reference.

Reference Symbol

Range ..

Reserved Words and Symbols
The following words and characters are reserved for use in formulas.

Symbol Description

( Left parenthesis

) Right parenthesis 

, Comma 

; Semicolon

: Colon

 (Control v) Square Root 

Sum or _ (Control w)* Summation



 (Control p) Pi 

TRUE True

FALSE False

For additional information, see the following topics:

Formula Edit Bar

Functions



MiniCad Functions

The following are the worksheet functions available in MiniCad. 

Capitalized functions use search criteria. Lower case functions take a number value or a cell range. 
Results and arguments for trigonomic functions are expressed in radians.

Function Description

acos Returns the arc cosine of a number

Angle Returns the angle of lines and walls

Area Returns the total area of objects

asin Returns the arc sine

atan Returns the arc tangent

average Returns the average (mean) of a series of arguments

BotBound Returns the bottom boundary of an object

cos Returns the cosine

Count Returns the number of objects

deg2rad Converts degrees to radians

exp Exponential

Height Returns the height of objects

if Returns one value if logical test evaluates true, and another value if 
it evaluates false

int Rounds a number down to nearest integer

LeftBound Returns the left boundary of an object

Length Returns the length of lines and walls

ln Natural logarithm

log Returns the base ten logarithm

max Largest of a series of values

min Smallest of a series of values

Perim Returns the perimeter of objects

rad2deg Converts radians to degrees

RightBound Returns the right boundary

round Rounds values

sin Returns the sine

sqrt Returns the square root

sum Returns the total of a series of arguments

tan Returns the tangent

TopBound Returns    the top boundary

Width Returns the width of objects



Xcenter Returns the center of objects in x    direction

Ycenter Returns the center of objects in y    direction

Acos Function

acos(number)

Returns the arccosine of a number. The arccosine is the angle whose cosine is number. The returned 
angle is given in radians in the range 0 to p.
Number is the cosine of the angle, and must be from -1 to 1

acos(cos(x))=x

See also:

cos

List of MiniCad Functions



Angle Function

Angle(criteria)

Returns the angle of lines and walls, the span angle of arcs (in degrees), and the slope angle of slabs (in 
degrees).

See also:

Width
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Area Function

Area(criteria)

Returns the total area of 2D objects.

See also:

Perim
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Asin Function

asin(number)

Returns the arcsine of a number. The arcsine is the angle whose sine is number. The returned angle is 
given in radians in the range -p/2 to p/2.

Number is the sine of the angle you want and must be from -1 to 1.

To express the arctangent in degrees use the rad2deg function (or multiply the result by 180/pi).

Related functions:

See also:

sin
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Atan Function

atan(number)

Returns the arctangent of a number. The arctangent is the angle whose tangent is number. The returned 
angle is given in radians in the range -p//2 to p//2.

Number is the tangent of the angle you want.

To express the arctangent in degrees, multiply the result by 180/pi().

See also:

tan
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Average Function

average(number1,number2...) 

Returns the average (mean) of the arguments.

See also:

max

min

sum
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Botbound Function

BotBound(criteria) 

Returns the minimum y coordinate of an object.

See also:

LeftBound

RightBound

TopBound
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Cos Function

cos(number) 

Returns the cosine of a given angle.

Number is the angle in radians for which you want the cosine

See also:

List of MiniCad Functions



Count Function

Count(criteria)

Returns the number of objects.

See also:

Width
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Deg2rad Function

deg2rad(number) 

Converts number from degrees to radians.

Number is the value in degrees you want converted to radians.

See also:

Width
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Exp Function

exp(number)

Returns e raised to the power of number. The constant e equals 2.71828182845904, the base of the 
natural logarithm.

Number is the exponent applied to the base e.

See also:

ln
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Height Function

Height(criteria) 

Returns the Dy (height) of objects.

See also:

Width
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If Function

if(logical_test, value_if_true,value_if_false)

Returns one value if logical_test is true, and another value if it is false.

Use this function to conduct conditional tests on values and formulas and to branch based on the results 
of that test. The outcome of the test determines the value returned by the if function.

The logical_test can be any value or expression that can be evaluated to true or false.

Up to seven if statements can be nested as value_if_true,value_if_false arguments to construct 
elaborate formulas. Boolean statements within an if statement must be in parentheses. Text within an if 
statement should be enclosed within quotation marks. 

See also:

Width
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Int Function

int(number) 

Removes any fractional part of a number.

Number is the real number you want to round down to an integer.

See also:

round
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LeftBound Function

LeftBound(criteria) 

Returns the left side minimum x (left boundary) of the object

See also:

BotBound

RightBound

TopBound



Length Function

Length(criteria) 

Returns the length of lines or walls.

See also:

Width
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Ln Function

ln (number) 

Returns the natural logarithm (base e).

Number is the positive real number for which you want the logarithm

See also:

exp
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Log Function

log(number) 

Returns the base 10 logarithm of a number.

Number is the positive real number for which you want the logarithm.

See also:

ln
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Max Function

max(number1,number2,...) 

Returns the largest number in the list of arguments

Number1,number2,... are 1 to 14 numbers for which you want to find the maximum value.

See also:

min
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Min Function

min(number1,number2,...) 

Returns the smallest number in the list of arguments

Number1,number2,... are 1 to 14 numbers for which you want to find the maximum value.

See also:

max
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Perim Function

Perim(criteria)

Returns the perimeter of objects.

See also:

Width
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Rad2deg Function

rad2deg(number) 

Converts number from radians to degrees.

Number is the value in radians you want converted to degrees.

See also:

Width
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RightBound Function

RightBound(criteria) 

Returns the right side minimum x (right boundary) of the object.

See also:

BotBound

LeftBound

TopBound
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Round Function

round(number,num_digits) 

Rounds a number to the specified number of digits.

Number is the number you want to round

Num_digits specifies the number of digits to which you want to round number.

See also:

int
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Sin Function

Returns the sine of a given angle.

Number is the angle in radians for which you want the sine

See also:
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Sqrt Function

sqrt(number) 

Returns a positive square root.

Number is the number for which you want the square root

See also:

Width
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Sum Function

sum(number1, number2,...) 

Returns the sum of all the numbers in the list of arguments.

Number1,number2,... are 1 to 14 arguments for which you want the sum.

See also:

average

Count

max

min
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Tan Function

tan(number) 

Returns the tangent of the given angle.

Number is the angle in radians for which you want the tangent

See also:
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TopBound Function

Topbound(criteria) 

Returns the maximum y (top boundary) of the object.

See also:

BotBound

LeftBound

RightBound
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Width Function

Width(criteria) 

Returns the Dx (width) of objects.

See also:

Height
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Xcenter Function

Xcenter(criteria)

Returns the center of objects in x direction.

See also:

Xcenter

List of MiniCad Functions



Ycenter Function

Ycenter(criteria) 

Returns the center of objects in y direction.

See also:

Ycenter

List of MiniCad Functions



Selecting Cells & Moving Around the Worksheet

Before working on a worksheet, you must select the part of the worksheet with which you want to work. 
This may be a single cell, a range of cells, or characters in the edit bar. 

To select... Do this...

Single cells Click on the cell

A range of cells Drag through the range. Or click one 
corner of the range, then click the 
opposite corner while pressing the 
Shift key.

A row or rows Click on the row heading (number). 
Multiple rows can be selected by 
dragging across the headings.

A column or columns Click on the column heading (letter). 
Multiple columns can be selected by 
dragging across the headings.

The entire worksheet Click on the square in the upper left 
corner of the worksheet

A selected cell is displayed with a thick border. A selected range of cells is darkened as well as 
surrounded by a thick border. 

The Reference Box in the upper left corner of the worksheet displays the column and row location of the 
active cell. 

The Enter key moves the active cell down. Shift-Enter moves the active cell up. 

The Tab key moves the active cell to the right. Shift-Tab moves the active cell to the left. 

You can move from cell to cell with the arrow keys. The active cell is highlighted. If a range of cells is 
selected, cell-to-cell movement is constrained to the selection.

For additional information, see the following topics:
Main Menus (worksheets)

Row Menus (worksheet window)

Entering Worksheet Data



Formatting Cell Contents

Worksheets can be formatted in various ways. The text in worksheets is controlled using the commands 
on the Text menu, just like any text in MiniCad. However, because all pen color is black, color cannot be 
controlled.

The following commands on the worksheet's Main menu, let you perform additional formatting:

The Number command lets you format numbers in numerous ways, including decimals, dimensions, 
dates and Boolean calculations. 

The Alignment command lets you control the alignment of a value in a cell. 

The Border command lets you place a border around a cell. 

The Column Width command. lets you specify the width of the column, in points.

For additional information, see the following topics:
Entering Worksheet Data

Selecting Cells & Moving Around the Worksheet

Main Menus (worksheets)

Row Menus (worksheets)



Using a Worksheet as a Database

A MiniCad drawing can have a worksheet that contains both a spreadsheet and a database. In fact, the 
database in MiniCad is the drawing itself, and the data it contains is gathered using Database Rows in a 
worksheet.

When a Database Row is configured, it creates a subrow for each instance of the item referenced by its 
search criteria. Each subrow is part of a "parent" row, which expands and contracts automatically as the 
referenced data changes. A small diamond next to the row number shows that the row is a Database 
Row.

The information returned to a the subrows is contained in database records. Database records are 
created with the Resource Palette. Assignment of these records is done with the Data pane of the 
Object Info Palette, where these records can be referenced and edited. 

The best way to show the usefulness of the database is by example. Please refer to the tutorials on 
database manipulation for more information.

For additional information, see the following topics:
Entering Worksheet Data

Selecting Cells & Moving Around the Worksheet

Main Menus (worksheets)

Row Menus (worksheets)



Placing a Worksheet as a Graphic

Worksheets can be placed as a graphic on the drawing. The worksheet does not have to be open for it to 
be placed as a graphic. 

A worksheets placed as graphic initially appears as a box with an "X" through it. It will display normally 
when the worksheet is closed.

To place a worksheet as a graphic, click the On Drawing checkbox in the Resource palette before you 
open the worksheet. 

As a graphic object, the on-drawing worksheet can be selected and repositioned as needed. However, it 
cannot be resized. 



Resizing worksheets

There are two ways to resize a worksheet. 

· You can use the Insert and Delete commands on the Main worksheet menu to add or delete 
columns and rows as needed.

· You can place the cursor on the lower right corner of the worksheet window and drag the corner 
left, right, up or down to add or remove rows and columns as you need.

Be aware that resizing a worksheet can affect values returned to referenced cells. 



Macro Commands

The Resource Palette is used to create and edit command palettes and macro commands.

Note:    Check the status of the Macro button at the bottom of the palette. If the button has a large, red 
"X" across it, click it to allow macro commands to be listed in the palette.

There are two types of macros used in MiniCad: 

· Internal MiniPascal macro commands, which run from customizable palettes.

· External macros, stored in external text files, which are run directly from the Resource palette. 

The internal macros, also called commands, are created and edited from the Resource palette. Internal 
macro commands are contained in command palettes. Command palettes are created and edited from 
the Resource palette. Internal macro commands also can be made with the Custom Selection, 
Custom Tools/Attributes, Custom Visibility and Save View commands.

For additional information, see the following topics:
Creating a Command Palette

Importing a Command Palette

Opening a Command Palette

Creating a Macro Command

Editing a Macro Command

Command Editor

Running an External Macro



Creating a Command Palette

Command palettes are created by clicking the New button on the Resource palette. In the Create 
Resource dialog, select the Command Palette option.

When the Assign Name dialog opens, enter a palette name. Palette names must be unique. Click on 
the OK button to create the palette.

Like all palettes, Command palettes are floating windows that can be placed anywhere on the screen. A 
Command palette can be resized. A MiniCad file can have many command palettes, and palettes can 
hold many commands. This allows "sets" of command palettes to be created, and filled with different 
commands for different types of jobs.



Importing a Command Palette

Command Palettes can be imported from other drawing files. This is done by selecting the palette's 
name in the Resource Palette's list box and clicking the Import button. Use the pop-up menu at the top 
of the Resource palette to locate the file that contains the palette you want to use. 

The palette will be copied into the active drawing. When a command palette is imported, all of the 
commands it contains are imported with it. 



Opening a Command Palette

A Command Palette can be opened by selecting the palette's name in the Resource Palette's list box 
and clicking the Open button. 



Creating a Macro Command

Internal macro commands can be created by clicking the New button on the Resource palette. 

When the Create Resource palette opens, select the MiniPascal Macro button and click Create. 

A dialog box with all of the file's command palettes appears. Select the palette on which you want the 
new command placed, then click the Add button. 

A dialog box opens for the command's name. Type a unique name for the macro. This name must be 
different from any other object or resource name in the drawing. Click OK.

The command is listed in the Resource palette. 

Select the command in the Resource Palette's list box and click the Edit button. The Command Editor 
is opened for you to begin creating the macro. 

For additional information, see the following topics:
Command Editor



Editing a Macro Command

To edit an internal macro command, select the command palette's name in the Resource Palette list 
box and click Open button.

Once the palette has been opened, select the name of the macro command to be edited and click the 
Edit button. 

The selected macro is presented in the Command Editor window.

tip:    You can also edit a macro from a command palette. This is done by holding the Control key while 
you double-click its name in the palette. The macro will be opened in the Command Editor.

For additional information, see the following topics:
Command Editor



Command Editor

The Command Editor is a powerful tool for editing MiniCad macros. It lets you create macro statements 
by clicking in dialog boxes. For most users, the Command Editor is used to edit custom selections, 
custom tool/attributes, and custom visibility commands created by their respective commands on the 
Organize menu. 

The Command Editor is automatically opened when a command macro is created or edited from the 
Resource Palette. See Creating a Macro Command and Editing a Macro Command for these 
procedures.

The Command Editor window contains the controls listed below.

Procedures

Criteria

Tools / Attr

Functions

Get Text

View Errors



Procedures

The Procedures button in the Command Editor window opens the Procedure dialog box.

This box has two lists, which are linked. When a heading is selected in the scrolling list labeled Chapter, 
the available procedures appear in the adjacent Procedure scrolling list. 

Procedures are selected from the list. When a procedure is selected, a brief description of the 
procedure is shown. 

Note:     A complete description of the available procedures is given in your MiniPascal manual.

The selected procedure is entered into the Command Editor when the OK button is clicked. All 
formatting and syntax is included, but variables and arguments have to be entered. While the Command 
Editor greatly assists you with this process, programming experience is helpful when creating macros.



Criteria

The Criteria button is used to open the Search Criteria dialog box. By using this feature, a command 
can be created that searches across the drawing for every instance of any of the criteria you specify. 

The Search Criteria dialog box has the following options:

Preset/Edit
Clicking the Preset button allows creation of the search criteria by clicking any of the individual criteria 
buttons on the dialog box. Clicking the Edit button allows the search criteria to be edited.

Visible
When selected, the search is limited to visible objects.

Selected
When selected, the search is limited to selected objects.

All
When selected all objects in the drawing are subject to the search.

Layer
A search can be limited to a particular layer or layers. To set the layer criteria, click the Layer button. 

When clicked, a list of all layers in the drawing is displayed. Select any layers to be included in the 
search. Multiple layers can be selected by pressing the Shift key while selecting. 

Click the Add button to add selected layers to the search criteria. The Remove button deletes the 
selected layer from the search criteria. The layer itself is not deleted. When finished, click the Done 
button. 

Cancel returns to the Command Editor without any changes.

Class
A search can be limited to include instances of a particular class or classes. This is done by clicking the 
Class button. 

When clicked, a list of all classes in the drawing is displayed. Select any classes to be included in the 
search. Multiple classes can be selected by pressing the Shift key while selecting. Click the Add button 
to add the class or classes to the search criteria. The Remove button clears the selected classes from 
the search criteria. The class itself is not deleted. When finished, click the Done button. 

Cancel returns to the Command Editor without any changes.

Type
A search can be made for any of the object types used in MiniCad. To search for an object type, click on 
the Type button on the Search Criteria dialog box. 

When clicked, a list of object types is displayed. Select any of the object types to be included in the 
search. Multiple types can be selected by pressing the Shift key while selecting. Click the Add button to 
add the object types to the search criteria. The Remove button clears the selected object types from the 
search criteria. When finished, click the Done button. 

Cancel returns to the Command Editor without any changes.

Name
A drawing can be searched for named objects. To include a named object in a search criteria, click 
Name. 

When clicked, a list of all named objects in the drawing is displayed. Select any of the object names to 
be included in the search. Multiple object names can be selected by pressing the Shift key while 
selecting. Click the Add button to add the object names to the search criteria. The Remove button clears 



the selected object names from the search criteria. When finished, click the Done button. 

Cancel returns to the Command Editor without any changes.

Symbol
MiniCad can search for instances of symbols placed on the drawing. To include a symbol in the search 
criteria, click on the Symbol button. When clicked, a list of symbols is displayed. Select any symbol to be 
included in the search. Symbols can be located in folders nested within other folders. When finished, 
click the Done button to add the symbols to the search criteria. 

Cancel returns to the Command Editor without any changes. 

Record/Field
The search criteria can search the drawing for instances of an object or symbol attached to a specific 
record or fields within the record. In addition, certain operations can be performed on the record to 
further refine the search. To search for a particular record or field, click the Rec/Fld button. Select the 
records and/or fields to be searched for by the program, and double-click. 

You may specify a limit by selecting one of the following constraints in the Select an Operator list.

· When the No operators option is specified, no limit is placed on the search criteria.

· When the Less than (<) option is specified, the search is successful only if the search criteria is 
less than the value in the Enter a Limit Value field.

· When the Greater than (>) option is specified, the search is successful only if the search criteria 
is greater than the value in the Enter a Limit Value field.

· When the Equal (=) option is specified, the search is successful only if the search criteria is equal 
to the value in the Enter a Limit Value field.

· When the Less than or equal (<=) option is specified, the search is successful only if the search 
criteria is less than or equal to the value in the Enter a Limit Value field.

· When the Greater than or equal (=>) option is specified, the search is successful only if the 
search criteria is greater than or equal to the value in the Enter a Limit Value field.

· When the Not equal (<>) option is specified, the search is successful only if the search criteria is 
not equal to the value in the Enter a Limit Value field.

If you want the search to be limited to whole record, without individual fields, check the Record Search 
Only checkbox.

After making your selections, click the Done button. Clicking the Delete button removes selected record 
or fields within the record from the selected list. It is not going to remove the specific record or fields 
within the record from the drawing.

Fill Pattern 
The search can be limited to instances of a specific fill pattern. To search by fill pattern, click the FilPat 
button. Select the fill patterns to be searched for by the program, and double-click. After making all 
selections, click the Done button. Delete removes a fill pattern from the selected list.

Edited fill patterns retain the ID number of the original fill pattern, so the search criteria remains the same 
no matter how many times the pattern is edited.

Line Weight 
MiniCad can limit the search to instances of a specific line thickness. To search by line weight, click the 
LineWgt button. Select the line weights to be searched for by the program and double-click. After 
making all selections, click the Done button. Delete removes a line weight from the selected list. 

It is possible to have more line weights stored in the drawing than the five selections available on the 
attribute palette. If more than five different line weights have been created in the drawing, click on Set 
Thickness in the selection box. The line weight is entered directly in the dialog box.



Line Style
MiniCad can limit the search to instances of a specific dash style. To do this, click the LineStyl button. 
The selection list displays all available dash styles. Select the dash styles for which you want to conduct 
a search, and double-click. After making all selections, click the Done button. Delete removes a dash 
style from the search criteria list. Clicking Cancel returns to the Command Editor.

Arrow Shape
The search can be limited to instances of specific arrowheads and line markers. To search by line 
marker, click the Arw Shape button. Select the arrowheads and line markers for which you want to 
conduct a search, and double-click. When all selections are made, click the Done button. Delete 
removes an arrowhead or line marker from the search criteria list.

Arrow Size
The search can include instances of specific arrowheads sizes. Click the Arw Size button. A scrolling list 
of the markers on the drawing is displayed. Select the particular arrow size for which a search is to be 
conducted and double-click. After making the selections, click the Done button. Click on the Delete 
button to remove a selected arrowhead or line marker from the list.

Fill / Pen Foreground / Background
The program can limit the search to instances of a specific color. MiniCad isolates the foreground color 
from the background color and also separates the pen (lines and text) and fill (surfaces). To search by 
color, click one of the color buttons (FillFore, FillBack, PenFore, PenBack). The color palette appears. 

Select the colors for which you want to conduct a search, and double-click. After making all selections, 
click the Done button. Delete removes a color from the selected list.



Tools / Attr

The Tools / Attr button opens the Custom Attributes dialog box, which allows a combination of object 
attributes to be applied as part of a command. Before selecting Tools / Attr, select or create an object 
with the attributes to be included in the command. Specify color and font and any other attribute to be 
added to the command.

The attributes can be toggled on and off as a group by clicking the appropriate buttons. The individual 
attributes are:

Pen
The pen color controls how a line's color and pattern are drawn. To select all, click Pen. There is 
individual control over foreground color, background color, and pattern

Fill
The fill color controls how the surface's color and pattern are drawn. To select all, click Fill. Foreground 
color, background color, and pattern can be used as individual attributes.

Line
The line attributes can be toggled on and off as a group by clicking Line. Line's weight, style (dash 
pattern), markers (arrowheads), and marker size can be used as individual attributes.

Text
The text attributes can be toggled on and off as a group by clicking Text. Text font, size, style, spacing, 
and justification can be used as individual attributes.

Class
The object's Class can be used as an attribute.

Layer
The object's Layer can be used as an attribute.

Symbols
If the object is a symbol, its name can be used as an attribute.

Tool
The selected tool can be used to make a custom tool.

Constraint
The current snap constraint can be selected as an attribute.



Functions

The Functions button is used to add MiniCad functions to a macro command. 

For a list of the supported functions, see MiniCad Functions.



Get Text 

The Get Text button is used to import a text file into the Command Editor. This can be used if you have 
created your macro code using an external ASCII editor rather than the Command Editor.

To enter text files, click the Get Text button, select the text file from the directory dialog box and click 
Open. The contents of the file are loaded into the Command Editor.



View Errors

The View Errors button is used to inspect the errors are generated when a MiniPascal command is 
executed.



Running an External Macro

Internal macros are executed from the command palette to which they were assigned.

External macros, which are stored in standard text files, are executed from the Resource palette. When 
a text file is selected in the Resource palette, the top button on the palette becomes the Run button. To 
run the macro, simply select its name in the Resource Palette's list box and click the Run button.

Be aware that any text file displays in the palette, even if it is not a macro. If the Run button is clicked on 
a non-macro file, an error message is displayed.



Hatch Patterns

The Resource Palette is used to create, edit and import hatch patterns.

Note:    Check the status of the Hatch button at the bottom of the palette. If the button has a large, red 
"X" across it, click it to allow hatch patterns to be listed in the palette.

Hatch patterns are patterns of lines that are used to fill a closed object. They are typically used to 
represent various construction materials. They can also be used as "section lines," which identify an 
object's profile when it is cut. 

Hatch patterns differ from fill patterns in that:

· They can be scaled. Fill patterns cannot. 

· They can be exported with DXF. Fill patterns cannot.

Hatches are made of line segments. Each line segment has a starting point, a variable offset (i.e., the 
distance between the line segments), a repeat factor (i.e., how often the pattern is duplicated), and a 
dash factor (or how much space there is between line segments). 

Segments are in layers, with the first segment at the bottom and each new one atop the last. There can 
be up to thirty segments or layers in a hatch pattern. This allows elaborate hatch patterns to be created.

Hatch patterns are either in page scale, where the measurements shown are used no matter what the 
scale of the active layer, or in world scale, where hatch measurements are scaled to match the active 
layer. In page scale, a quarter inch spacing in a hatch pattern is a quarter-inch spacing on the screen 
when in normal scale. This scaling ability is another way hatch patterns differ from patterns.

A hatch pattern is placed in the drawing using the Hatch command.

For additional information, see the following topics:
Importing a Hatch Pattern

Editing a Hatch Pattern



Importing a Hatch Pattern

If a hatch pattern exists in another drawing or in a MiniCad library, it can be imported into the active 
drawing.

To import a hatch pattern, select its name in the Resource Palette's list box, then click the Import 
button. The pattern will be imported into the active drawing. 

Note:     The Find button is can be used to locate a pattern anywhere on your system. When clicked, the 
Find button opens the Find Resource dialog box. Enter the name of the pattern you want to locate, use 
the Set Where button to set the search path and click OK.

If the imported hatch pattern's name already exists in your drawing, you will be asked whether you want 
it to replace the one in your drawing. 



Editing a Hatch Pattern

To edit a hatch pattern, select its name in the Resource Palette's list box, then click Edit button. 

The hatch pattern will be presented in the Edit Hatch dialog box. This dialog contains the tools you need 
to make changes to the hatch pattern. After you have made your changes, click OK to close the dialog 
box.

Like all edits to a file, changes in the active hatch do not become be permanent until the active document 
is saved (i.e., if you create a pattern, but don't save the drawing, the pattern will be lost).

For more information about the Edit Hatch window, see The Edit Hatch dialog box.



The Edit Hatch dialog box

The Edit Hatch dialog box is used to edit a hatch pattern. This window is opened by double-clicking the 
hatch pattern's name in the Resource Palette.

Along the left side of the Edit Hatch dialog are a set of editing tools. Along the right side of the dialog 
box are the hatch values. You can define a hatch pattern by entering new values in these fields, or by 
drawing it with the mouse in the edit window. 

The Edit Hatch dialog contains the following fields and controls:

Start Point
The Start Point group box contains the coordinates of the starting point handle, which represents the 
pattern's origin. The origin is used when the hatch is applied on the drawing. It represents the point in the 
pattern that will be aligned on the cursor's position when the pattern is placed in the drawing.

The buttons on the right side of Start Point group box can be used to toggle the values between 
Cartesian and polar format.

In the edit window, the Start Point is represented by a solid round dot. You can change this dot's 
position by entering new values in the Start Point field, or simply by dragging the dot to a new position. 

Note:     If you hold the Control key and drag the Start Point handle, the pattern will be copied to a new 
layer.

Repeat
The Repeat group box specifies the angle and length of each hatch layer before the segment begins 
again. There may be a portion of the layer that is open space, determined by the dash factor, or the 
segment can be drawn continuously. 

A value of 0 in either coordinate field results in a hatch layer that is either horizontal or vertical. Equal 
absolute values result in the hatch layer lying on a 45° line. 

The buttons on the right side of Repeat group box can be used to toggle the values between Cartesian 
and polar format.

You can also change the Repeat value by dragging the small, unfilled, square handle in the edit window. 
Dragging this handle will change the value in the Repeat fields.

The line defined by the Repeat and Start Point values can never be parallel to the line defined by the 
Offset point and the Start Point values.

Offset
The Offset group box defines one edge or corner of the repeating tile that the hatch layer is in. Each 
layer can have a different repeat tile. Equal absolute values entered into the coordinate fields result in 
the tile edge or corner lying on a 45° line from the start point. 

The buttons on the right side of Offset group box can be used to toggle the values between Cartesian 
and polar format.

You can also change the Offset value by dragging the small, unfilled, round handle in the edit window. 
Dragging this handle will change the value in the Offset fields.

The line defined by Offset and Start Point can never be parallel to the line defined by the Repeat and 
Start Point.

Dash Factor
The Dash Factor determines the line-to-space ratio. To produce a solid line, enter a value of 1 in this 
field. A value less than one produces a dashed line..

You can also change the Dash Factor by dragging the small, solid, square handle in the edit window. 
Dragging this handle will change the value in the Dash Factor field.



The Select tool is used to select a layer in the edit window. When editing hatches with more than one 
layer, be sure to select the proper layer before entering values.

Layers are selected by clicking on one of the elements on the desired layers. The solid cursor shows as 
a hollow cursor when it is over a selectable object . Handles display on the objects in the selected layer. 
You may want to use this dialog's Zoom In tool to magnify the hatch pattern and make it easier to select 
a layer. 

The Pan Tool is used to pan the edit window. Panning repositions the hatch origin.

The Zoom In tool is used to magnify objects in the edit window. Click the tool to magnify the contents of 
the window by a factor of 2.

The Zoom Out tool is used to reduce the displayed size of objects in the edit window. Click the tool to 
reduce the displayed size by a factor of two.

Add Layer 
The Add Layer button is used to add a layer to the edit window. A hatch pattern can have up to thirty    
layers. The new layer is created with the default hatch values. 

You can alternatively, press the Control key and drag the current layer's start point handle to add a new 
layer to the pattern.

Delete Layer 
The Delete Layer button is used to remove the active layer in the hatch. This action cannot be undone.

Page
The Page button sets the pattern's scale to absolute dimensions. When this option is set, the hatch 
maintains its scale, regardless of the scale of the layer in which it is placed. 

Page scale is useful when you want an absolute distance between hatch lines on printed output. 

World
World allows the pattern to be scaled to that of the layer in which it is placed. This setting is useful for 
hatches that represent materials such as brick elevations or floor tiles that are used on objects drawn to 
scale.

Name
This field specifies the hatch pattern's name. Each hatch must have a unique name. The maximum 
length for a hatch name is twenty characters.

Revert 
The Revert button returns the active hatch to its original condition, without any changes.

Cancel
The Cancel button closes the Edit Hatch dialog box without making any changes.

OK
Accepts the changes and closes the dialog box. Like all edits to a file, changes in the active hatch do not 
become be permanent until the active document is saved (i.e., if you save the pattern, but don't save the 
drawing, the pattern will be lost).



Record Formats

The Resource Palette is used to create, edit and import record formats.

Note:    Check the status of the Record Format button at the bottom of the palette. If the button has a 
large, red "X" across it, click it to allow record formats to be listed in the palette.

Record formats are record descriptions that are used to attach database records to objects in a drawing. 
When a record format is attached to an object, it creates a database record (you can view or change this 
record by selecting the object and displaying the Data pane of the Object Info Palette). 

Database records can be collected into a worksheet, where they can be viewed, sorted, analyzed and 
printed. You can even extract records that meet specific criteria (e.g., a certain manufacturer or a > 90 
day lead time). See the Worksheets topic for more information about worksheets.

One powerful use of a record format is to attach it to a symbol. For instance, you might create a record 
format called "Appliances" that contains individual fields for manufacturer, type, model number, 
availability, price, etc. This record format can then be attached to different appliance symbols in the 
library, modifying it appropriately for each symbol. 

Each time an appliance symbol is placed in a drawing, an "Appliance" database record is automatically 
created. You can easily pull these "Appliance" records into a worksheet to see how many appliances 
(and what type) are needed. 

For additional information, see the following topics:
Creating a Record Format

Editing a Record Format

Importing a Record Format



Creating a Record Format

Before a record can be assigned to an object or symbol, a record format must be created for it. The 
record format defines the fields that make up the record, and defines the default value of each.

Record formats are created by clicking the New button in the Resource palette. 

When the Create Resource dialog box appears, select the Record Format button and click Create. 

In the Create Record dialog box, enter a name for the record format. This name must be unique, and 
must not exceed 20 characters.

In the Record Format dialog box, click New to create the first field in the record. 

In the Edit Field dialog box, enter the field's name, data type and default value, then click OK. 

The Edit Record dialog closes and you are returned to the Record Format dialog. The field you just 
created will appear in this dialog's scrolling list.

Define each of the record's fields in the same way. A record format can contain many fields (with a limit 
of 32k). 

When all fields have been defined, click OK.

For related information, see the following topics:
Editing a Record Format

Importing a Record Format



The Edit Field dialog box

The Edit Field dialog box is used to create or edit a field in a record format. It contains the following 
options:

Name 
The Name field specifies the name of the field. This name does not need to be unique.

Type
The Type field specifies the kind of information the field will hold. Select one of the four types: 

· Integer.    Integer fields contain whole numbers. Because an integer is a whole number, it can be 
very efficiently stored by the computer, and uses less memory than other numeric types. If the 
field will only hold whole numbers, select the Integer type instead of Number.

· Number.    Number fields can contain any number, including fractional values.

· Boolean.    Boolean fields can return a descriptive text string of up to eight characters. In the 
record format, a Boolean field returns either true or false.

· Text    Text fields can contain up to 32,000 characters of information, but only 255 characters of 
that text can be displayed in the spreadsheet cell. A database subrow will display sixty-three 
characters of the text in a Text field.

Default Values
The Default Value specifies the data that will automatically be placed in this field when the record is 
attached to an object in the drawing. Once the record is attached to an object, you can use the Data 
pane of the Object Info Palette to change the information in that record.



Editing a Record Format

Record formats that have already been created can be modified by selecting the name of the record 
format in the Resource Palette's list box  and clicking the Edit button (you can also double-click the 
record format's name). The Record Format dialog box is opened.

· If you want to change a field's name, type or default value, select the field and click the Edit 
button.

· If you want to add a new field, click the New button and enter the field's name, type and default 
value in the Edit Field dialog box. For more information about this dialog box, see The Edit Field 
dialog box.

· If you want to move a field's position in the record, select it and click the Up or Down button to 
move it one line up or down. 

· If you want to delete a field, select it and click the Remove button.

For related information, see the following topics:
Creating a Record Format

Importing a Record Format



Importing a Record Format

If a record format exists in another drawing or in a MiniCad library, it can be imported into the active 
drawing.

To do this, select the name of the record format in the Resource Palette's list box. Then click the Import 
button. The record format will be imported into the active drawing. 

Note:     The Find button is can be used to locate a record format anywhere on your system. When 
clicked, the Find button opens the Find Resource dialog box. Enter the name of the record format you 
want to locate, use the Set Where button to set the search path and click OK.

If the imported record format's name already exists in your drawing, you will be asked whether you want 
it to replace the one in your drawing. 

For related information, see the following topics:
Creating a Record Format

Editing a Record Format




